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Omnichannel Messaging Overview

Yeastar P-Series Cloud Edition provides an omnichannel messaging feature, enabling busi-
ness to integrate multiple digital channels into the system. This allows business agents to
interact seamlessly with customers across multiple channels, including text messages, so-
cial media, and more, on a unified platform. ensuring agent productivity while enhancing the
customer experience.

Highlights
Yeastar omnichannel messaging feature provides the following highlights:

All-in-one Message Inbox

Agents are able to receive and respond to customers' queries from different
messaging channels directly on their Linkus UC Clients, greatly saving their
time by eliminating the need of switching between apps or services to check
for messages. The messages are stored on the PBX server, providing a central
record of all the messaging sessions.

Customer Contact using Business Number

Agents can contact customers using a business number, while keeping their
own personal mobile number private. If necessary, the messaging session can
be easily elevated to a call to reach the customer, so that the agent can re-
solve issues faster via voice call.

Seamless Collaboration across Agents

Agents can hand off customers' issue to another agent by transferring the
conversation, the new agent can quickly review the whole chat history and
take over the conversation without hassle.

Flexible Chat Assignment

Route your business messages from different messaging channels to agents,
who can share the workload across teams to reduce customer service re-
sponse time. Chats can be automatically assigned to the first agent who re-
sponds to a session in the queue, or agents can manually take over sessions
as needed.

Roles in omnichannel messaging
Users can access the omnichannel messaging feature and perform different tasks based on
their roles and responsibilities, as the following table lists.
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Role Description

System System administrators that are responsible for configuring and maintaining the
Administrator omnichannel messaging features, including setting up communication channels,
setting routing rules, assigning agents, and managing conversation histories.

For more information, see Omnichannel Messaging Administrator Guide.

Agent Agents that are responsible for interacting with customers from various messaging
channels, handling inquiries, resolving issues, and providing support and services.

For more information, see Omnichannel Messaging Agent Guide.




Administrator Guide

Omnichannel Messaging Administrator Guide

This guide provides detailed instructions for system administrators to set up and manage
the PBX omnichannel messaging feature, implementing smooth communication on the PBX
system across various channels.

Audience

This guide is intended for system administrators responsible for configuring and maintain-
ing the omnichannel messaging feature.

Requirements

Subscribe to Enterprise Plan or Ultimate Plan to ensure that the Omnichannel Messaging
feature is available.

Steps to set up omnichannel messaging

1. Set up message channels

To enable your contact center to handle digital channels interactions, you need
to add the communication channels in the PBX system, and configure settings
for each channel, such as message sending rate, inbound messaging routing
rule, etc., for smooth operation.

Refer to the individual channel setup articles for the requirements and detailed
instructions.

Channel Instruction

SMS To reach customers directly on their mobile phones using SMS,
you can set up SMS channels on Yeastar PBX with the following
supported SMS service providers:

» Set up an SMS Channel for Apidaze

» Set up an SMS Channel for Bandwidth
» Set up an SMS Channel for Flowroute

» Set up an SMS Channel for SIPTRUNK
 Set up an SMS Channel for Telnyx

» Set up an SMS Channel for Twilio

» Set up an SMS Channel for VoiceMeUp
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Channel Instruction

For SMS Service Providers that are not listed above, they can add
their SMS service to Yeastar P-Series Cloud Edition using SMS API.
After the integration is complete, you can create an SMS channel for
the Service Provider on your PBX.

For more information about the SMS service integration and the
SMS channel setup after the integration, see Integrate SMS Service
with Yeastar P-Series Cloud Edition using SMS API.

Social media  To interact with customers through popular social media platforms,
you can set up social media channels on Yeastar PBX with the
following supported social media.

» Set up a Facebook Channel
» Set up a Live Chat Channel
» Set up a WhatsApp Channel

2. Set up message queue

Define a group of agents to receive the inbound messages. When an agent of
the queue picks up a session, he or she is able to respond to the messages in
the session, and the session is automatically assigned to the agent.

For more information, see Create a Message Queue and Manage Message
ueues.

3. Set up message campaign

To send a message to multiple recipients, you can create a message cam-
paign. This allows you to set up and manage bulk messaging tasks, enabling
you to deliver a single message to multiple target numbers at once.

For more information, see Create an SMS Campaign and Create a WhatsApp
Campaign.

4. Manage message history

Get access to the detailed records of customer message interactions from
various channels, allowing you to have a complete overview of each conversa-
tion journey.

For more information, see Check and Manage External Chat Logs and Down-
load External Chat Logs.
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Message Channel Setup
Apidaze

Set up an SMS Channel for Apidaze

This topic describes how to set up a Apidaze SMS channel on Yeastar P-Series Cloud Edi-
tion, so that agents in your business can receive and reply to SMS messages from cus-
tomers on their Linkus UC Clients.

Requirements
The Yeastar PBX should meet the following requirements:

« Firmware: Version 84.20.0.128 or later

« Plan: Enterprise Plan (EP) or Ultimate Plan (UP)

- Domain Name: Due to the limitation of the third-party platform, the domain name
must NOT contain underscore character(s), otherwise the messaging channel will en-
counter authentication failure, or will fail to receive messages.

- Domain Certificate: A valid domain certificate is installed.

Note:

If the root domain of your Cloud PBX is NOT the standard Yeastar-provided

domains (ycmcloud.com, yeastarcloud.com, or yeastarycm.co.za), you NEED
to install a valid domain certificate for the PBX first, otherwise the messaging
channel will encounter authentication failure, or will fail to receive messages.

Supported message types and limits

Supported message types

The Apidaze SMS channel supports text messages and multimedia messages
(MMS), where the supported MMS file types are determined by Apidaze.

Important:

When sending multimedia messages (such as images), the SMS ser-
vice provider downloads the files from a link provided by the PBX.
Therefore, if you have set Allowed Country/Region IP Access Pro-
tection rule, make sure that you have allowed the IP access from the



https://help.yeastar.com/en/p-series-cloud-edition/administrator-guide/restrict-specific-countries-or-regions-from-accessing-yeastar-pbx.html
https://help.yeastar.com/en/p-series-cloud-edition/administrator-guide/restrict-specific-countries-or-regions-from-accessing-yeastar-pbx.html
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country where the SMS service provider is located, otherwise the file
transmission would fail.

Limits

s File size: Max. 100 MB
» File retention period: 72 hours

Prerequisites
You have obtained the following information from the Apidaze Service Provider:

* APl key
* Secret
« Phone number used for message sending and receiving

Note:

If business needs to communicate with US-based customers, make sure that
the phone number has been completed with T0DLC registration to avoid dis-
ruption in message delivery.

Procedure

» Step 1. Create and configure an SMS channel on PBX
« Step 2. Configure webhook in Apidaze

Step 1. Create and configure an SMS channel on PBX

1. Log in to PBX web portal, go to Messaging > Message Channel.
2. Click Add, and select SMS.
3. In the Authentication tab, enter the authentication information of Apidaze.
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Authentication Messaging Settings

Please refer to the User Guide for information on how to configure the following settings.

Apidaze SMS Channel https://docs.example.yeastarcloud.com/api/v1.0/webhook/apidaze/226.

Apidaze

- Name: Enter a name to help you identify the channel.
+ ITSP: Select Apidaze.
« APl Key: Enter the API key obtained from Apidaze.
- Secret: Enter the Secret obtained from Apidaze.
4. In the Messaging Setting tab, configure the channel.
a. In the Message Sending Rate field, specify the number of messages that PBX
can send per second.

Note:

« If the number of messages to send exceeds the set value, PBX
will arrange the messages in queue and send them at the sending
rate.

« If the sending rate set in PBX exceeds the limit set by the SMS
service provider, it may result in message delivery failures. Con-
tact your SMS service provider to confirm the sending rate limit of
your account and increase the limit as needed.

b. Optional: If you want the system to automatically close the sessions that have
been inactive for a specific period of time, select the checkbox of Close Ses-
sion Automatically, then set the timeout in the Session Timeout (Days) field.

Close Session Automatically

c. In the Accompanying Text for Chat File field, specify the default text that will
be sent along with chat files.
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* Accompanying Text for Chat File

Sent by Yeastar

Apidaze requires that the chat file be accompanied by text content. Please configure the
default accompanying text. For example: Sent by Yeastar.

The message recipient will see the text displayed alongside the chat files.

Sent by Yeastar

Two-factor Authentication

d. In the Number section, click Add to add a message routing rule.

Add X

* Number
+14102161183

For phone numbers, please enter them in E.164 format. For example, +86-592-5503309 should be entered as +865925503309.

* Destination for Inbound Messaging * Extension

Extension v 3000-Leo Ball \4

Extensions allowed to create messaging sessions

4 items Available 2 items Selected
Search here Q Search here Q
Extension Num... Caller ID Name Extension Num... Caller ID Name
=
Extension Group  Default_All_Ext... 1000 Leo Ball
> ~
1002 Terrell Smith 1001 Phillip Huff
- < o
1003 Dave Haris
1004 Troy Daniel ¥

X Cancel

« Number: Enter the purchased number or specify an Alphanumeric Sender
ID.
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Note:
The phone number should be in E.164 format ([ +] [ count ry
code] [ phone nunber] ). For example, +14102161183.

« Destination for Inbound Messaging: Specify the destination of inbound
messages from the number.

Option Description

Extension If selected, choose an extension from the Extension
drop-down list.

Only the extension user can receive inbound messages
from the number.

Message Queue If selected, choose a queue from the Message Queue
drop-down list.

All the agents in the selected message queue can receive
inbound message(s) of new sessions in the queue.
However, only the user who picks up a session will be
able to receive and respond to the follow-up inbound
messages in the session.

Third-Party If selected, inbound messages will be automatically
Message forwarded to a third-party message analytics platform via
Analytics Platform  API for advanced processing.

(Transmitted via

API) ,‘ Note:

To enable automatic forwarding of inbound
messages to a third-party message analytics
platform, ensure that your PBX server has been
integrated with the third-party message analytics
platform via API. Once this option is selected, the
PBX system will automatically transmit inbound
messages to the designated platform. You can
get notified by monitoring the API event (30031)
New Message Notification. Additionally, the PBX
provides a comprehensive Message API suite for
advanced message interaction with the integrated
third-party message analytics platforms.

- Extensions allowed to create messaging sessions: Select the exten-
sions that are allowed to initiate a messaging session with customers.

e. Click Save.
5. Click Save.


https://help.yeastar.com/en/p-series-cloud-edition/developer-guide/enable-yeastar-p-series-pbx-api.html
https://help.yeastar.com/en/p-series-cloud-edition/developer-guide/event-new-message-notification.html
https://help.yeastar.com/en/p-series-cloud-edition/developer-guide/event-new-message-notification.html
https://help.yeastar.com/en/p-series-cloud-edition/developer-guide/api-interfaces-and-events-summary.html#api-interface-and-event-overview__section_messaging
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Step 2. Configure webhook in Apidaze

1. On PBX web portal, go to Messaging > Message Channel.
2. Click the SMS channel you created.

3. In the Authentication tab, copy the Webhook URL.

Authentication Messaging Settings

Please refer to the User Guide for information on how to configure the following settings.

Apidaze SMS Channel https://docs.example.yeastarcloud.com/api/v1.0/webhook/apidaze/226. j

............................ j [T, N

4. In Apidaze, configure messaging webhook for the phone number using the PBX's web-
hook URL to receive inbound messages.

Result

« A messaging channel is created successfully. You can see the channel displayed in

the Messaging Channel list with Status showing .

Status Name Type Number Total Sent Operations

@ Apidaze SMS SMs

+14102161183 0 0 Z T
Channel

« PBX automatically tracks and records the number of messages sent and received on

the channel, where the Total column indicates the total number of sent messages, in-
cluding both successfully sent messages and failed ones.

"4 Note:

- o For sent messages, PBX only tracks the number of the messages sent
from agents' Linkus UC Clients. If you want to calculate the actual cost
of sent messages, consult with the SMS service provider for the precise
number of messages transmitted, as long text messages (longer than
160 characters) are automatically split into segments and then re-as-
sembled when they are received, increasing the number of sent mes-
sages.

> You can filter the statistics by a time period using the time filter.
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‘Q
All

Number Total Sent Failed Received Operations

+14102161183 30 20 10 8 Z

What to do next

Send text messages to the phone number and see if the specified agent can receive mes-
sages on his or her Linkus UC Client.

Related information
Check and Manage External Chat Logs
User Guide - Manage customer queries from SMS channel on Linkus Web Client /
Desktop Client
User Guide - Manage customer queries from SMS channel on Linkus Mobile Client

Bandwidth

Set up an SMS Channel for Bandwidth

This topic describes how to set up a Bandwidth SMS channel on Yeastar P-Series Cloud
Edition, so that agents in your business can receive and reply to SMS messages from cus-
tomers on their Linkus UC Clients.

Requirements

The Yeastar PBX should meet the following requirements:

« Firmware: Version 84.20.0.128 or later

« Plan: Enterprise Plan (EP) or Ultimate Plan (UP)

- Domain Name: Due to the limitation of the third-party platform, the domain name
must NOT contain underscore character(s), otherwise the messaging channel will en-
counter authentication failure, or will fail to receive messages.

- Domain Certificate: A valid domain certificate is installed.

Note:
If the root domain of your Cloud PBX is NOT the standard Yeastar-provided
domains (yecmcloud.com, yeastarcloud.com, or yeastarycm.co.za), you NEED
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to install a valid domain certificate for the PBX first, otherwise the messaging
40 channel will encounter authentication failure, or will fail to receive messages.

Supported message types and limits

Supported message types

The Bandwidth SMS channel supports text messages and multimedia mes-
sages (MMS), where the supported MMS file types are determined by Band-
width. For more information, see Bandwidth supported MMS file types.

Important:

When sending multimedia messages (such as images), the SMS ser-
vice provider downloads the files from a link provided by the PBX.
Therefore, if you have set Allowed Country/Region IP Access Pro-
tection rule, make sure that you have allowed the IP access from the
country where the SMS service provider is located, otherwise the file
transmission would fail.

Limits

* File size: Max. 100 MB
» File retention period: 72 hours

Prerequisites

» You have created a sub-account and associated with your location in Bandwidth.

Note:

Ensure that the Allow user credentials to authenticate API option is en-
abled for the account.



https://support.bandwidth.com/hc/en-us/articles/360014128994-What-MMS-file-types-are-supported-
https://help.yeastar.com/en/p-series-cloud-edition/administrator-guide/restrict-specific-countries-or-regions-from-accessing-yeastar-pbx.html
https://help.yeastar.com/en/p-series-cloud-edition/administrator-guide/restrict-specific-countries-or-regions-from-accessing-yeastar-pbx.html
https://support.bandwidth.com/hc/en-us/articles/360035563254-How-do-I-manage-Sub-accounts-and-Locations-in-the-Bandwidth-Dashboard-
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* User Ac Method
(O Allow user to login to the Bandwidth App
| © Allow user credentials to authenticate API |

« You have purchased phone number(s) in Bandwidth.

Procedure

« Step 2. Configure a number for SMS on Bandwidth
« Step 3. Create and configure an SMS channel on PBX
» Step 1. Obtain a Webhook URL on PBX

Step 1. Obtain a Webhook URL on PBX

Obtain a Webhook URL from PBX web portal first, which is required when you configure a
number for SMS on Bandwidth.

1. Log in to PBX web portal, go to Messaging > Message Channel.
2. Click Add, and select SMS.
3. In the ITSP drop-down list, select Bandwidth, then copy the Webhook URL.

o Important:
The URL will change once you leave the current page, please make sure you

use the latest Webhook URL for the configuration on the service provider's
customer portal.

Authentication Messaging Settings

Please refer to the User Guide for information on how to configure the following settings.

* Name * Webhook URL

https://docs.example.yeastarcloud.com/api/v1.0/webhook/bandwidth/90

*ITSP A

| Bandwidth I. _______________________ .

4. Note down the Webhook URL.


https://support.bandwidth.com/hc/en-us/articles/360011094753-How-do-I-search-and-order-phone-numbers-
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Step 2. Configure a number for SMS on Bandwidth

Important:

According to US legislation (A2P 10DLC SMS), 10DLC (10-digit Long Code) phone
numbers that are used for A2P (Application-to-Person) messaging MUST be reg-
istered, otherwise SMS messages sent to US numbers from unregistered 10DLC
numbers will be blocked.

If your business needs to communicates with US-based customers, you should
confirm the registration requirements with the SMS service provider and complete
the phone number registration to avoid disruption in message delivery.

Log in to Bandwidth portal, and complete the followings:

1. Create an application using a sub-account and configure the callback with PBX's Web-

LEARNING LAB & SUPPORT

(9) ‘ Dashboard  Numbers Orders{ Applications |Insights

Pie (++#++4+%)  Account Logout

,
Applications
Your messaging URI: https://medsaging.bandwidth.com/api/v2/users/******* /messages COPY APICREDENTIALS  DEVELOPER DOCS [
Applwcat\ons 4 CREATE APPLICATION Create Application

§ ) * Application name: * Applical tion ID:
Yeastar SMS messaging We create this for yo

Application type

Use multiple callback URLs
CALLBACK

* Callback URL:
https://docs.example.yeastarcloud.com/api/v1.0/webhook/bandwidth/dda18

Use 3 username/password for callbacks
STATUS CALLBACK TYPES

(B 5end 'message-delivered callbacks (2
(B send 'message-failed callbacks (2

Send ‘message-sending’callbacks 2

X CANCEL cnurnpiucmou

2. On the details page of the new application, associate the application with your loca-
tion.


https://support.bandwidth.com/hc/en-us/articles/1500003820522-Registering-brands-and-campaigns-for-10DLC
https://support.bandwidth.com/hc/en-us/articles/1500003820522-Registering-brands-and-campaigns-for-10DLC
https://passport.bandwidth.com/login
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ASSOCIATED LOCATIONS @

+ ASSOC\@E LOCATION | [i] DISASSOCIATE LOCATION
Associate a location

LOCATION

Location
‘_ Yeastar Test

- |

X CANCEL m

3. Enable HTTP SMS and MMS messaging for your location and the associated applica-

+ ASSOCIATE ANOTHER LOCATION

tion.

Yeastar Test

SETTINGS VOICE MESSAGING uc

@SMS SETTINGS

( SMS Enabled

% ) Toll Free

% ) Short Codes

Geographic reach
CAN ZONE 2 ZONE 3 ZONE 4 ZONE 5

Selected countries apply to both SMS and MMS

SMS Protocol

HTTP
API-based
( V2 Messaging

* Applications

Yeastar SMS messaging
+ CREATE APPLICATION

MMS SETTINGS

( MMS Enabled

MMS Protocol

HTTP
API-based

V2 Messaging

[ DELETE X CANCEL m

4. Search the number that you want to use for SMS and associate it with your sub-ac-

count.
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(g, ‘ Dashboard Orders Applications Insights

My Numbers | Hosted Messaging External Numbers

My Numbers

MY INVENTORY LINE FEATURES MOVE NUMBERS

~ SEARCH FOR NUMBERS ACTIVE ON YOUR ACCOUNT

« How do you want to search?
° Show all numbers on your account (sub-account / location)
o Find the sub-account and location information for a telephone number

O Search for a number based on IP address or DNS
Location:

Sub-account:
v

Move Number

~ SEARCH RESULT (ACCOUNT: TEST COMPANY |
* Sub-Account
v

(410) 216-1183 Yeastar Test

* Location

Yeastar Test

5. Note down the Application ID and Account ID for the integration with PBX.

(9) ‘ Dashboard  Numbers Orders Insights
—

API CREDENTIALS ~ DEVELOPER DOCS

Applications

SMS for Yeastar

Appl ications |- CREATE APPLICATION
; e « Application name:
Yeastar SMS messaging rerirgl

Yeastar SMS messaging Application type:

Messaging Application

Use multiple callback URLs.

Step 3. Create and configure an SMS channel on PBX
Create an SMS channel on PBX, and configure the channel with the authentication informa-

tion and number obtained from Bandwidth.

1. Log in to PBX web portal, go to Messaging > Message Channel.

2. Click Add, and select SMS.
3. In the Authentication tab, enter the authentication information of Bandwidth.
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Authentication Messaging Settings

Please refer to the User Guide for information on how to configure the following settings.

Bandwidth SMS channel https://docs.example.yeastarcloud.com/api/v1.0/webhook/bandwidth

Bandwidth

« Name: Enter a name to help you identify the channel.
« ITSP: Select Bandwidth.
« Application ID: Paste the Application ID obtained from Bandwidth.
« Account ID: Enter the Account ID of your Bandwidth account.
- Username: Enter the user name of your Bandwidth account.
« Password: Enter the password associated with your Bandwidth account.
4. In the Messaging Settings tab, configure the channel.
a. In the Message Sending Rate field, specify the number of messages that PBX
can send per second.

Note:

« If the number of messages to send exceeds the set value, PBX
will arrange the messages in queue and send them at the sending
rate.

« If the sending rate set in PBX exceeds the limit set by the SMS
service provider, it may result in message delivery failures. Con-
tact your SMS service provider to confirm the sending rate limit of
your account and increase the limit as needed.

b. Optional: If you want the system to automatically close the sessions that have
been inactive for a specific period of time, select the checkbox of Close Ses-
sion Automatically, then set the timeout in the Session Timeout (Days) field.
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Close Session Automatically

c. In the Number section, click Add to add a message routing rule.

Add X

*
+14102161183

For phone numbers, please enter them in E.164 format. For example, +86-532-5503309 should be entered as +865925503309.

Extension 3000-Leo Ball
4 items Available 2 items Selected
Extension Num... Caller ID Name Extension Num... Caller ID Name
Extension Group  Default_All_Ext.. 1000 Leo Ball
1002 Terrell Smith 1001 Phillip Huff
1003 Dave Haris
1004 Troy Daniel

X Cancel

« Number: Enter the purchased number or specify an Alphanumeric Sender
ID.

Note:

The phone number should be in E.164 format ([ +] [ count ry
code] [ phone nunber] ). For example, +14102161183.

» Destination for Inbound Messaging: Specify the destination of inbound
messages from the number.

Option Description

Extension If selected, choose an extension from the Extension
drop-down list.

Only the extension user can receive inbound messages
from the number.

Message Queue If selected, choose a queue from the Message Queue
drop-down list.
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Option Description

All the agents in the selected message queue can receive
inbound message(s) of new sessions in the queue.
However, only the user who picks up a session will be
able to receive and respond to the follow-up inbound
messages in the session.

Third-Party If selected, inbound messages will be automatically
Message forwarded to a third-party message analytics platform via
Analytics Platform  API for advanced processing.

(Transmitted via

API) / Note:

To enable automatic forwarding of inbound
messages to a third-party message analytics
platform, ensure that your PBX server has been
integrated with the third-party message analytics
platform via API. Once this option is selected, the
PBX system will automatically transmit inbound
messages to the designated platform. You can
get notified by monitoring the API event (30031)
New Message Notification. Additionally, the PBX
provides a comprehensive Message API suite for
advanced message interaction with the integrated
third-party message analytics platforms.

- Extensions allowed to create messaging sessions: Select the exten-
sions that are allowed to initiate a messaging session with customers.

d. Click Save.
5. Click Save.

Result

« A messaging channel is created successfully. You can see the channel displayed in

the Messaging Channel list with Status showing Q.

Status Name Type Number Total Sent Operations

Bandwidth SMS
@ anawl SMS +14102161183 0 0 Z T
channel

« PBX automatically tracks and records the number of messages sent and received on

the channel, where the Total column indicates the total number of sent messages, in-
cluding both successfully sent messages and failed ones.


https://help.yeastar.com/en/p-series-cloud-edition/developer-guide/enable-yeastar-p-series-pbx-api.html
https://help.yeastar.com/en/p-series-cloud-edition/developer-guide/event-new-message-notification.html
https://help.yeastar.com/en/p-series-cloud-edition/developer-guide/event-new-message-notification.html
https://help.yeastar.com/en/p-series-cloud-edition/developer-guide/api-interfaces-and-events-summary.html#api-interface-and-event-overview__section_messaging
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"4 Note:

. o For sent messages, PBX only tracks the number of the messages sent
from agents' Linkus UC Clients. If you want to calculate the actual cost
of sent messages, consult with the SMS service provider for the precise
number of messages transmitted, as long text messages (longer than
160 characters) are automatically split into segments and then re-as-
sembled when they are received, increasing the number of sent mes-
sages.

> You can filter the statistics by a time period using the time filter.

@ Add All

Number Total Sent Failed Received Operations

414102161183 30 20 10 8 Z

What to do next

Send text messages to the phone number and see if the specified agent can receive mes-
sages on his or her Linkus UC Client.

Related information
Check and Manage External Chat Logs
User Guide - Manage customer queries from SMS channel on Linkus Web Client /
Desktop Client
User Guide - Manage customer queries from SMS channel on Linkus Mobile Client

Flowroute

Set up an SMS Channel for Flowroute

This topic describes how to set up a Flowroute SMS channel on Yeastar P-Series Cloud
Edition, so that agents in your business can receive and reply to SMS messages from cus-
tomers on their Linkus UC Clients.
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Requirements

Platform Requirement

Yeastar PBX » Firmware: Version 84.20.0.128 or later

* Plan: Enterprise Plan (EP) or Ultimate Plan (UP)

« Domain Name: Due to the limitation of the third-party platform, the domain
name must NOT contain underscore character(s), otherwise the messaging
channel will encounter authentication failure, or will fail to receive messages.

» Domain Certificate: A valid domain certificate is installed.

) Note:
If the root domain of your Cloud PBX is NOT the standard
Yeastar-provided domains (ycmcloud.com, yeastarcloud.com, or
yeastarycm.co.za), you NEED to install a valid domain certificate
for the PBX first, otherwise the messaging channel will encounter
authentication failure, or will fail to receive messages.

Flowroute API Version: v2.1

Note:
You can check or update the API version on Flowroute (Path:
PREFERENCE > API Control > SMS Webhook Version).

Supported message types and limits

Supported message types

The Flowroute SMS channel supports text messages and multimedia mes-
sages (MMS), where the supported MMS file types are determined by
Flowroute. For more information, see Flowroute supported MMS file types.

Important:

When sending multimedia messages (such as images), the SMS ser-
vice provider downloads the files from a link provided by the PBX.
Therefore, if you have set Allowed Country/Region IP Access Pro-
tection rule, make sure that you have allowed the IP access from the
country where the SMS service provider is located, otherwise the file
transmission would fail.

Limits

* File size: Max. 100 MB


https://manage.flowroute.com
https://support.flowroute.com/937402-Supported-MMS-file-types
https://help.yeastar.com/en/p-series-cloud-edition/administrator-guide/restrict-specific-countries-or-regions-from-accessing-yeastar-pbx.html
https://help.yeastar.com/en/p-series-cloud-edition/administrator-guide/restrict-specific-countries-or-regions-from-accessing-yeastar-pbx.html
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» File retention period: 72 hours

Procedure

» Step 1. Obtain a Webhook URL on PBX
« Step 2. Configure a number for SMS on Flowroute
«» Step 3. Create and configure an SMS channel on PBX

Step 1. Obtain a Webhook URL on PBX

Obtain a Webhook URL from PBX web portal first, which is required when you configure a
number for SMS on Flowroute.

1. Log in to PBX web portal, go to Messaging > Message Channel.

2. Click Add, and select SMS.
3. In the ITSP drop-down list, select Flowroute, then copy the Webhook URL.

Important:
The URL will change once you leave the current page, please make sure you
use the latest Webhook URL for the configuration on the service provider's

customer portal.

Authentication Messaging Settings

Please refer to the User Guide for information on how to configure the following settings.
https://docs.example.yeastarcloud.com/api/v1.0/webhook/flowroute/ ..

Flowroute

4. Note down the Webhook URL.

Step 2. Configure a number for SMS on Flowroute

Important:

According to US legislation (A2P 10DLC SMS), 10DLC (10-digit Long Code) phone
numbers that are used for A2P (Application-to-Person) messaging MUST be regis-
tered, otherwise SMS messages sent to US numbers from the unregistered 10DLC
numbers will be blocked.
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If your business communicates with US-based customers, you should confirm the
registration requirements with the SMS service provider and complete the phone
number registration to avoid disruption in message delivery.

Log in to Flowroute portal, and complete the following settings:

1. Enable the messaging feature for the desired DID number.

INTERCONNECTION

pr———

flowroute  veastar o -
0 DASHBOARD r Manage Purchase Port Orders E911 CNAM
] Manage your DIDs )
CDRS & STATS :
1
1

Set Route
¥ prerereNces Set Failover Route

Add New Route 4 Failover 4 Messaging & CNAM . A 4 e comer
Alias Options Route Lookups

Set Alias

® wee

14102161183 Clear Alias Opted-out PURCHASED DC~WSHNGTNZ
- E911 Options
Assign / Enter E911 Profile
(] 18002786915 Unassign E911 Profile ion Opted-out Yes - - PURCHASED DC~WSHNGTNZ
- Messaging Options
Enable Messaging
Show| 25  vjentries ¥ Disable Messaging
Showing 1t 2 of 2entries 1 row sel (A Previous = Next
Clear Callback URL
CNAM Options
Set CNAM Storage Preset
Clear CNAM Storage Preset
Enable CNAM Lookups

2. Configure messaging webhook according to your needs.
« If you only need to receive callback notification for inbound messages sent from
a specific number, configure messaging webhook with PBX's Webhook URL for
the number individually.

{ Set Callback URL for your Phone
Number

« If you need to receive callback notification for inbound messages sent from all
the numbers in your account, configure global messaging webhook with PBX's
Webhook URL as shown below.


https://support.flowroute.com/265034-Messaging-Guidelines---10DLC-Carrier-Fees-and-Registration
https://support.flowroute.com/265034-Messaging-Guidelines---10DLC-Carrier-Fees-and-Registration
https://manage.flowroute.com
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flowroute

INTERCONNECTION

DiDS

L prererences

] e

Yeastar

Account Information  User Profile

Features

Fraud Control

Balance Management

API Control

10DLC Registration

Toll Free Verification

Developer Docs for more information

ting a callback url for an account

« Setting a callback url for a phone number

SMs

MMs

SMS DLR

MMS DLR

@) croves

https://docs.exampl

loud com/api/v1

@) e

https://docs

com/apifv1

e automatically returned in v2.1

@) cwoves

https://docs.

se the v2.0 format

loud.com/api/v1

@) s

3. Create an API key for the integration with PBX.

Important:
You MUST note down the generated key in the pop-up window,

displayed ONCE.

flowroute
@ oasusoarD
@ s
il cprs & sTATS

L8 NTeRcONNECTION

# oos

& prererences

HELP NAME
®

Yeastar

Account Information

APl Keys

User Profile Features

to prov

Add new API Key

‘ Yeastar Docy|

Fraud Control Balance Management API Control

LTy SppEs W Iy 317 G 1 DS

ide and revoke access to your account resources via our A

DESCRIPTION EXPIRATION

[}

10DLC Registration

Toll Free Verification

y prior to expiration

Account

Description  Ac

Yeastar 1

API| Key Created

Please copy this key and save it somewhere safe.

For security reasons, we cannot show it to you again.

82¢ db

4. Note down the Access Key of the API key.

with a matching 'S

©@support

as itis only

®support +

ret Key' This key is only displayed

| when an API key is expiring or has expiredy The account Dashboard will also
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ﬂowroui‘e Yeastar shirley .~

@ DpasueoarD Account t Information User Profile Features Fraud Control Balance Management API Control 10DLC Registration Toll Free Verification © support ~

@ s

Add new API Key

NAME DESCRIPTION EXPIRATION

Description  AccessKey  Secret Key

Yeastar it 4 sxsamsaassasos Never Apr 07,2020 11:49 PM +00:00 mmm
Yeastar Docs 3 4 sxasssaa s ss Never Apr 07,2020 11:49 PM +00:00 mmm

Step 3. Create and configure an SMS channel on PBX

Create an SMS channel on PBX, and configure the channel with the authentication informa-
tion and number obtained from Flowroute.

1. Log in to PBX web portal, go to Messaging > Message Channel.
2. Click Add, and select SMS.
3. In the Authentication tab, enter the authentication information of Flowroute.

Authentication Messaging Settings

Please refer to the User Guide for information on how to configure the following settings.

Flowroute SMS channel https://docs.example.yeastarcloud.com/api/v1.0/webhook/flowroute...

Flowroute

« Name: Enter a name to help you identify the channel.
« ITSP: Select Flowroute.
* Access Key: Paste the access key obtained from Flowroute.
« Secret Key: Paste the API key obtained from Flowroute.
4. In the Messaging Settings tab, configure the channel.
a. In the Message Sending Rate field, specify the number of messages that PBX
can send per second.
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Note:

« If the number of messages to send exceeds the set value, PBX
will arrange the messages in queue and send them at the sending
rate.

« If the sending rate set in PBX exceeds the limit set by the SMS
service provider, it may result in message delivery failures. Con-
tact your SMS service provider to confirm the sending rate limit of
your account and increase the limit as needed.

b. Optional: If you want the system to automatically close the sessions that have
been inactive for a specific period of time, select the checkbox of Close Ses-
sion Automatically, then set the timeout in the Session Timeout (Days) field.

Close Session Automatically

c. In the Number section, click Add to add a message routing rule.

Add X

+14102161183

For phone numbers, please enter them in E.164 format. For example, +86-592-5503309 should be entered as +865925503309.

Extension 3000-Leo Ball
4 items Available 2 items Selected
Extension Num... Caller ID Name Extension Num... Caller ID Name
Extension Group  Default_All_Ext.. 1000 Leo Ball
1002 Terrell Smith 1001 Phillip Huff
1003 Dave Haris
1004 Troy Daniel

X Cancel

« Number: Enter the purchased number or specify an Alphanumeric Sender
ID.

| Note:
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The phone number should be in E.164 format ([ +] [ count ry
code] [ phone nunber] ). For example, +14102161183.

« Destination for Inbound Messaging: Specify the destination of inbound
messages from the number.

Option Description

Extension If selected, choose an extension from the Extension
drop-down list.

Only the extension user can receive inbound messages
from the number.

Message Queue If selected, choose a queue from the Message Queue
drop-down list.

All the agents in the selected message queue can receive
inbound message(s) of new sessions in the queue.
However, only the user who picks up a session will be
able to receive and respond to the follow-up inbound
messages in the session.

Third-Party If selected, inbound messages will be automatically
Message forwarded to a third-party message analytics platform via
Analytics Platform  API for advanced processing.

(Transmitted via

API) ,’ Note:

To enable automatic forwarding of inbound
messages to a third-party message analytics
platform, ensure that your PBX server has been
integrated with the third-party message analytics
platform via API. Once this option is selected, the
PBX system will automatically transmit inbound
messages to the designated platform. You can
get notified by monitoring the API event (30031)
New Message Notification. Additionally, the PBX
provides a comprehensive Message API suite for
advanced message interaction with the integrated
third-party message analytics platforms.

- Extensions allowed to create messaging sessions: Select the exten-
sions that are allowed to initiate a messaging session with customers.

d. Click Save.
5. Click Save.


https://help.yeastar.com/en/p-series-cloud-edition/developer-guide/enable-yeastar-p-series-pbx-api.html
https://help.yeastar.com/en/p-series-cloud-edition/developer-guide/event-new-message-notification.html
https://help.yeastar.com/en/p-series-cloud-edition/developer-guide/event-new-message-notification.html
https://help.yeastar.com/en/p-series-cloud-edition/developer-guide/api-interfaces-and-events-summary.html#api-interface-and-event-overview__section_messaging
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Result

« A messaging channel is created successfully. You can see the channel displayed in

the Messaging Channel list with Status showing .

Status Name Type Number Total Sent Operations

Flowroute SMS

@ SMS +14102161183 ] 0 £ T
channel

« PBX automatically tracks and records the number of messages sent and received on

the channel, where the Total column indicates the total number of sent messages, in-
cluding both successfully sent messages and failed ones.

"4 Note:

. > For sent messages, PBX only tracks the number of the messages sent
from agents' Linkus UC Clients. If you want to calculate the actual cost
of sent messages, consult with the SMS service provider for the precise
number of messages transmitted, as long text messages (longer than
160 characters) are automatically split into segments and then re-as-
sembled when they are received, increasing the number of sent mes-
sages.

> You can filter the statistics by a time period using the time filter.

Number Total Sent Failed Received Operations

+14102161183 30 20 10 8 Z W

What to do next

Send text messages to the phone number and see if the specified agent can receive mes-
sages on his or her Linkus UC Client.

Related information
Check and Manage External Chat Logs
User Guide - Manage customer queries from SMS channel on Linkus Web Client /
Desktop Client
User Guide - Manage customer queries from SMS channel on Linkus Mobile Client
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Set up an SMS Channel for SIPTRUNK

This topic describes how to set up a SIPTRUNK SMS channel on Yeastar P-Series Cloud
Edition, so that agents in your business can receive and reply to SMS messages from cus-
tomers on their Linkus UC Clients.

Requirements

Platform Requirement

Yeastar PBX

SIPTRUNK

» Firmware: Version 84.20.0.128 or later

« Plan: Enterprise Plan (EP) or Ultimate Plan (UP)

« Domain Name: Due to the limitation of the third-party platform, the
domain name must NOT contain underscore character(s), otherwise the
messaging channel will encounter authentication failure, or will fail to
receive messages.

» Domain Certificate: A valid domain certificate is installed.

) Note:
If the root domain of your Cloud PBX is NOT the standard
Yeastar-provided domains (ycmcloud.com, yeastarcloud.com,
or yeastarycm.co.za), you NEED to install a valid domain
certificate for the PBX first, otherwise the messaging channel will
encounter authentication failure, or will fail to receive messages.

» Telephone number: The DID number(s) should be SMS/MMS compatible
and registered with 10DLC.

Important:

According to US legislation (A2P 10DLC SMS), 10DLC

(10-digit Long Code) phone numbers that are used for A2P
(Application-to-Person) messaging MUST be registered, otherwise
SMS messages sent to US numbers from the unregistered 10DLC
numbers will be blocked.

If your business communicates with US-based customers, you
should complete the 10DLC registration for your phone numbers to
avoid disruption in message delivery.

I 0 Tip:
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Platform Requirement

Submit a request to your service provider for the required
0 number(s). For more information, see SMS Process &

Expectations.

Supported message types and limits

Supported message types

The SIPTRUNK SMS channel supports text messages and multimedia mes-
sages (MMS), where the supported MMS file types are determined by SIP-
TRUNK.

Important:

When sending multimedia messages (such as images), the SMS ser-
vice provider downloads the files from a link provided by the PBX.
Therefore, if you have set Allowed Country/Region IP Access Pro-
tection rule, make sure that you have allowed the IP access from the
country where the SMS service provider is located, otherwise the file
transmission would fail.

Limits

* File size: Max. 100 MB
« File retention period: 72 hours

Procedure

«» Step 1. Obtain a Webhook URL on PBX
« Step 2. Configure messaging feature on SIPTRUNK
« Step 3. Create and configure an SMS channel on PBX

Step 1. Obtain a Webhook URL on PBX

Obtain a Webhook URL from PBX web portal first, which is required when you configure a
number for SMS on SIPTRUNK.

1. Log in to PBX web portal, go to Messaging > Message Channel.
2. Click Add, and select SMS.
3. In the ITSP drop-down list, select SIPTRUNK, then copy the Webhook URL.


https://support.siptrunk.com/hc/en-us/articles/20569864729371-SMS-Process-Expectations
https://support.siptrunk.com/hc/en-us/articles/20569864729371-SMS-Process-Expectations
https://help.yeastar.com/en/p-series-cloud-edition/administrator-guide/restrict-specific-countries-or-regions-from-accessing-yeastar-pbx.html
https://help.yeastar.com/en/p-series-cloud-edition/administrator-guide/restrict-specific-countries-or-regions-from-accessing-yeastar-pbx.html
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Important:

The URL will change once you leave the current page, please make sure you
use the latest Webhook URL for the configuration on the service provider's
customer portal.

Authentication Messaging Settings

Please refer to the User Guide for information on how to configure the following settings.

https://docs.example.yeastarcloud.com/api/v1.0/webhook/siptrunk/9..

SIPTRUNK

4. Note down the Webhook URL.

Step 2. Configure messaging feature on SIPTRUNK
Log in to SIPTRUNK customer portal, and complete the following settings:

1. Note down the desired DID number to be added to the SMS channel.

Silinh TELEPHONE NUMBERS
CUSTOMER PORTAL

Create CSV (all 4 numbers)  Bulk Update Recent Orders View by Trunk Search View/Set CNAM

£% Dashboard edt  Number Type  Primary Secondary PSTNForward ~ PSTN Backup  Vmail to Email  Description: Location Description: General
# [0 14102161183 | STD  Trunk 1 not set not set not set not set

[Es Profile

B2 Payment Center >

., SIP Trunking > Call Detail Records

SIP Trunks
Q¥ Number Porting > new numbers

Telephone Numbers
£ Billing Order Telephone Numbers

o International Calling
= Fax

2. Configure messaging webhook for the DID number.
a. Create a Webhook using the PBX's Webhook URL.



https://login.siptrunk.com/
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CUSTOMER PORTAL

sl P*run k API Keys 'Webhooks- API Docs How to Use Messaging
1
1

S Dashboard M R —— S—

e heen
‘Webhooks [€EEEfERITETIN CLOSE|
[£5] Profile ol
*Me Inbound Description Active Delete

E2l Payment Center >

Qs SIP Trunking > Yol

Enter the PBX's webhook URL
Set a webhook name

¥ Number Porting >
1410

= Billing

=

Fax Webhooks
Webhook Created

(O Messaging

(@) Support

oy System Status

b. Assign the Webhook to the DID number.

.
SI P*-ru n k API Keys [l Webhooks [l API Docs |l Package Pricing Jll How to Use Messaging

CUSTOMER PORTAL
Messaging Resources:

(/@’ Dashboard + Messaging Setup Process & Timeline

) Profile +10DLC Registration Form Help Sheet

« Messaging Knowledgebase
E21 Payment Center

% SIP Trunking Your Messaging DIDs:
@ Number Porting DD  Enabled Assign WebHook

wiozeuss| @ |- 00004
B2 Billing -

‘Yeastar_PBX_Webhook (hﬂps://dncs,exampIe,yeastarcloud,com/ap\/vl,O/webtimk/siptmnkIMeOQbBQabMTZchMEABB?deMFS)

Fax
(O Messaging
(2) Support

afly System Status

3. Create an API key for the integration with PBX, and note down the Access Key and
Secret Key.

Important:
Make sure that you have copied and properly saved the Secret Key before
closing the pop-up window, as it is only displayed ONCE.
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siptrunk

CUSTOMER PORTAL

W Webhooks |l APl Docs i Package Pricing |l How to Use Messaging

- ——=

4% Dashboard

r N
P2 B Gl Create New AP Key CLOSE

35 Profile

API Keys
5 PaymentCenter > =
R, SIP Trunking 3

Q€ Number Porting >

API| Key Created.

3 Billing ‘
Please save the secret key. You won't be able to see it again
after you close this screen.
é Fax Access Key: t-Ea:‘ 2273
= Secrst Key: 9041 17899
SCXAPI Token
YmFhYTdIYTctOGVMS00Ym YSLWIIN]YtMDI3SMGELMWEyMjczOjkwNGYyMDBILTZmMjktNDBhNCOSYWIwLWM1Z)M5N2I30Dk52g==
{7 Messaging L | Description: test

(7) Support

Ay System Status

Step 3. Create and configure an SMS channel on PBX

Create an SMS channel on PBX, and configure the channel with the authentication informa-
tion and number obtained from SIPTRUNK.

1. Log in to PBX web portal, go to Messaging > Message Channel.
2. Click Add, and select SMS.

3. In the Authentication tab, enter the authentication information of SIPTRUNK.

Authentication Messaging Settings

Please refer to the User Guide for information on how to configure the following settings.

* Name * Webhook URL

SIPTRUNK SMS channel https://docs.example.yeastarcloud.com/api/v1.0/webhook/siptrunk/9..
* TSP

SIPTRUNK
* Access Key * Secret Key

« Name: Enter a name to help you identify the channel.
« ITSP: Select SIPTRUNK.
* Access Key: Paste the access key obtained from SIPTRUNK.
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« Secret Key: Paste the secret key obtained from SIPTRUNK.
4. In the Messaging Settings tab, configure the channel.
a. In the Message Sending Rate field, specify the number of messages that PBX
can send per second.

Note:

« If the number of messages to send exceeds the set value, PBX
will arrange the messages in queue and send them at the sending
rate.

« If the sending rate set in PBX exceeds the limit set by the SMS
service provider, it may result in message delivery failures. Con-
tact your SMS service provider to confirm the sending rate limit of
your account and increase the limit as needed.

b. Optional: If you want the system to automatically close the sessions that have
been inactive for a specific period of time, select the checkbox of Close Ses-
sion Automatically, then set the timeout in the Session Timeout (Days) field.

Close Session Automatically

c. In the Number section, click Add to add a message routing rule.

Add X
+14102161183
For phone numbers, please enter them in E.164 format. For example, +86-592-5503309 should be entered as +865925503309.
Extension 3000-Leo Ball
4 items Available 2 items Selected
Extension Num... Caller ID Name Extension Num... Caller ID Name
Extension Group  Default_All_Ext.. 1000 Leo Ball
1002 Terrell Smith 1001 Phillip Huff
1003 Dave Haris
1004 Troy Daniel

X Cancel
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« Number: Enter the purchased number or specify an Alphanumeric Sender
ID.

Note:

The phone number should be in E.164 format ([ +] [ count ry
code] [ phone nunber] ). For example, +14102161183.

- Destination for Inbound Messaging: Specify the destination of inbound
messages from the number.

Option Description

Extension If selected, choose an extension from the Extension
drop-down list.

Only the extension user can receive inbound messages
from the number.

Message Queue If selected, choose a queue from the Message Queue
drop-down list.

All the agents in the selected message queue can receive
inbound message(s) of new sessions in the queue.
However, only the user who picks up a session will be
able to receive and respond to the follow-up inbound
messages in the session.

Third-Party If selected, inbound messages will be automatically
Message forwarded to a third-party message analytics platform via
Analytics Platform  API for advanced processing.

(Transmitted via

API) 73 Note:

To enable automatic forwarding of inbound
messages to a third-party message analytics
platform, ensure that your PBX server has been
integrated with the third-party message analytics
platform via API. Once this option is selected, the
PBX system will automatically transmit inbound
messages to the designated platform. You can
get notified by monitoring the APl event (30031)
New Message Notification. Additionally, the PBX
provides a comprehensive Message API suite for
advanced message interaction with the integrated
third-party message analytics platforms.

- Extensions allowed to create messaging sessions: Select the exten-
sions that are allowed to initiate a messaging session with customers.


https://help.yeastar.com/en/p-series-cloud-edition/developer-guide/enable-yeastar-p-series-pbx-api.html
https://help.yeastar.com/en/p-series-cloud-edition/developer-guide/event-new-message-notification.html
https://help.yeastar.com/en/p-series-cloud-edition/developer-guide/event-new-message-notification.html
https://help.yeastar.com/en/p-series-cloud-edition/developer-guide/api-interfaces-and-events-summary.html#api-interface-and-event-overview__section_messaging
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d. Click Save.
5. Click Save.

Result

« A messaging channel is created successfully. You can see the channel displayed in

the Messaging Channel list with Status showing .

Status Name Type Number Total Sent Operations

@ SIPTRUNK SMS

SMS +14102161183 0 0 Z ™
Channel

« PBX automatically tracks and records the number of messages sent and received on

the channel, where the Total column indicates the total number of sent messages, in-
cluding both successfully sent messages and failed ones.

"4 Note:

. o For sent messages, PBX only tracks the number of the messages sent
from agents' Linkus UC Clients. If you want to calculate the actual cost
of sent messages, consult with the SMS service provider for the precise
number of messages transmitted, as long text messages (longer than
160 characters) are automatically split into segments and then re-as-
sembled when they are received, increasing the number of sent mes-
sages.

> You can filter the statistics by a time period using the time filter.

@ Add All

Number Total Sent Failed Received Operations

414102161183 30 20 10 8 Z

What to do next

Send text messages to the phone number and see if the specified agent can receive mes-
sages on his or her Linkus UC Client.

Related information
Check and Manage External Chat Logs

User Guide - Manage customer queries from SMS channel on Linkus Web Client /
Desktop Client
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User Guide - Manage customer queries from SMS channel on Linkus Mobile Client

Telnyx

Set up an SMS Channel for Telnyx

This topic describes how to set up a Telnyx SMS channel on Yeastar P-Series Cloud Edition,
so that agents in your business can receive and reply to SMS messages from customers on
their Linkus UC Clients.

Requirements

The Yeastar PBX should meet the following requirements:

« Firmware: Version 84.20.0.128 or later

« Plan: Enterprise Plan (EP) or Ultimate Plan (UP)

- Domain Name: Due to the limitation of the third-party platform, the domain name
must NOT contain underscore character(s), otherwise the messaging channel will en-
counter authentication failure, or will fail to receive messages.

- Domain Certificate: A valid domain certificate is installed.

Note:

If the root domain of your Cloud PBX is NOT the standard Yeastar-provided

domains (ycmcloud.com, yeastarcloud.com, or yeastarycm.co.za), you NEED
to install a valid domain certificate for the PBX first, otherwise the messaging
channel will encounter authentication failure, or will fail to receive messages.

Supported message types and limits

Supported message types

The Telnyx SMS channel supports text messages and multimedia messages
(MMS), where the supported MMS file types are determined by Telnyx. For
more information, see Telnyx supported MMS file types.

Important:

When sending multimedia messages (such as images), the SMS ser-
vice provider downloads the files from a link provided by the PBX.
Therefore, if you have set Allowed Country/Region IP Access Pro-



https://support.telnyx.com/en/articles/3102823-mms-sending-and-receiving#mms-file-types-and-sizes
https://help.yeastar.com/en/p-series-cloud-edition/administrator-guide/restrict-specific-countries-or-regions-from-accessing-yeastar-pbx.html
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tection rule, make sure that you have allowed the IP access from the
country where the SMS service provider is located, otherwise the file
transmission would fail.

Limits

s File size: Max. 100 MB
» File retention period: 72 hours

Procedure

» Step 1. Obtain a Webhook URL on PBX
« Step 2. Configure a number for SMS on Telnyx
«» Step 3. Create and configure an SMS channel on PBX

Step 1. Obtain a Webhook URL on PBX

Obtain a Webhook URL from PBX web portal first, which is required when you configure a
number for SMS on Telnyx.

1. Log in to PBX web portal, go to Messaging > Message Channel.
2. Click Add, and select SMS.
3. In the ITSP drop-down list, select Telnyx, then copy the Webhook URL.

Important:

The URL will change once you leave the current page, please make sure you
use the latest Webhook URL for the configuration on the service provider's
customer portal.

Authentication Messaging Settings

Please refer to the User Guide for information on how to configure the following settings
https://docs.example.yeastarcloud.com/api/v1.0/webhook/telnyx/90b4...

Telnyx

4. Note down the Webhook URL.


https://help.yeastar.com/en/p-series-cloud-edition/administrator-guide/restrict-specific-countries-or-regions-from-accessing-yeastar-pbx.html
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Step 2. Configure a number for SMS on Telnyx

Important:

According to US legislation (A2P 10DLC SMS), 10DLC (10-digit Long Code) phone
numbers that are used for A2P (Application-to-Person) messaging MUST be regis-
tered, otherwise SMS messages sent to US numbers from the unregistered 10DLC
numbers will be blocked.

If your business communicates with US-based customers, you should confirm the
registration requirements with the SMS service provider and complete the phone
number registration to avoid disruption in message delivery.

Log in to Telnyx portal, and complete the following settings:
1. Search and purchase a DID number with SMS feature.

Atelnyx P09 e

Available credit in USD +

Buy Number Number Orders

Real-Time Communications ~
Messaging v
: Buy Numbers
Voice v
Numbers ~
Country Required | Features Type Search By Area Code
Buy Numbers
United States of America +1 v SMS X MMS X v v Area code v v
Manage Numbers
Port Numbers Advanced Search v
Compliance Search Numbers
Reports @
Video v
Identity v Number Location/Rate Center Number Type Features Upfront Price Monthly Price
Fax +1555 123 4567 United States of America Toll free (iR =N ] US$1.00 US$1.00 Add to Cart
Virtual Networkin
g +1415 987 6543 United States of America Toll free (el =N ] US$1.00 US$1.00 Add to Cart
PR, +1212 555 7890 United States of America Toll free (S iaR =N ] US$1.00 US$1.00 Add to Cart

2. Create a message profile and configure messaging webhook with PBX's Webhook
URL.

Note:
For any settings not shown, configure them according to your actual require-
ments.



https://support.telnyx.com/en/articles/6325731-register-for-10dlc-messaging
https://support.telnyx.com/en/articles/6325731-register-for-10dlc-messaging
https://portal.telnyx.com
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&telnyx Proge

Real-Time Communications ~
« Back to Messaging Profiles
i ~
Messaging Create Messaging Profile
Programmable Messaging
ompliance
Profile Name Required 2. Allowed destinations
Settings
g Yeastar SMS Messaging 3. Inbound
Debug
API Version 4 Outbound
Reports 5. Senders

6. Keywords

Create Messaging Profile

Inbound settings 1. Details

Control how your profile handles incoming messages 2. Allowed destinations

Webhook URL @

https://docs.example.yeastar.com/api/v1.0/webhook 4. Outbound

Webhook Failover URL @ 5. Senders

6. Keywords

e.g. https://example.com

If you wish to send and receive using an SMPP bind 2, please email sales@telnyx.com 7

3. Assign the message profile to the purchased DID number.

Atelnyx Prove

My Numbers Hosted Messaging Numbers Short Code Verified Numbers

Real-Time Communications ~

Messaging v
My Numbers

Voice v

I Numbers ~ I [ Enter full or partial number (e.g. last 4 digits) Q |

T
* Buy Numbers N

. . .
Billing Group ~ | | Voice Billing Method -

. Ny . . \ N
| Status - || NumberType v || Source v || Tags~v || Connection v || Messaging Profile v
N J\ J\ AN J\ AN

| Manage Numbers |

N s N N
Port Numbers | Emergency Status ~ | | Bundles ~ || Number(s) on bundle pricing v || Countries v+ | C
\ AN J\ )\ J

Compliance & Export
Reports
Video v (O  Number$ Status Ci i ication ¢ jing profile Services
Identity v

(@] +1-410-216-1183 O ® Active Yeastar Yeastar SMS Messm@ ® < & 72|
Fax

4. Create an API key for the integration with PBX.

0 Important:
Properly copy and save the API key after it is created, as it will only be dis-

played once. You will not be able to view the key again after you close the API
key display window.
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o API Key Created X

(1) Copy the key value now as you will not be able to see it
again. Losing a key requires creating a new one.

APl Key
KEYQ197BFE1F2E68862C5280B+ ++# k%% % [n] |
Copy to clipboard and close
L -

Atelnyx P: 0986

Logged in as:
shirley@yeastar.com
Welcome, Shirley! Organization:
(D Xiamen Yeastar Information Technology Co.. Lid.

What's nev
Al, Storage and Compute v

<> APIkeys

10T and Wireless o Product Highlight: Conversational Al

6/24/2025
Design and deploy Al Assistants with global telephony and dedicated Private PG &  Account settings

infrastructure for agile, scalable and real-time engagement.

Real-Time Communications M
allocation "
Bl Manage biling

Dark mode (@ ]

Virtual Networking

Reporting v

Read more

- 6/23/2025
Ask our Al assistant Telnyxexg  Sign Out

|
1

1

1

1

1

1

1

1

1

1
Read more 2 1
1

1

1

1

1

1

1

1

1

1

1
!

€ Back
Account settings v

Friers . API Keys

APIKe
B Create and manage APl Keys to use with the Telnyx API v2

Organization API Keys

1
Public Key status APIKey Create API Key x  [eated LastUsed
1
Access Control Lists v " " - - b
® Active This API Key is encrypted Once created, you will be able to see and configure key details in Jun 2025 12:47 AM 30 Jun 2025 h:00 PM © 2
Advanced Features v the table view. 1
Integration Secrets ® Active This API Key is encrypted Tags IMay 2025 2:14 PM 18 Jun 2025 II:ZG AM

[ Select an existing option or enter a new one

Optional descriptor(s) to easily identify the APl key

Expiration

Expiration Date (UTC)

[ 07/31/2025 12:00 AM

5. Note down the Public key in Public Key page.

o] %4 0 9 @

Account settings v

APl Keys

Public Key

APl Keys
& Use your public key to validate Telnyx API V2 webhooks

Organization API Keys

Access Control Lists v | wb3e75 . YOWK= [a] |

Advanced Features ~

Integration Secrets
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Step 3. Create and configure an SMS channel on PBX

1. Log in to PBX web portal, go to Messaging > Message Channel.
2. Click Add, and select SMS.
3. In the Authentication tab, enter the authentication information of Telnyx.

Authentication Messaging Settings

Please refer to the User Guide for information on how to configure the following settings
Telnyx SMS channel https://docs.example.yeastarcloud.com/api/v1.0/webhook/telnyx/90...

Telnyx

- Name: Enter a name to help you identify the channel.
« ITSP: Select Telnyx.
* API Key: Paste the API Key obtained from Telnyx.
« Public Key: Paste the Public Key obtained from Telnyx.
4. In the Messaging Settings tab, configure the channel.
a. In the Message Sending Rate field, specify the number of messages that PBX
can send per second.

Note:

« If the number of messages to send exceeds the set value, PBX
will arrange the messages in queue and send them at the sending
rate.

- If the sending rate set in PBX exceeds the limit set by the SMS
service provider, it may result in message delivery failures. Con-
tact your SMS service provider to confirm the sending rate limit of
your account and increase the limit as needed.

b. Optional: If you want the system to automatically close the sessions that have
been inactive for a specific period of time, select the checkbox of Close Ses-
sion Automatically, then set the timeout in the Session Timeout (Days) field.
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Close Session Automatically

c. In the Number section, click Add to add a message routing rule.

Add X

*
+14102161183

For phone numbers, please enter them in E.164 format. For example, +86-532-5503309 should be entered as +865925503309.

Extension 3000-Leo Ball
4 items Available 2 items Selected
Extension Num... Caller ID Name Extension Num... Caller ID Name
Extension Group  Default_All_Ext.. 1000 Leo Ball
1002 Terrell Smith 1001 Phillip Huff
1003 Dave Haris
1004 Troy Daniel

X Cancel

« Number: Enter the purchased number or specify an Alphanumeric Sender
ID.

Note:

The phone number should be in E.164 format ([ +] [ count ry
code] [ phone nunber] ). For example, +14102161183.

» Destination for Inbound Messaging: Specify the destination of inbound
messages from the number.

Option Description

Extension If selected, choose an extension from the Extension
drop-down list.

Only the extension user can receive inbound messages
from the number.

Message Queue If selected, choose a queue from the Message Queue
drop-down list.




Omnichannel Messaging Guide | 2 - Administrator Guide | 44

Option Description

All the agents in the selected message queue can receive
inbound message(s) of new sessions in the queue.
However, only the user who picks up a session will be
able to receive and respond to the follow-up inbound
messages in the session.

Third-Party If selected, inbound messages will be automatically
Message forwarded to a third-party message analytics platform via
Analytics Platform  API for advanced processing.

(Transmitted via

API) / Note:

To enable automatic forwarding of inbound
messages to a third-party message analytics
platform, ensure that your PBX server has been
integrated with the third-party message analytics
platform via API. Once this option is selected, the
PBX system will automatically transmit inbound
messages to the designated platform. You can
get notified by monitoring the API event (30031)
New Message Notification. Additionally, the PBX
provides a comprehensive Message API suite for
advanced message interaction with the integrated
third-party message analytics platforms.

- Extensions allowed to create messaging sessions: Select the exten-
sions that are allowed to initiate a messaging session with customers.

d. Click Save.
5. Click Save.

Result

« A messaging channel is created successfully. You can see the channel displayed in

the Messaging Channel list with Status showing Q.

Status Name Type Number Total Sent Operations

(@) Telnyx SMS channel ~ SMS +14102161183 0 0 Z T

« PBX automatically tracks and records the number of messages sent and received on

the channel, where the Total column indicates the total number of sent messages, in-
cluding both successfully sent messages and failed ones.


https://help.yeastar.com/en/p-series-cloud-edition/developer-guide/enable-yeastar-p-series-pbx-api.html
https://help.yeastar.com/en/p-series-cloud-edition/developer-guide/event-new-message-notification.html
https://help.yeastar.com/en/p-series-cloud-edition/developer-guide/event-new-message-notification.html
https://help.yeastar.com/en/p-series-cloud-edition/developer-guide/api-interfaces-and-events-summary.html#api-interface-and-event-overview__section_messaging
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"4 Note:

. o For sent messages, PBX only tracks the number of the messages sent
from agents' Linkus UC Clients. If you want to calculate the actual cost
of sent messages, consult with the SMS service provider for the precise
number of messages transmitted, as long text messages (longer than
160 characters) are automatically split into segments and then re-as-
sembled when they are received, increasing the number of sent mes-
sages.

> You can filter the statistics by a time period using the time filter.

@ Add All

Number Total Sent Failed Received Operations

414102161183 30 20 10 8 Z

What to do next

Send text messages to the phone number and see if the specified agent can receive mes-
sages on his or her Linkus UC Client.

Related information
Check and Manage External Chat Logs
User Guide - Manage customer queries from SMS channel on Linkus Web Client /
Desktop Client
User Guide - Manage customer queries from SMS channel on Linkus Mobile Client

Twilio

Set up an SMS Channel for Twilio

This topic describes how to set up a Twilio SMS channel on Yeastar P-Series Cloud Edition,
so that agents in your business can receive and reply to SMS messages from customers on
their Linkus UC Clients.

Requirements

The Yeastar PBX should meet the following requirements:
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« Firmware: Version 84.20.0.128 or later

« Plan: Enterprise Plan (EP) or Ultimate Plan (UP)

- Domain Name: Due to the limitation of the third-party platform, the domain name
must NOT contain underscore character(s), otherwise the messaging channel will en-
counter authentication failure, or will fail to receive messages.

- Domain Certificate: A valid domain certificate is installed.

Note:

If the root domain of your Cloud PBX is NOT the standard Yeastar-provided

domains (yemcloud.com, yeastarcloud.com, or yeastarycm.co.za), you NEED
to install a valid domain certificate for the PBX first, otherwise the messaging
channel will encounter authentication failure, or will fail to receive messages.

Supported message types and limits

Supported message types

The Twilio SMS channel supports text messages and multimedia messages
(MMS), where the supported MMS file types are determined by Twilio. For
more information, see Twilio supported MMS file types.

Important:

When sending multimedia messages (such as images), the SMS ser-
vice provider downloads the files from a link provided by the PBX.
Therefore, if you have set Allowed Country/Region IP Access Pro-
tection rule, make sure that you have allowed the IP access from the
country where the SMS service provider is located, otherwise the file
transmission would fail.

Limits
* File size: Max. 100 MB
» File retention period: 72 hours
Procedure

» Step 1. Obtain a Webhook URL on PBX
» Step 2. Configure a number for SMS on Twilio
« Step 3. Create and configure an SMS channel on PBX



https://www.twilio.com/docs/sms/troubleshooting/accepted-mime-types
https://help.yeastar.com/en/p-series-cloud-edition/administrator-guide/restrict-specific-countries-or-regions-from-accessing-yeastar-pbx.html
https://help.yeastar.com/en/p-series-cloud-edition/administrator-guide/restrict-specific-countries-or-regions-from-accessing-yeastar-pbx.html
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Step 1. Obtain a Webhook URL on PBX
Obtain a Webhook URL from PBX web portal first, which is required when you configure a
number for SMS on Twilio.

1. Log in to PBX web portal, go to Messaging > Message Channel.
2. Click Add, and select SMS.
3. In the ITSP drop-down list, select Twilio, then copy the Webhook URL.

Important:

The URL will change once you leave the current page, please make sure you
use the latest Webhook URL for the configuration on the service provider's
customer portal.

Authentication Messaging Settings

Please refer to the User Guide for information on how to configure the following settings.

https://docs.example.yeastarcloud.com/api/v1.0/webhook/twilio/90b -

Twilio

4. Note down the Webhook URL.

Step 2. Configure a number for SMS on Twilio

Important:

According to US legislation (A2P 10DLC SMS), 10DLC (10-digit Long Code) phone
numbers that are used for A2P (Application-to-Person) messaging MUST be regis-
tered, otherwise SMS messages sent to US numbers from the unregistered 10DLC
numbers will be blocked.

If your business communicates with US-based customers, you should confirm the
registration requirements with the SMS service provider and complete the phone
number registration to avoid disruption in message delivery.

Log in to Twilio portal, and complete the followings:

1. Search and purchase a number with SMS feature.


https://support.twilio.com/hc/en-us/articles/1260801864489-How-do-I-register-to-use-A2P-10DLC-messaging-
https://support.twilio.com/hc/en-us/articles/1260801864489-How-do-I-register-to-use-A2P-10DLC-messaging-
https://www.twilio.com
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0 Tip:

You can check the SMS service pricing here.

Console
Account v Billng v Test Account v
® testaccount@mail.com's Account | ¢ Q 9 @

peveiop | vontor— Buy @ Number

Country Capabilities
Elastic SIP
> & runking g us (+1) United States - US Q W voice | @ svs M wmvs | B Fax
v # Phone Numbers Search criteria Matehto
+ Manage Number ristpartotmumber | ([ meser iers

a code, | our phone number

» Advanced Search

Buy anumber

Verified Caller IDs
TwiML apps Number Type Capabilities Address Requirement Monthly fee

> Port& Host Voice sMs MMS Fax

+1972996 72524

Richardson, TX US

Local S = =] i) None $1.15 Buy

+124831369294
Walled Lake, MI US

Local S a & & None $1.15 Buy

2. Edit the purchased number to configure the messaging webhook with PBX's Webhook
URL.

ser | we Active Numbers

Elastic SIP @ A2 10DLC registration reqy " N N
> & Tunking q " | Messaging Configuration

© Check the A2P 10DLC regist,

Inventory Filters

A2P 10DLC registration required for US messaging.

Numbe
0 the US with this US local number, 3 registration process is required. Learn more about A2P 10DLC registration (% or Check the A2P 10DLC registration
Numb
Initiate AZP 10DLC registration >
«uwz‘sﬁ"mw
usus I

URL HTTR
HTTP POST

Primary handier fails URL HTTP
Webhook v HTTP POST

3. Enable the geographic permission for the desired region(s) where you want to send
SMS messages, so that messages can be successfully sent to the phone numbers
within the region(s).

Note:

This setting should be completed in the parent account.


https://www.twilio.com/en-us/sms/pricing/us
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Console

Account v Billing v Test Account v
® testaccount@mail.com’s Account | " g v @) Test Accoun

Develop Monitor . . .o ®
Messaging Geographic Permissions
v [ Messaging Filter by country
Overview Q
> Tryitout
Services North America
> Senders
Anguilla (+1264) Antigua and Barbuda (+1268) Aruba (+297)
Content Editor Ascension (+247) Bahamas (+1242) Barbados (+1246)
+"Beta Belize (+501) Bermuda (+1441) Canada (+1)
v Settings Cayman Islands (+1345) Costa Rica (+506) Cuba (+53)
— Curagao and Caribbean Netherlands (Bonaire, Sint || Dominica (+1767) Dominican Republic (+1829)
Eustatius, Sint Maarten, Saba) (+599)
Log archives Dominican Republic (+1849) Dominican Republic (+1809201) Dominican Republic (+1809)
Eorprs El Salvador (+503) Greenland (+299) Grenada (+1473)
) Guadeloupe (+590) Guatemala (+502) Haiti (+509)
Add-ons+*Beta
Honduras (+504) Jamaica (+1876) Martinique (+596)
® Docs and Support Mexico (+52) Montserrat (+1664) Nicaragua (+505)
Panama (+507) Puerto Rico (+1787) St Kitts and Nevis (+1869)

«

4. Go to your account's dashboard, note down the Account SID and Auth Token, as
you will need to use it on PBX later.

Note:
The account MUST be the one used for purchasing the number. That is, if the
number is purchased using a sub-account, you need to access the sub-ac-

count's dashboard to obtain the information.

Console

Develop Monitor @ Al US. SMS and MMS messages from unregistered 10DLC phone numbers are now blocked. Please register your numbers
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Account v Bilng v (@) Test Account v

@ Al US.SMS and MM messages from unregistered 10DLC phone numbers are now blocked. Please register your numbers, get approved and resume messaging. Learn more (2

Ahoy , welcome to Twilio!

Connect to 3rd-party applications Invite teammates

> Voice
You'll need 3 things to use Twilio with most 3rd-party applications Add developers in your team to your account,

Invite teammates >

+
Geta trial phone numt Talk to Sales
Read 3rd-party integration FAQ Connect with a Twilio expert to find out what products and plans best suit your needs.
Talk to Sales (2
~ Account Info ~ Helpful links
Account SID Tuwilio work? (2
ACXRO000ONOKIXXNR 49 ute v
C Sh
® Docs and Support 5 T =
«

Step 3. Create and configure an SMS channel on PBX

1. Log in to PBX web portal, go to Messaging > Message Channel.

2. Click Add, and select SMS.
3. In the Authentication tab, enter the authentication information of Twilio.

Authentication Messaging Settings

Please refer to the User Guide for information on how to configure the following settings.

* *

Twilio SMS channel https://docs.example.yeastarcloud.com/api/v1.0/webhook/twilio/90b4

%
Twilio

*

« Name: Enter a name to help you identify the channel.
« ITSP: Select Twilio.
« Account SID: Paste the Account SID obtained from Twilio.
« Auth Token: Paste the Auth Token obtained from Twilio.
4. In the Messaging Settings tab, configure the channel.
a. In the Message Sending Rate field, specify the number of messages that PBX
can send per second.

| Note:
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« If the number of messages to send exceeds the set value, PBX
4 will arrange the messages in queue and send them at the sending
rate.

« If the sending rate set in PBX exceeds the limit set by the SMS
service provider, it may result in message delivery failures. Con-
tact your SMS service provider to confirm the sending rate limit of
your account and increase the limit as needed.

b. Optional: If you want the system to automatically close the sessions that have
been inactive for a specific period of time, select the checkbox of Close Ses-
sion Automatically, then set the timeout in the Session Timeout (Days) field.

Close Session Automatically

c. In the Number section, click Add to add a message routing rule.

Add X

+14102161183

For phone numbers, please enter them in E.164 format. For example, +86-592-5503309 should be entered as +865925503309.

Extension 3000-Leo Ball
4 items Available 2 items Selected
Extension Num... Caller ID Name Extension Num... Caller ID Name
Extension Group  Default_All_Ext.. 1000 Leo Ball
1002 Terrell Smith 1001 Phillip Huff
1003 Dave Haris
1004 Troy Daniel

X Cancel

« Number: Enter the purchased number or specify an Alphanumeric Sender
ID.

| Note:
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The phone number should be in E.164 format ([ +] [ count ry
code] [ phone nunber] ). For example, +14102161183.

« Destination for Inbound Messaging: Specify the destination of inbound
messages from the number.

Option Description

Extension If selected, choose an extension from the Extension
drop-down list.

Only the extension user can receive inbound messages
from the number.

Message Queue If selected, choose a queue from the Message Queue
drop-down list.

All the agents in the selected message queue can receive
inbound message(s) of new sessions in the queue.
However, only the user who picks up a session will be
able to receive and respond to the follow-up inbound
messages in the session.

Third-Party If selected, inbound messages will be automatically
Message forwarded to a third-party message analytics platform via
Analytics Platform  API for advanced processing.

(Transmitted via

API) ,’ Note:

To enable automatic forwarding of inbound
messages to a third-party message analytics
platform, ensure that your PBX server has been
integrated with the third-party message analytics
platform via API. Once this option is selected, the
PBX system will automatically transmit inbound
messages to the designated platform. You can
get notified by monitoring the API event (30031)
New Message Notification. Additionally, the PBX
provides a comprehensive Message API suite for
advanced message interaction with the integrated
third-party message analytics platforms.

- Extensions allowed to create messaging sessions: Select the exten-
sions that are allowed to initiate a messaging session with customers.

d. Click Save.
5. Click Save.


https://help.yeastar.com/en/p-series-cloud-edition/developer-guide/enable-yeastar-p-series-pbx-api.html
https://help.yeastar.com/en/p-series-cloud-edition/developer-guide/event-new-message-notification.html
https://help.yeastar.com/en/p-series-cloud-edition/developer-guide/event-new-message-notification.html
https://help.yeastar.com/en/p-series-cloud-edition/developer-guide/api-interfaces-and-events-summary.html#api-interface-and-event-overview__section_messaging
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Result

« A messaging channel for Twilio is created successfully. You can see the channel dis-

played in the Messaging Channel list with Status showing Q.

Status Name Type Number Total Sent Operations

@ Twilio SMS channel SMS +14102161183 0 0 Z ‘E[

« PBX automatically tracks and records the number of messages sent and received on

the channel, where the Total column indicates the total number of sent messages, in-
cluding both successfully sent messages and failed ones.

"4 Note:

. o For sent messages, PBX only tracks the number of the messages sent
from agents' Linkus UC Clients. If you want to calculate the actual cost
of sent messages, consult with the SMS service provider for the precise
number of messages transmitted, as long text messages (longer than
160 characters) are automatically split into segments and then re-as-
sembled when they are received, increasing the number of sent mes-
sages.

> You can filter the statistics by a time period using the time filter.

@ Add All

Number Total Sent Failed Received Operations

414102161183 30 20 10 8 Z

What to do next

Send text messages to the phone number and see if the specified agent can receive mes-
sages on his or her Linkus UC Client.

Related information
Check and Manage External Chat Logs
User Guide - Manage customer queries from SMS channel on Linkus Web Client /
Desktop Client
User Guide - Manage customer queries from SMS channel on Linkus Mobile Client
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VoiceMeUp

Set up an SMS Channel for VoiceMeUp

This topic describes how to set up a VoiceMeUp SMS channel on Yeastar P-Series Cloud
Edition, so that agents in your business can receive and reply to SMS messages from cus-
tomers on their Linkus UC Clients.

Requirements

The Yeastar PBX should meet the following requirements:

« Firmware: Version 84.20.0.128 or later

« Plan: Enterprise Plan (EP) or Ultimate Plan (UP)

- Domain Name: Due to the limitation of the third-party platform, the domain name
must NOT contain underscore character(s), otherwise the messaging channel will en-
counter authentication failure, or will fail to receive messages.

- Domain Certificate: A valid domain certificate is installed.

Note:

If the root domain of your Cloud PBX is NOT the standard Yeastar-provided

domains (ycmcloud.com, yeastarcloud.com, or yeastarycm.co.za), you NEED
to install a valid domain certificate for the PBX first, otherwise the messaging
channel will encounter authentication failure, or will fail to receive messages.

Supported message types and limits

Supported message types

The VoiceMeUp SMS channel supports text messages and multimedia mes-
sages (MMS), where the supported MMS file types are determined by Voice-
MeUp.

Important:

When sending multimedia messages (such as images), the SMS ser-
vice provider downloads the files from a link provided by the PBX.
Therefore, if you have set Allowed Country/Region IP Access Pro-
tection rule, make sure that you have allowed the IP access from the



https://help.yeastar.com/en/p-series-cloud-edition/administrator-guide/restrict-specific-countries-or-regions-from-accessing-yeastar-pbx.html
https://help.yeastar.com/en/p-series-cloud-edition/administrator-guide/restrict-specific-countries-or-regions-from-accessing-yeastar-pbx.html
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country where the SMS service provider is located, otherwise the file
transmission would fail.

Limits

s File size: Max. 100 MB
» File retention period: 72 hours

Procedure

» Step 1. Obtain a Webhook URL on PBX
« Step 2. Configure messaging feature on VoiceMeUp
« Step 3. Create and configure an SMS channel on PBX

Step 1. Obtain a Webhook URL on PBX

Obtain a Webhook URL from PBX web portal first, which is required when you configure a
number for SMS on VoiceMeUp.

1. Log in to PBX web portal, go to Messaging > Message Channel.
2. Click Add, and select SMS.
3. In the ITSP drop-down list, select VoiceMeUp, then copy the Webhook URL.

Important:

The URL will change once you leave the current page, please make sure you
use the latest Webhook URL for the configuration on the service provider's
customer portal.

Authentication Messaging Settings
Please refer to the User Guide for information on how to configure the following settings
https://docs.example.yeastarcloud.com/api/v1.0/webhook/voicemeu

VoiceMeUp

4. Note down the Webhook URL.
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Step 2. Configure messaging feature on VoiceMeUp
Log in to VoiceMeUp customer portal, and complete the following settings:

1. Purchase a DID number with SMS feature.

Important:

According to US legislation (A2P 10DLC SMS), 10DLC (10-digit Long Code)
phone numbers that are used for A2P (Application-to-Person) messaging
MUST be registered, otherwise SMS messages sent to US numbers from the
unregistered 10DLC numbers will be blocked.

If your business communicates with US-based customers, you should con-
tact the SMS service provider to complete 10DLC registration for your DID
number to avoid disruption in message delivery.

ly
@ MMs and SMs

2. Configure messaging webhook for the DID number.
a. Go to the edition page of the desired DID number.


https://clients.voicemeup.com/v3/login

Q search

© DID Numbers

B =

Y Fil
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Search String

Search Field(s)
v

O O oo

D

54213

54214

55486

Use new lines or commas for multipie search

/ Friendly Name.

Friendly Name

4102161183

PBX's Webhook URL.

Available Options

Basic Call Flow
Peer | SIP Trunk

ste call to selected peer(s)

Rol

[ Media playback

Play a media file to the caller

Applications
Virtual fax

send call to fax service

Additional Options
[ call recording

Record inbound calls associated to this number

A

2 SMS/MMS options

Enable SMS/MMS for this DID

Enable forwarding @

O

Enable email notifications @

O

Enable autoreply @

O

Enable Callback URL @

[ enable SMs DNIS Override

[ call queue

Send call to a call queue

[ voicemail

Send call to a voice mailbox

Virtual attendant

Route the call to a virtual attendant profile

O rilters

Block calls based on selected criteria

+/ Phone Number

Showing item 1 to 3. Total: 3

Type DID Number

Local B B 1@

Local B B &

[ call forward

Forward the call to another number

SIP URI

Route call to another SIP address

SMS/MMS options @

Modify SMS/MMS options for this number

SMS/MMS Profile (Optional)

You don't have any

N

Forwarding number

Notification email

Autoreply message

Callback URL

profiles

Profiles

1 are not using an SMS/SMS Profile, please use the options below

Local B B @  +1 410-216-1183

—
peer(s) Options Action
SIP [ ITest - Yeastar Interop |

b. Enable SMS/MMS for the DID number, and configure the Callback URL using the

O call director @

Send call to director service

Conference @

Muttiple party conference system

[ Advanced options

Additional options for advanced users

https://docs.example.yeastarcloud.com/api/vl.0/webhook/voicemeup/885c2304e90040850749552a56¢279b4

Advanced option : Incoming SMS/MMS messages will be transmitted to the Callback URL

SMS DNIS override
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3. Configure a user account used for the integration with PBX.
a. Create a user account.

ACCOUNT
O yeastar_interop ~

Ml 88 Users & Access

Blofo roer] % BN 0 covecoer
-

Qsearch Y Filtes

Apply

1
W CDlefclefe[-[e[«[ o[ Iv]er el s o v [w]x]]e]
: search string
1
1
! g
+ search Field(s)

v Vs v / email O co

15 items p Showing item 10 8. Total: 8
a D Typ Access Usernam First Name Last Name Email Notifications Action

b. Configure the account information, and enable API access for the account.

Note:

Note down the username you set, as you will need it later on PBX.
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User Type @
Please remember to adjust the permissions after saving, as new users
standard - will have access to all applications by default.
Username

yeastar_test

First Name Last Name
Example Yeastar

Email Phone Number Extension
example@yeastar.com |8 R

Fax Number Preferred Language

Ofrench @ English

Time Zone

AmericafMontreal [GMT -4]

O Allow login to the client section ~/ Allow access to the API

APl access is a big security risk because it allows anyone with the key to make changes in your account. Make sure not to disclose it anywhere.

Client Account ID Auth Token

IMPORTANT - Regenerating a token renders the previous token obsolete.

//clientsvoicemeup.com/api/vil/xml/get_re

st_types?username=USERNAME&auth_token=AUTH_TOKEN

Documentation URL

oper.voicemeup.com/guides/xml_engine htmi

5 Copyright 2006-2023, Internet Infinity. All rights reserved.

An account is created successfully; You are redirected the user account list.
c. Go to the account's details page, and obtain the Auth Token for the integration.

Allow login to the client section Allow access to the API

APl access is a big security risk because it allows anyone with the key to make changes in your account. Make sure not to disclose it
anywhere.

Client Account ID Auth Token

80020576 DO © m

Step 3. Create and configure an SMS channel on PBX

Create an SMS channel on PBX, and configure the channel with the authentication informa-
tion and number obtained from VoiceMeUp.
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1. Log in to PBX web portal, go to Messaging > Message Channel.

2. Click Add, and select SMS.
3. In the Authentication tab, enter the authentication information of VoiceMeUp.

Authentication Messaging Settings

VoiceMeUp SMS channel https://docs.example.yeastarcloud.com/api/v1.0/webhook/voicemeu

VoiceMeUp

- Name: Enter a name to help you identify the channel.
+ ITSP: Select VoiceMeUp.
« Username: Paste the username of the VoiceMeUp account.
« Auth Token: Paste the auth token of the VoiceMeUp account.
4. In the Messaging Settings tab, configure the channel.
a. In the Message Sending Rate field, specify the number of messages that PBX
can send per second.

Note:

« If the number of messages to send exceeds the set value, PBX
will arrange the messages in queue and send them at the sending
rate.

« If the sending rate set in PBX exceeds the limit set by the SMS
service provider, it may result in message delivery failures. Con-
tact your SMS service provider to confirm the sending rate limit of
your account and increase the limit as needed.

b. Optional: If you want the system to automatically close the sessions that have
been inactive for a specific period of time, select the checkbox of Close Ses-
sion Automatically, then set the timeout in the Session Timeout (Days) field.

Close Session Automatically
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c. In the Number section, click Add to add a message routing rule.

Add X

*
+14102161183

For phone numbers, please enter them in E.164 format. For example, +86-592-5503309 should be entered as +865925503309.

Extension 3000-Leo Ball
4 items Available 2items Selected
Extension Num... Caller ID Name Extension Num... Caller ID Name
Extension Group  Default_All_Ext.. 1000 Leo Ball
1002 Terrell Smith 1001 Phillip Huff
1003 Dave Haris
1004 Troy Daniel

X Cancel

« Number: Enter the purchased number or specify an Alphanumeric Sender
ID.

Note:

The phone number should be in E.164 format ([ +] [ count ry
code] [ phone nunber] ). For example, +14102161183.

- Destination for Inbound Messaging: Specify the destination of inbound
messages from the number.

Option Description

Extension If selected, choose an extension from the Extension
drop-down list.

Only the extension user can receive inbound messages
from the number.

Message Queue If selected, choose a queue from the Message Queue
drop-down list.

All the agents in the selected message queue can receive
inbound message(s) of new sessions in the queue.
However, only the user who picks up a session will be
able to receive and respond to the follow-up inbound
messages in the session.
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Option Description

Third-Party If selected, inbound messages will be automatically
Message forwarded to a third-party message analytics platform via
Analytics Platform  API for advanced processing.

(Transmitted via

API) / Note:

To enable automatic forwarding of inbound
messages to a third-party message analytics
platform, ensure that your PBX server has been
integrated with the third-party message analytics
platform via API. Once this option is selected, the
PBX system will automatically transmit inbound
messages to the designated platform. You can
get notified by monitoring the API event (30031)
New Message Notification. Additionally, the PBX
provides a comprehensive Message API suite for
advanced message interaction with the integrated
third-party message analytics platforms.

- Extensions allowed to create messaging sessions: Select the exten-
sions that are allowed to initiate a messaging session with customers.
d. Click Save.
5. Click Save.

Result

« A messaging channel is created successfully. You can see the channel displayed in

the Messaging Channel list with Status showing .

Status Name Type Number Total Sent Operations

VoiceMeUp SMS

SMS +14102161183 0 0 Z T
channel

@

» PBX automatically tracks and records the number of messages sent and received on
the channel, where the Total column indicates the total number of sent messages, in-
cluding both successfully sent messages and failed ones.

Note:

o For sent messages, PBX only tracks the number of the messages sent
from agents' Linkus UC Clients. If you want to calculate the actual cost
of sent messages, consult with the SMS service provider for the precise
number of messages transmitted, as long text messages (longer than



https://help.yeastar.com/en/p-series-cloud-edition/developer-guide/enable-yeastar-p-series-pbx-api.html
https://help.yeastar.com/en/p-series-cloud-edition/developer-guide/event-new-message-notification.html
https://help.yeastar.com/en/p-series-cloud-edition/developer-guide/event-new-message-notification.html
https://help.yeastar.com/en/p-series-cloud-edition/developer-guide/api-interfaces-and-events-summary.html#api-interface-and-event-overview__section_messaging
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160 characters) are automatically split into segments and then re-as-
4 sembled when they are received, increasing the number of sent mes-
sages.

> You can filter the statistics by a time period using the time filter.

Number Total Sent Failed Received Operations

+14102161183 30 20 10 8 Z ™

What to do next

Send text messages to the phone number and see if the specified agent can receive mes-
sages on his or her Linkus UC Client.

Related information
Check and Manage External Chat Logs
User Guide - Manage customer queries from SMS channel on Linkus Web Client /
Desktop Client
User Guide - Manage customer queries from SMS channel on Linkus Mobile Client

Custom SMS Channel

Integrate SMS Service with Yeastar P-Series Cloud Edition using
SMS API

Yeastar P-Series Cloud Edition allows Service Providers to integrate their SMS service with
the PBX system using SMS API. This topic describes how Service Provider can achieve the
interaction of SMS service with Yeastar PBX using API, and introduces how PBX administra-
tors can set up an SMS channel for the Service Provider on PBX system.

Requirements

To implement the SMS service integration with Yeastar P-Series Cloud Edition, Yeastar PBX
and Service Provider must meet the following requirements.

Platform Requirement

Yeastar PBX * Firmware: Version 84.20.0.128 or later
* Plan: Enterprise Plan (EP) or Ultimate Plan (UP)
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Platform Requirement

» Domain Name: Due to the limitation of the third-party platform, the
domain name must NOT contain underscore character(s), otherwise
the messaging channel will encounter authentication failure, or will fail
to receive messages.

» Domain Certificate: A valid domain certificate is installed.

,'* Note:
If the root domain of your Cloud PBX is NOT the
standard Yeastar-provided domains (ycmcloud.com,
yeastarcloud.com, or yeastarycm.co.za), you NEED to
install a valid domain certificate for the PBX first, otherwise the
messaging channel will encounter authentication failure, or will
fail to receive messages.

Service Provider  API: Service Provider should provide the following API interfaces.

o HTTPS REST API for sending messages.

o (Optional) If the service provider requires PBX to verify its
identity, an HTTPS REST API for verifying authentication should
also be provided.

» Customer Portal Feature: Service Provider should offer the following
features on its customer portal.

> Provide an API key to authenticate API requests sent from PBX
system.

o (Optional) If the Service Provider requires signature verification
for webhook requests sent to the PBX, a Secret should also be
provided for the PBX to verify the authenticity of the webhook
requests.

> Support for configuring Webhook through the customer portal.

* Number Format: Phone numbers should follow the E.164 format.

Authenticate requests
As the SMS service integration is implemented via API interactions between Service

Provider and PBX, the Service Provider should provide an APl key and a Secret for the re-
quest authentication of APIs and webhooks in the integration.

- API key

The API key is used to authenticate the API requests sent from PBX to Service
Provider.

The PBX will pass the API key in the header of each API request under an Aut hor i za-
ti on field, as shown below:

Aut hori zati on: Bearer {api_key}
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Upon receiving an API request, Service Provider verifies the APl key extracted from the
request header. If the API key is valid, the Service Provider should execute the corre-
sponding actions as specified in the request. Otherwise, the API request fails.
For more information about the API request, see the followings:

o (Optional) Verify SMS channel connectivity

> Send messages through Service Provider

* Secret

The Secret is used to authenticate the webhook requests sent from Service Provider
to PBX.

Note:
Whether the Secret is required depends on whether the Service Provider uses
it for signature verification in webhook request.

When sending a message to PBX via webhook, the Service Provider needs to utilize
the Secret along with the SHA256 algorithm to generate a signature based on the
webhook request body, and pass the signature in the header of each webhook request
under an X- Si gnat ur e- 256 field, as shown below:

Important:
The signature included in the request header must be in all lowercase letters.

X- Si gnat ur e- 256: sha256={si gnat ur e}

Upon receiving a webhook request, PBX calculates a signature using the Secret along
with SHA256 algorithm based on the received webhook request body, then compares
the result with the signature extracted from the request header. If the signatures
match, it indicates that the webhook request is valid and PBX will deliver the message
retrieved from the request body to the message recipient. Otherwise, the webhook re-
quest will be rejected.

For more information about the webhook request, see Receive messages from Ser-
vice Provider.

(Optional) Verify SMS channel connectivity

| Note:
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Whether to perform this operation depends on the Service Provider's requirement
£ for identity verification. If not required, it can be skipped.

Once an SMS channel has been established on PBX web portal, the system will periodical-
ly send API requests to Service Provider using the API address for verifying authentication
and API key to verify the connectivity of the channel.

Interaction flow

The process of channel connectivity verification is shown below:

Yeastar P-Series
PBX System

w
©
5
=
o
o
o
=
(s}
=
o
o
=

Send request to APl
GET /verify?challenge_code

Verify
APl key

Return status code 200

and challenge_code

Verify the
challenge_code

1. PBX initiates an API request, containing a randomly generated challenge
code.

2. Upon receiving the API request, Service Provider validates the API key.

3. If the API key is valid, Service Provider should return a status code 200,
and include the challenge code in the response body.

4. Upon receiving the response, PBX checks if the returned challenge code
matches the one it sent.

If the challenge code matches, it indicates that the channel connection
is successful.

APl request sent by PBX
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Below is the structure and explanation of the API request sent by PBX for
channel connectivity verification.

Request method
GET

Request URL

{api _address_for_verifying_authentication}
For example:

https://service-provi der. exanpl e. com verify

Headers

Parameter Description

Authorizatio String Pass the API key in the header.

n Format: Bearer { api _key}

Query parameter

Parameter Description

challenge  String Challenge code. A random string that is
generated by PBX.

Request example

GET /
verify?chal | enge=mAWGyeTZgguOPYl Wt GPl RIYI hoLMy
HTTP/ 1.1
Host: service-provider.exanpl e.com
Aut hori zati on: Bearer {api_key}
API response returned by Service Provider

Service Provider should return the API response in JSON format.

Success response

If the request is successful, Service Provider should return the
following information in the response:

« HTTP status code 200
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« The challenge code that was sent by PBX in the request

For example:

HTTP/ 1.1 200 OK
Body: mAWGIYeTZgguOPYl W t GPl RJYI hoLMy

If the challenge code in the response body matches the one sent
by PBX, it indicates that the channel has successfully connected.
In this case, the channel status on PBX web portal is displayed

as © (Connected).

Error response

If the request fails, Service Provider should return the error infor-
mation in the response according to the following format.

Parameter Type Description
code String Error code.
title String Error type (Customizable).
detail String Detailed information of the error
(Customizable).

The following example shows a response of a failed channel
connectivity verification.

HTTP/ 1.1 401 Unaut hori zed

{
"errors": |
{
"code": "10004",
"title": "Authentication failed",
"detail": "No key found matching the ID
with the provided secret."
}
]
}

Exceptions and troubleshooting

If channel connectivity verification fails, the channel on PBX web
portal will display an abnormal status. Service Provider can trou-
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bleshoot the cause of the anomaly by checking the error code

and response body.

* Error code

The table below lists the error codes defined in the PBX.

Error Message

Description

channel.ErrinvalidPhon

channel.ErrinvalidPara

channel.ErrUnsupportM

channel.ErrAuthFail
channel.ErrAuthFail

channel.ErrTooManyRe

channel.ErrServiceUnav

channel.ErrExceedsSiz

Invalid phone number.

Invalid parameter in the
request.

Resource type not
supported (MMS).

Authentication failed.
No permission.

Too many requests.

Service unavailable on
recipient's platform.

File size exceeds the

Error
Code
10001
eNumber
10002
m
10003
edia
10004
10005
10006
quest
10007
ailable
10008
eLimit

limit.

« Exceptions

The table below lists the possible abnormal channel sta-
tuses and their trigger conditions.

Channel
Status

Unauthorized

Services of
the recipient
platform are
unavailable

Unknown

Trigger Condition

o Authentication failed, Service
Provider returns HTTP status code
401/403/404.

> The returned challenge code does
not match the one sent by the PBX.

Service Provider returns HTTP status code
500.

Service Provider returns HTTP status code
except for 401/403/404/500, and returns error
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Channel : i
Status Trigger Condition
information in the response body according
to the format defined by the PBX.
Request Failed o Service Provider does not return

an HTTP status code, possibly
due to TCP connection issues or
non-existent domain.

o Service Provider returns HTTP status
code except for 401/403/404/500, and
does not return a response body or
the returned response body is not in
JSON format.

Send messages through Service Provider

When a PBX user sends a message, PBX will send an API request to the Service Provider us-
ing the API interface for sending messages and API key, so as to deliver the message to ex-
ternal message recipient through Service Provider.

Interaction flow

The process of sending a message through Service Provider is shown below:

Yeastar P-Series
PBX System !

e}
o
X
c
@
e

Send - 1

Sendrequest to API
POST /sendmessage

Return status code 200
-—
and data.id

i
Deliver the }
|

1. A PBX user sends a message.

2. PBX initiates an API request to send a message through the Service
Provider.

3. Upon receiving the API request, the Service Provider validates the API
key.

4. If the API key is valid, the Service Provider should return a status code
200 and a dat a. i d to pass the unique ID of the message.
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5. Service Provider delivers the message to the message recipient.

APl request sent by PBX

Below is the structure and explanation of the API request sent by PBX for
sending a message through Service Provider.

Request method
POST

Request URL

{api _address_for_sendi ng_nessage}
For example:

https://service-provider. exanpl e. conl sendnessage

Headers
Parameter Type Description
Content-Ty  String Define the content type of the request
pe payload.
Valid value: application/json
Authorizatio String Pass the API key in the header.
n Format: Bearer { api _key}
Request body

PBX will pass the outbound message in the request body.

Param

T D ipti
eter ype escription
from String Phone number of the message sender.
Note:
This parameter should be in E.164
format. For example, +8618012121222.
to String Phone number of the message recipient.
I Note:




Omnichannel Messaging Guide | 2 - Administrator Guide | 72

Param
T D ipti
eter ype escription
Y This parameter should be in E.164
4 format. For example, +8618012121222.
text String The textual content of the message.

media_ur Array<Str The URL(s) pointing to the media content of
Is ing> the message.

Request example

Here are examples of sending SMS/MMS messages to a phone
number through Service Provider.

« Send an SMS message

POST / sendnessage HTTP/ 1.1

Host: service-provi der. exanpl e.com
Cont ent - Type: application/json

Aut hori zati on: Bearer {api key}

{
"fronf: "+8618012121222",
"text": "Hello, World!'",
"to": "+8618012121223"

}

« Send an MMS message

POST /sendnessage HTTP/ 1.1

Host: service-provider.exanpl e.com
Cont ent - Type: application/json

Aut hori zati on: Bearer {api key}

“from':"+8618012121222",
"to":"+8618012121223",

"medi a_url s":["docs. exanpl e. yeast ar cl oud. conf
api / chat / 70dee7e2f 95041ca890f 222ace06c2dc" ]

}

APl response returned by Service Provider
Service Provider should return the API response in JSON format.
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Success response

If the request is successful, Service Provider should return the
following information in the response:

« HTTP status code 200
A parameter dat a. i d to pass the unique ID of the mes-
sage

For example:

HTTP/ 1.1 200 K

{
"data": {
"id":"b301led3f - 1490- 491f - 995f - 6e64€69674d4" ,
/'l Message ID (Required, and MUST be different every
tinme)

}

Error response

If the API request fails, Service Provider should return the error
information in the response according to the following format.

Parameter Type Description
code String Error code.
title String Error type (Customizable).
detail String Detailed information of the error
(Customizable).

The following example shows a response of a failed message
sending request.

HTTP/ 1.1 400 Bad Request

{
"errors": |
{
"code": "10001",
"title": "lnvalid 'to' address"”,
"detail": "The 'to' address should be a

single valid nunber."

}



Omnichannel Messaging Guide | 2 - Administrator Guide | 74

Exceptions and troubleshooting

If message delivery fails, an error prompt will be displayed on the
PBX user's Linkus client. Service Provider can troubleshoot the
cause of the anomaly by checking the error code and response

body.

* Error code

The table below lists the error codes defined in the PBX.

Error
Code

10001

10002

10003

10004
10005
10006

10007

10008

Error Message
channel.ErrinvalidPhon
eNumber

channel.ErrinvalidPara
m

channel.ErrUnsupportM
edia

channel.ErrAuthFail
channel.ErrAuthFail

channel.ErrTooManyRe
quest

channel.ErrServiceUnav
ailable

channel . ErrExceedsSiz
eLimit

Description

Invalid phone number.

Invalid parameter in the
request.

Resource type not
supported (MMS).

Authentication failed.
No permission.

Too many requests.

Service unavailable on
recipient's platform.

File size exceeds the
limit.

* Exceptions

The table below lists the possible error prompts and their
trigger conditions.

Trigger Condition

Error Prompt

o Service Provider does not return a
data.id.

o Service Provider returns HTTP status
code 404, prompting service not
found.

Failed to send
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Error Prompt Trigger Condition

o Message delivery fails, and Service
Provider returns error information
according to the format defined by
the PBX, which will be displayed in
the error prompt.

o Message delivery fails, and Service
Provider does not return error
information or the returned response
body is not in JSON format.

Authentication o Service Provider returns HTTP status
Failed code 401.
o Service Provider returns error code
10004 or 10005.

Recipient o Service Provider returns HTTP status
Platform code 403.

Service o Service Provider returns error code
Unavailable 10007.

Invalid Phone Service Provider returns error code 10001.

Number

Invalid Service Provider returns error code 10002.
Parameter

This type of Service Provider returns error code 10003.

message is not
supported due
to the restriction
of the recipient
platform.

Too frequent Service Provider returns error code 10006.
operations.

Please try again

later.

The file size Service Provider returns error code 10008.
exceeds the

limit of the

recipient's

platform.

Receive messages from Service Provider

PBX can receive messages from external message sender via a phone number provided
by the Service Provider. When an external message sender sends a message to the phone
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number, Service Provider can send a request to PBX's webhook URL, so as to deliver this
message to PBX.

Interaction flow

The process of receiving a message from Service Provider is shown below:

Note:
Whether to perform signature verification depends on the Service

Provider's requirement for signature verification. If not required, the
signature-related operations can be skipped.

Yeastar P-Series
PBX System

i
| +——— Sendmessage

1 POST request to '

Webhook URL

|

|

!

Verify :
Webhook signature |
|

|

l

|

i
Return status code 204 ———» |

)
| -«—— Deliver the message
i

1. An external message sender sends a message.

2. The Service Provider should initiate a request to the PBX's webhook URL,
with the inbound message attached in the request body and a SHA256
signature included in the request header.

3. Upon receiving the webhook request, PBX verifies the signature by using
the secret provided by Service Provider to calculate a SHA256 signature
based on the received webhook request body, then compares the result
with the signature extracted from the request header.

If the signatures match, it indicates that the webhook request is valid,
and PBX will return a status code 204 to the Service Provider.
4. PBX delivers the message to the PBX user.

Webhook request sent by Service Provider

Below is the structure and explanation of the webhook request that Service
Provider should send for message delivery.
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Request method
POST

Request URL

{webhook_ur| _provi ded_by_pbx}
For example:

htt ps://docs. exanpl e. yeast ar cl oud. con!
api / v1l. 0/ webhook/ gener al / 429ced149f f 9437695be795af f 3
8407b

Headers

Parameter | Type Description

Content-Typ String | Define the content type of the request
e payload.

Valid value: application/json

X-Signature- String  Pass the signature for webhook

256 authentication, where { si gnat ur e} is the
lowercase result generated by encrypting
the body content with the Secret using the
SHA256 algorithm.

Format: sha256={si gnat ur e}

Request body

The Service Provider should pass the inbound messages in the
request body.

Note:
Here only lists the mandatory parameters. Service
Provider may extend this message with other data if

needed.

Parameter Description

data.event_ ty Yes Strin Event type.

pe 9 Valid value: nessage. recei ved.



Parameter I?equ
ired
data.payload.i Yes
d

data.payload.f Yes
rom.phone_nu
mber

data.payload.t Yes
o.phone_num
ber

data.payload.t Yes
ext

data.payload. Yes

media
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Type

Strin
g

Strin

Strin

Strin

Array

Description

Message ID.

Note:

» The maximum
character length is
255.

* The ID MUST be
different every time.

Phone number of the message
sender.

Note:
This parameter should be in
E.164 format. For example,
+8618012121222.

Phone number of the message
recipient.

Note:
This parameter should be in
E.164 format. For example,
+8618012121222.

Textual content of the message.

Important:

Either dat a. payl oad. t ext or
dat a. payl oad. nedi a must be
provided.

The information and URL pointing to

<med the media content of the message.

ia>

Important:

Either dat a. payl oad. t ext or
dat a. payl oad. nedi a must be
provided.
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R
Parameter .equ
ired

Type Description
data.payload.r Yes | Strin The time when the message was
eceived_at g received (ISO 8601 format).

Format:
YYYY- M DDTHH: MM SS. mmmi/ - HH: MM

Example:
2019-12-09T20:16:07.588+08:00.

data.payload.r Yes  Strin Record type.

ecord_type 9 Valid value: nessage.

media

Param | Requ

eter ired Type Description

content No Strin  The type of the media file.

_type g
0 Tip:

Refer to the Media
Types for the
corresponding
value.

sha256 No Strin The SHA256 value of the

g media file.

size No Integ File size.
er

url Yes Strin  The URL that points to the
g media file.

Request example

The following example shows a webhook request for Service
Provider to send a message to the PBX.

PGST /

api / v1. 0/ webhook/ gener al / 429ced149f f 9437695be795af f 3
8407b HTTP/ 1.1

Host: docs. exanpl e. yeast arcl oud. com

Cont ent - Type: application/json

X- Si gnat ur e- 256: sha256={si gnat ur e}


https://www.iana.org/assignments/media-types/media-types.xhtml
https://www.iana.org/assignments/media-types/media-types.xhtml
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"data": {

"event type": "nessage.received",
"id":

"b301ed3f - 1490- 491f - 995f - 6e64e69674d4" ,

/'l Event 1D (Required, and MJST be different every

time)
"occurred_at":

"2019-12- 09T20: 16: 07. 588+00: 00",

"payl oad": {
"conpleted at": null,
"direction": "inbound",

"encodi ng": "GSM 7",
“errors": [],
"fron: {
/1 Sender information
"carrier": "T-Mbile USA",

"l'ine_type": "long_code",
"phone_nunber": "+8618012121222",
"status": "webhook delivered"

I s

"id":

"84ccal75- 9755- 4859- b67f - 4730d7f 58aa3",
/I Message | D
"media": [{
/1 Medi a content of the nessage
"content type": null,
"sha256": null,
“url":
"https://pbs.twi ng. con profile_ i mges/ 1142168442042
118144/ AVBF4f FD_400x400. png"
H,
"messagi ng_profile_id":
"740572b6- 099c- 44al- 89b9- 6c92163bc68d",
"organi zation_id":
"47a530f 8- 4362- 4526- 829b- bceel7f d9f 7a",

"parts": 1,

"received_at":
"2019-12- 09T20: 16: 07. 503+00: 00", /1 The tine
when the nmessage is received

"record_type": "nmessage",

// Record type
"sent _at": null,
"tags": [],



Omnichannel Messaging Guide | 2 - Administrator Guide | 81

"text": "Hello from PBX! ",
/] Textual content of the nmessage

"to": [
/! Reci pient information
{
“carrier": "PBX",
"line_type": "Wreless",
"phone_nunber":
"+8618012121223",
"status": "webhook delivered"
}
I
"type": "SMS/ MVB',
"valid until": null,
"webhook failover _url": null,
"webhook_url ":
"http://webhook. site/04bbd2e3- 09b5- 4c9e- 95de- aldebe
b9e675"
b
"record_type": "event"
I s
"meta": {
"attenpt": 1,

"delivered to":
"http://webhook. site/ 04bbd2e3- 09b5- 4c9e- 95de- aldebe
b9e675"
}
}

Webhook response returned by PBX

The PBX system will return an HTTP status code in the response.

Status Code Description
204 Success.
400 Bad request, returned when the signature is incorrect.

Set up an SMS channel for Service Provider

After Service Provider implements the SMS service integration with Yeastar PBX, PBX ad-
ministrator can set up an SMS channel on PBX web portal for the Service Provider.

Limitations
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Item Limitation

Supported message The supported message types are determined by the Service
types Provider.

Important:

When sending multimedia messages (such as
images), the SMS service provider downloads the
files from a link provided by the PBX. Therefore, if
you have set Allowed Country/Region IP Access
Protection rule, make sure that you have allowed the
IP access from the country where the SMS service
provider is located, otherwise the file transmission
would fail.

File size Max. 100 MB

File retention period 72 hours

Prerequisites

« Obtain the following information from the Service Provider:
> APl address for sending messages
> (Optional) API address for verifying authentication
> Message sending rate limit
« Obtain the following information from the Service Provider's customer
portal:
> APl key
> (Optional) Secret
> Phone number used for message sending and receiving

Note:

If business needs to communicate with US-based cus-
tomers, make sure that the phone number has been com-
pleted with 10DLC registration to avoid disruption in mes-
sage delivery.

Procedure

1. Log in to PBX web portal, go to Messaging > Message Channel.
2. Click Add, and select SMS.
3. In the Authentication tab, complete the following settings.


https://help.yeastar.com/en/p-series-cloud-edition/administrator-guide/restrict-specific-countries-or-regions-from-accessing-yeastar-pbx.html
https://help.yeastar.com/en/p-series-cloud-edition/administrator-guide/restrict-specific-countries-or-regions-from-accessing-yeastar-pbx.html
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General SMS Channel https://docs.example.yeastarcloud.com/api/v1.0/webhook/general/90b

General

https:/service-provider.example.com/sendmessage https://service-provider.example.com/verify

« Name: Enter a name to help you identify the channel.

« ITSP: Select General.

* API Key: Enter the API key obtained from the Service Provider's
customer portal.

« Secret: Optional. If Service Provider provides a Secret for verifica-
tion, enter it in this field.

- APl Address for Sending Messages: Enter the correspond-
ing API address provided by the Service Provider. For example,
https://service-provi der. exanpl e. com sendnessage.

« APl Address for Verifying Authentication: Optional. If Service
Provider provides an APl address for identity authentication, enter
it in this field. For example, ht t ps: / / servi ce- pr ovi der . exanpl e-
.com verify.

« Webhook URL: copy the Webhook URL, and configure messag-
ing webhook for the phone number using the URL in the Service
Provider's customer portal.

4. In the Messaging Settings tab, configure the channel.
a. In the Message Sending Rate field, specify the number of mes-
sages that PBX can send per second.

Note:

« If the number of messages to send exceeds the set
value, PBX will arrange the messages in queue and
send them at the sending rate.

« If the sending rate set in PBX exceeds the limit set
by the SMS service provider, it may result in mes-
sage delivery failures. Contact your SMS service
provider to confirm the sending rate limit of your ac-
count and increase the limit as needed.

b. Optional: If you want the system to automatically close the ses-
sions that have been inactive for a specific period of time, select
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the checkbox of Close Session Automatically, then set the time-
out in the Session Timeout (Days) field.

Close Session Automatically

c. In the Number section, click Add to add a message routing rule.

Add X

*
+14102161183

For phone numbers, please enter them in E.164 format. For example, +86-592-5503309 should be entered as +865925503309.

Extension 3000-Leo Ball
4 items Available 2 items Selected
Extension Num... Caller ID Name Extension Num... Caller ID Name
Extension Group  Default_All_Ext... 1000 Leo Ball
1002 Terrell Smith 1001 Phillip Huff
1003 Dave Haris
1004 Troy Daniel

X Cancel

« Number: Enter the purchased number or specify an Al-
phanumeric Sender ID.

Note:

The phone number should be in E.164 format ([ +]
[country code] [ phone nunber]). For example,
+14102161183.

- Destination for Inbound Messaging: Specify the destina-
tion of inbound messages from the number.

Description

Extension If selected, choose an extension from the
Extension drop-down list.
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Option Description

Only the extension user can receive inbound
messages from the number.

Message If selected, choose a queue from the Message
Queue Queue drop-down list.

All the agents in the selected message queue
can receive inbound message(s) of new
sessions in the queue. However, only the
user who picks up a session will be able to
receive and respond to the follow-up inbound
messages in the session.

Third-Party If selected, inbound messages will be
Message automatically forwarded to a third-party
Analytics message analytics platform via API for
Platform advanced processing.

(Transmitted via

API) / Note:

To enable automatic forwarding of
inbound messages to a third-party
message analytics platform, ensure
that your PBX server has been
integrated with the third-party
message analytics platform via
API. Once this option is selected,
the PBX system will automatically
transmit inbound messages to the
designated platform. You can get
notified by monitoring the API event
(30031) New Message Notification.
Additionally, the PBX provides a
comprehensive Message API suite for
advanced message interaction with
the integrated third-party message
analytics platforms.

- Extensions allowed to create messaging sessions:
Select the extensions that are allowed to initiate a messag-
ing session with customers.
d. Click Save.
5. Click Save.

Result


https://help.yeastar.com/en/p-series-cloud-edition/developer-guide/enable-yeastar-p-series-pbx-api.html
https://help.yeastar.com/en/p-series-cloud-edition/developer-guide/enable-yeastar-p-series-pbx-api.html
https://help.yeastar.com/en/p-series-cloud-edition/developer-guide/event-new-message-notification.html
https://help.yeastar.com/en/p-series-cloud-edition/developer-guide/api-interfaces-and-events-summary.html#api-interface-and-event-overview__section_messaging
https://help.yeastar.com/en/p-series-cloud-edition/developer-guide/api-interfaces-and-events-summary.html#api-interface-and-event-overview__section_messaging
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« A messaging channel for the Service Provider is created successfully.

The channel is displayed in the Messaging list with Status showing .

Status Name Type Number Total Sent Operations

o) General SMS SMs pom o 0 0 2 B

Channel

« PBX automatically tracks and records the number of messages sent
and received on the channel, where the Total column indicates the total
number of sent messages, including both successfully sent messages
and failed ones.

Note:

> For sent messages, PBX only tracks the number of the
messages sent from agents' Linkus UC Clients. If you
want to calculate the actual cost of sent messages, con-
sult with the SMS service provider for the precise number
of messages transmitted, as long text messages (longer
than 160 characters) are automatically split into seg-
ments and then re-assembled when they are received, in-
creasing the number of sent messages.

> You can filter the statistics by a time period using the time
filter.

Number Total Sent Failed Received Operations

+14102161183 30 20 10 8 Z W

What to do next

Send text messages to the phone number added in the channel, and see if the
specified PBX user can receive messages on his or her Linkus UC Client.

Related information
Check and Manage External Chat Logs
User Guide - Manage customer queries from SMS channel on Linkus Web Client /
Desktop Client
User Guide - Manage customer queries from SMS channel on Linkus Mobile Client
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Facebook

Facebook Messenger Integration Guide

By integrating Facebook and Yeastar P-Series Cloud Edition, agents in your business can re-
ceive and reply to Facebook Page messages directly on Linkus UC Clients, without having to
log in to Facebook Messenger.

Requirements

Platform Requirement

Yeastar PBX * Firmware: Version 84.20.0.128 or later

* Plan: Enterprise Plan (EP) or Ultimate Plan (UP)

« Domain Name: Due to the limitation of the third-party platform, the domain
name must NOT contain underscore character(s), otherwise the messaging
channel will encounter authentication failure, or will fail to receive messages.

» Domain Certificate: A valid domain certificate is installed.

," Note:
If the root domain of your Cloud PBX is NOT the standard
Yeastar-provided domains (ycmcloud.com, yeastarcloud.com, or
yeastarycm.co.za), you NEED to install a valid domain certificate
for the PBX first, otherwise the messaging channel will encounter
authentication failure, or will fail to receive messages.

Facebook * Product: Messenger Platform

« Account:
o A Meta Developer account

Note:
You only need one Meta Developer account to create multiple
Meta apps for the Facebook channel integration. There is no
limit to the number of Facebook channels on PBX.

A Business Manager account (Business Portfolio)

o

,'* Note:
After you set up a Business Manager account, verify your
business.



https://developers.facebook.com/docs/development/register
https://www.facebook.com/business/help/1710077379203657?id=180505742745347
https://www.facebook.com/business/help/2058515294227817?id=180505742745347
https://www.facebook.com/business/help/2058515294227817?id=180505742745347
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Limitations

Learn about the limitations of Facebook messaging channel.

Item Description

Message type Supports text messages and multimedia messages, where the multimedia
message types are determined by Facebook. For more information, see
Facebook supported media types.

Important:

When sending multimedia messages (such as images), Facebook
downloads the file from a link provided by the PBX. Therefore, if you
have set Allowed Country/Region IP Access Protection rule, make
sure that you have allowed the IP access from the country where the
Facebook server is located, otherwise the file transmission would fail.

Messaging Supports to receive and reply to Inbound messages, but agents can NOT
mechanism initiate a messaging session with a Facebook user.

Message sending  Supports to send up to 40 messages per second.

rate

File size Supports to send a file with a maximum size of 25 MB.
File retention Files can be retained for 72 hours.

period

Set up a Facebook Channel

This topic describes how to set up a Facebook channel on Yeastar P-Series Cloud Edition,
so that agents in your business can receive and reply to your Facebook Page messages.

Step 1. Create a Meta app

On 'Meta for Developers' portal, create a Meta app for the integration.

1. Log in to 'Meta for Developers' portal, then go to My Apps from the top menu.


https://developers.facebook.com/docs/messenger-platform/reference/send-api#sample-request
https://help.yeastar.com/en/p-series-cloud-edition/administrator-guide/restrict-specific-countries-or-regions-from-accessing-yeastar-pbx.html
https://developers.facebook.com
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00 Meta Developer Products Docs Blog More My Apps Q

Introducing Llama 3.1:
Our most capable
models to date

Llama 3.1 405B is the first openly available model that rivals the
top Al models when it comes to state-of-the-art capabilities in M e et L I a I I I a 3 .1
general knowledge, steerability, math, tool use, and multilingual

translation.

-> ) Learn more

2. At the top-right corner, click Create App.

Docs  Tools  Suppot  Apps Required actions

R Meta

Apps Name or App ID
)

Filter by Admin Apps Select all

(@) All Apps (14)
Archived &R o
u P X
v
Required actions (1)

Business portfolio Clear

No busine ortfolio select v @ Administrator @) Administrator @ Administrator

3. For App details, configure app name and contact email, then click Next.

Create an app

[ ) App details

App name

This is the app name that will show on your My Apps page and associated with your app ID. You can change the name later in Settings.

Yeastar Messaging

App contact email
This is the email address we'll use to contact you about your app. Make sure it is an address you check regularly. We may contact you about policies, app restrictions or recovery if your
app is deleted or compromised

becky@yeastar.com

=1

4. For Use cases, select Other, then click Next.
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Create an app

@ App details (P usecases QO Business QO Finalize

Add use cases

Create & manage ads with Marketing API
Create, manage and optimize ad campaigns across Meta technologies. Programmatically extend, stop or update ad campaigns and more.
Learn more.

Measure ad performance data with Marketing API
Maximize ROl with ad performance data to optimize ad budgets, creatives and create custom audiences, connect customers to product
catalogs and improve reach. Learn more.

Capture & manage ad leads with Marketing API
Give potential customers a quick and safe way to sign up to get info about your business or products. Learn more.

Run ads to promote your app
Get an app ID to promote your app on Meta technologies, like Facebook and Instagram. Learn more.

Access the Threads API
Use the Threads API and choose to authenticate users, retrieve user information, post threads, reply to threads, manage reply settings
and/or gather insights for a Threads profile you own or manage on behalf of others. Learn more.

Embed Threads content in other websites
Use the Threads oEmbed API to embed content of Threads posts, such as photos and videos, in other websites. Learn more.

Launch a game on Facebook
Launch a game that players can find and play directly in their Feed or messages/conversations, on both desktop and mobile devices. Learn
more.

Authenticate and request data from users with Facebook Login
Our most common use case. A secure, fast way for users 1o log into your app or game and for the app to ask for permissions to access their
data to personalize their experience. Learn more.

Looking for something else?
If you need something that isn't shown above, you can see more options by selecting Other.

Other o
Explore other options for app integrations such as Whatsapp messaging, Commerce APl and more. You'll be asked to select an app type, then add
the permissions and products you need.

Cancel Previous m

5. For App type, select Business, then click Next.
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Create an app

(P Type Select an app type
The app type can't be changed after your app is created. Learn more
-") Details
Business o
1 Create or manage business assets like Pages, Events, Groups, Ads, Messenger, WhatsApp, and
Instagram using the available business permissions, features and products.

Consumer
a'. Connect consumer products and permissions, like Facebook Login to your app.

=

6. For App details, select your Meta business portfolio.
Create an app

Q Type App name

This is the app name that will show on your My Apps page and associated with your app ID. You can change the name later in Settings

(D petails Yeastar Messaging 17/30

App contact email
This is the email address we'll use to contact you about your app. Make sure it is an address you check regularly. We may contact you about
policies, app restrictions or recovery if your app is deleted or compromised.

becky@yeastar.com

Business portfolio - Optional
Connecting a business portfolio to your app is only required for certain products and permissions. You'll be asked to connect a business
portfolio when you request access to those products and permissions.

T | TestBusiness hd

Cancel Previous

7. Click Create app.
The Meta app is created; You are redirected to the App Dashboard page.

Step 2. Set up the Meta app

On 'Meta for Developers' portal, add Messenger Platform to your Meta app and set up the
app to gather the required credentials for the integration.

1. On the Add products to your app page, click Set up on Messenger.
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Add products to your app

We've streamlined the app creation process by surfacing the products and permissions needed to build the app type you selected

® G -

Messenger Instagram WhatsApp

Allow creators and businesses to manage
messages and comments, publish content, track Integrate with WhatsApp
nsights, hashtags and mentions.

Customize the way you interact with people on
Messenger.

Read Docs Set up Read Docs Set up Read Docs Set up

You are redirected to the Messenger API configuration page.
2. Connect the Meta app to your Facebook Page to generate an access token, and gath-
er credentials of the Facebook Page.
a. Scroll down to the 2. Generate access tokens section, click Connect to add
your Facebook Page.
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App Dashboard upport  Apps  Required actions

Yeastar Messaging v App ID: 477381038391389 App Mode: Development @ Live App type: Business @ Help

(o) pashboard 2. Generate access tokens
v Connect Facebook pages to generate access tokens and set up webhook subscriptions.
Required actions

{G% App settings v
App roles v
£\ Alerts v
@ App Review v
Products Add Product
Messenger -~

No FB pages yet.

Messenger API Settings Connect to your F8 pages.

Instagram settings

Activity log m

1= Activity log
€) Log in With Facebook - Google Chrome - O X ) Log in With Facebook - Google Chrome = m] X
25 facebook.com/dialog/oauth?client id=4901615936574638display=po... % 25 facebook.com/dialog/oauth?client id=490161593657463&display=po... %

xN-B ‘- - B L

Continueas = ww? Choose the Pages you want Yeastar Messaging to
Yeastar Messaging will receive your name and profile picture. access
Later you'll be able to review what Yeastar Messaging will be able to do
with the Pages you select.
Not ? Log into another account.

Opt in to all current and future Pages
This will give Yeastar Messaging access 1o your current Pages, in addition to
any Page you create in the future

@ Optinto current Pages only
This will only give Yeastar Messaging access to the Pages you select

Select all 1Asset Selected

v Yeastar
334079033132769

By continuing, Yeastar Messaging will receive ongoing access to the information you
share and Meta will record when Yeastar Messaging accesses it. Learn more about

this sharing and the settings you have.

€) Log in With Facebook - Google Chrome = o X €) Log in With Facebook - Google Chrome = [m} X

2% facebook.com/dialog/oauth?client i

N~ B ‘-~ N = E e -

id=4901615936574638&display=po... % 25 facebook.com/dialog/oauth?client id=4901615936574638&display=po... %

Review what Yeastar Messaging is requesting # Law has been connected to Yeastar Messaging
permission todo To manage this connection, go to Business Integrations.

Manage and access Page conversations in Messenger
1 Page selected

... oo |
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Refresh the webpage and you will see that the Facebook Page is added.

2. Generate access tokens

A~
Connect Facebook pages to generate access tokens and set up webhook subscriptions.
Page Name Webhook Subscription Token
Yeastar Add Subscriptions
Generate 1]
. 354079033132769 No fields subscribed.
Add Page

b. Generate an access token to authenticate the Meta app and allow it to perform
actions on behalf of the Facebook Page.

Note:
Copy and note down the access token, as you will need to add it on the
PBX later.

Token Generation X

Yeastar
2. Generate access tokens 334079033132769

Connect Facebook pages to generate access tokens and set up webhook subscriptions.

To protect your security, ONLY share this token with app developers you trust.

Page Name Webhook Subscription Token
Yeastar ‘Add Subscriptions This token will ony be shown once, so keep it safe. I it gets lost, you'l need to create a new
334079033132769 Generate | @ one. Anyone could potentially use this token to impersonate this page, depending on the
No fields subscribed.

privacy settings of your app. If you wish to revoke all previously generated tokens for this
app, you can go to Business Integrations settings. Learn More
Add Page

(V) 1Understand

EAAGGXpUMZBMOBOTrXRLTY{YBUWYFaXV1UISFi6jfNvedEoJiavFyopJoe | ([ Copy

c. Copy and note down the name and ID of your Facebook Page, as you will need
to add them on the PBX later.

2. Generate access tokens

Connect Facebook pages to generate access tokens and set up webhook subscriptions. ~
Page Name Webhook Subscription Token
. Veastar Token generated
334(@33132759 No fields subscribed. Generate W
Add Page

3. Obtain secret key for the Meta app.
a. On the left navigation bar, click App settings > Basic.
b. On the right of the App secret field, click Show to show the secret key.
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bs s swpot  apps  equresacors s (IR & &

QN Meta = App Dashboard

[E] veastar Messaging v App ID: 477381038391389 App Mode: Development @ Live App type: Business @ Help
m Dashboard
App ID secret
Required actions PP App
2478854338991095  eesssses Show
b App settings ~
Display name Namespace
Basic
Yeastar Messaging
Advance d

c. Copy and note down the secret key, as you will need to add it on the PBX later.
Docs. Tools Support Apps Required actions 4 — A .

OQMeta = App Dashboard

[ vessurmessaging v App ID: 477381038391389 App Mode: Development @ Live App type: Business @ Help
@ Dashboard

AppID App secret
Required actions PP PP

468798182717645 56187 Reset

ﬁ App settings A @

Display name Namespace

Basic
Yeastar Messaging

Advanced

Step 3. Create a Facebook channel

On PBX web portal, create and configure a Facebook channel.

1. Log in to PBX web portal, go to Messaging > Message Channel.

2. Click Add, and select Facebook Messenger.
3. In the Authentication tab, enter the authentication information of Facebook.

Authentication Messaging Settings
Please refer to the User Guide for information on how to configure the following settings

Facebook channel https://docs.example.yeastarcloud.com/api/v1.0/webhook/facebook/cb--

334079033132769 Yeastar

« Name: Enter a name to help you identify the channel.
« Webhook URL: Note down the Webhook URL, as you will need it later on 'Meta

for Developers' portal.
- Verify Token: Note down the verify token, as you will need it later on 'Meta for

Developers' portal.
» Access Token: Paste the Access Token obtained from 'Meta for Developers'

portal.
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» App Secret: Paste the App Secret obtained from 'Meta for Developers' portal.

 Page ID: Paste the Page ID obtained from 'Meta for Developers' portal.

» Page Name: Paste the Page Name obtained from 'Meta for Developers' portal.
4. In the Messaging Settings tab, configure the channel.

Authentication Messaging Settings

* *
Extension 1002-Terrell Smith
Close Session Automatically

*

1

- Destination for Inbound Messaging: Specify the destination of inbound mes-
sages from Facebook Page.

Option Description

Extension If selected, choose an extension from the Extension drop-down list.

Only the extension user can receive inbound messages from the
Facebook Page.

Message If selected, choose a queue from the Message Queue drop-down list.

Queue All the agents in the selected message queue can receive inbound

message(s) of new sessions in the queue. However, only the user
who picks up a session will be able to receive and respond to the
follow-up inbound messages in the session.

Third-Party If selected, inbound messages will be automatically forwarded
Message to a third-party message analytics platform via API for advanced
Analytics processing.

Platform

(Transmitted ,‘. Note:

via API) To enable automatic forwarding of inbound messages

to a third-party message analytics platform, ensure that

your PBX server has been integrated with the third-party
message analytics platform via API. Once this option

is selected, the PBX system will automatically transmit
inbound messages to the designated platform. You can get
notified by monitoring the API event (30031) New Message
Notification. Additionally, the PBX provides a comprehensive
Message API suite for advanced message interaction with the
integrated third-party message analytics platforms.

» Close Session Automatically: Optional. If you want the system to automatical-
ly close the sessions that have been inactive for a specific period of time, select


https://help.yeastar.com/en/p-series-cloud-edition/developer-guide/enable-yeastar-p-series-pbx-api.html
https://help.yeastar.com/en/p-series-cloud-edition/developer-guide/event-new-message-notification.html
https://help.yeastar.com/en/p-series-cloud-edition/developer-guide/event-new-message-notification.html
https://help.yeastar.com/en/p-series-cloud-edition/developer-guide/api-interfaces-and-events-summary.html#api-interface-and-event-overview__section_messaging
https://help.yeastar.com/en/p-series-cloud-edition/developer-guide/api-interfaces-and-events-summary.html#api-interface-and-event-overview__section_messaging
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the checkbox of Close Session Automatically, then set the timeout in the Ses-
sion Timeout (Days) field.
5. Click Save.

Step 4. Set up Meta webhook

On 'Meta for Developers' portal, configure webhook for your Meta app and subscribe to the
messages event, so that PBX can get notified upon receiving Facebook Page messages.

1. On 'Meta for Developers' portal, go to the Messenger API configuration page of your
Meta app.

2. In the 1. Configure webhooks section, configure a webhook and subscribe to mes-
sages field for your app.
a. Click Configure to add and configure a webhook.

Edit Callback URL X

Callback URL

| https://docs.example.yeastarcloud.com/api/v1.0/webhook/facebook/f4f8f0074a6b4faB94ea7ec] ched! |

Verify Token

| gma3rprrg52wzklah |

- Callback URL: Paste the Webhook URL obtained from PBX.
- Verify Token: Paste the verify token obtained from PBX.
b. Click Manage to subscribe to messages field.
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1. Configure webhooks

~
Configure a custom webhook URL or use services that help you set up an endpoint. Learn more.
Callback URL Verify Token
https://docs.example.yeastarcloud.com/api/v1.0/webhook/f Edit
Webhook Fields
Manage
Show Recent Errors
Webhook fields X
message_reactions v20.0 w v20.0 w m
messages v20.0 w v20.0 w Subscribe
messaging_account_linking v20.0 w v20.0 w Subscribe
mAanaamins Anctamaar infarmmatin L1 N N
Cancel

3. In the 2. Generate access tokens section, click Add Subscriptions to subscribe to
messages field for your Facebook Page.
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2. Generate access tokens
Connect Facebook pages to generate access tokens and set up webhook subscriptions.

Page Name Webhook Subscription Token

. Yeastar Add Subscriptions Generate @

334079033132769 ;
No fields subscribed.

Add Page
Edit Page Subscriptions X
Yeastar
334079033132769
messages messaging_postbacks
messaging_optins messaging_optouts
message_deliveries message_reads
messaging_payments messaging_pre_checkouts
messaging_checkout_updates messaging_account_linking
messaging_referrals message_echoes
message_edits messaging_game_plays
PRPRF | R RS S ERPR PR e
Learn more Cancel m

Result

« On PBX web portal, the Status of the Facebook channel shows @, which indicates
that you have successfully created a Facebook channel.

Status Name Type Number Total Sent Failed Operations

@ Facebook channel Facebook Messenger ~ 334079033132769 0 0 0 Z B

» PBX automatically tracks and records the number of messages sent and received on

the channel, where the Total column displays the total amount of the sent messages,
including both successfully sent messages and failed ones.

e Tip:

You can filter the statistics by a time period using the time filter.
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Status Name Type Number Total Sent Failed Received Operations

@ EE Facebook Messenger  334079033132769 30 30 0 25 Z

What to do next

Submit App for Review.

(Optional) Add a Tester for Meta App

After a Meta app is created, only your Meta Developer account has permission to interact
with the app. To keep your account safe, you can add a user as a Tester to aid with the test-
ing process.

Requirements

The user who you want to add as a Tester must have a Meta developer account.
Step 1. Add a user to business portfolio

1. Go to Business settings in Meta Business Manager, then select the business portfolio
that is connected with your Meta app.

00 Meta —
Settings

| Test Business v

@ Ads Manager
E}} Ads Reporting

O%)D Events Manager

2. Go to Users > People, then click Invite people.


https://business.facebook.com/settings/
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3

. Test Business
Settings .

Business portfolio

A) users N People o Q Search | =5 Filters & Export v
m Name T Business portfolio access @

Partners

Lastactive @ Status @

=)

System Users

b o o B o

3. In the Email address field, enter the email address of the user who you want to add,
then click Next.

Invite people Add people X
‘) Add people YZ: can invite people to join the Test Business business portfolio by entering their email
address.

Email address
Notifications from the business will be sent to these email addresses.

yangym@yeastar.com X

Additional settings
@  Temporary access

@  Meta Spark access

Allow this person to access AR effects in Meta Spark on behalf of this business portfolic. They
won't have access to other business tools. Learn more

4. Set the type of access that you want to assign as needed, then click Next.
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Invite people

Q Add people

O Assign access

Assign access x

Select the tasks that best fit what all the invitees need to do in the Test Business business
portfolia.

Partial access

Basic

can

Apps and integrations
Set up Conversions API. Monitor events, edit applications and create access tokens.

(] Manage

Full control
Everything

This is the most control you can give someone. They can do all of the above, assign other people full
control and delete the business portfolio.

(] Manage

View advanced options *

Learn more about assigning access to a business portfolio. Back Next

5. Leave business asset(s) blank, then click Next.
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Invite people Assign business assets X

Assign all invitees access to Facebook Pages, Instagram accounts or other business assets in

Q Add people ’ ) ‘
the Test Business business portfolio.
Q Assign access
Select business asset(s) v
O Assign business a...
Learn more about assigning access to a business asset Back Next

6. Click Send invitation.
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Invite people

Q Add people

@ Assign access

Q Assign business a...

(P Review invitation

Review invitation X
An email will be sent to inviting them to join the Test Business business portfolio.
Add to business portfolio
& yangym@yeastar.com
Access to portfolio and assets

Test Business
Partial access: Basic

No assets assigned
Select Assign business assets or Back 1o assign

Your business name, business portfolio cre.
country, business

Back Send invitation

Y

7. Click Done to close the window.
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Invite people Invitation sent X
o Add people

@ Assign access

o Assign business a...

Q Review invitation

Your invitation to to join the Test Business
business portfolio is on the way! The invitation
will expire in 30 days.

Meta will send an activation email to the user; The user needs to accept the invitation
to join your business portfolio.

Step 2. Assign the Meta app to the user

1. On the right of the desired user, click ***, then select Assign assets.

00 . Test Business
Settings . Business portolio
AU 7 Welcome to the new Settings experience on Meta Business Suite -~
sers IS
. The new Settings is an updated version of Business Settings. It has the same features, but with a fresh new look, improved user experience and added reliability. Please note that
m the legacy Business Settings will be discontinued soon.
® Partners
o e People © Q Search by name, ID, or ema 5 Filters & Export w + Invite people
ystem Users
fol Name 11 Business portfolio access @ Lastactive @ Status @
8 =9 Accounts ~
Gy yangym Partial access .
Pages & Jangymeyeastarcom Basic Aug 15,2024 Active
Ad Accounts X i
View details
Business Asset Groups
& Editinfo
Apps
Edit business portfolio permissions
Instagram accounts
Assign assets
WhatsApp Accounts
) Remove from business portfolio
Q £ DataSources v
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2. Assign the Meta app and test access to the user, then click Assign assets.

Select assets and assign permissions X
Select asset type @ Select assets Assign permissions
Catalogs Q Search by name or ID Partial access .

Apps Y Develop app

—  Select all - Can change app settings, test the app and view analytics.
WhatsApp accounts ~ . PS View insights
v Yeastar Messaging Can view app analytics.
o Test app
© @ Can test the app.
&R
. Full control
e
He Manage app
. Can manage roles, change app settings, test the app and
..6, view analytics.
&R
&
: hd
&R ] »

- | 4 3

1 asset selected Cancel

3. Click Done to close the window.

Select assets and assigh permissions X

Assets assigned
1 asset was assigned to yang ym.
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Result

The user is added as a Tester and can interact with your Meta app.

What to do next

Submit App for Review.

Submit App for Review

After you set up a Facebook channel, you need to test message delivery between Facebook
Page and Yeastar P-Series Cloud Edition, then submit your app for review.

Before you submit

Test message delivery between Facebook Page and Yeastar P-Series Cloud Edition.

1. (Optional) Add a user as a Tester.

By default, only your Meta Developer account has permission to interact with the app.
You can directly use your Meta Developer account to test message delivery, but we
recommend that you add a Tester account with limited access to aid with the testing
process. This helps avoid exposing your Meta Developer account, as Meta requires a
Facebook account to test your app.
2. Test message delivery and record two screencasts.
« A screencast that demonstrates how you send a message to your Facebook
Page and how the message is received and replied on Yeastar P-Series Cloud
Edition within 24 hours.

« A screencast that demonstrates how your app uses a human agent tag to re-
spond to customer messages outside the 24-hour window.

0 Tip:
App Review - Best Practices may help improve the quality of your submission and
reduce the chances of it being rejected.

Step 1. Complete app settings

1. Go to the Basic settings page of your Meta app.
a. Log in to 'Meta for Developers' portal, then go to My Apps from the top menu.



https://developers.facebook.com/docs/resp-plat-initiatives/app-review/before-you-submit?locale=en_US
https://developers.facebook.com
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x

Meta

Introducing Llama 3.1:
Our most capable
models to date

Llama 3.1 405B is the first openly available model that rivals the
top Al models when it comes to state-of-the-art capabilities in
general knowledge, steerability, math, tool use, and multilingual
translation.

- ) Learn more

b. On the App list, click your Meta app.

(R Meta

Apps

Filter by

Admin Apps

(®) AllApps (16)

oW | veastar Messaging
Archived MO R L e
(a8l Mode: \_Jopment

Type: Busingss

Required actions (1) Business: Test Business

Business portfolio Clear

No bu

ess portfolio selected v @ Administrator

Developer Products Docs

/

(

\\
X

Blog More My Apps

4058 )

Meet Llama 3.1

Docs Tools

@ Administrator

Suppot  Apps  Required actions i

c. On the left navigation bar, go to App settings > Basic.
2. At the top of the page, complete the following settings.

OQOMeta = App Dashboard

[E] Yeastar Messaging

Gﬁ Dashboard
Required actions
O App settings

Basic

Advanced
@J App roles
Q Alerts
@ App Review
Products
Webhooks

Messenger

Activity log

i= Activity log

- App ID: 477381038391389 App Mode: Development @
App D
477381038391389
~ Display name
Yeastar Messaging
App domains
v
D v Privacy Policy URL
https://www.yeastar.com/privacy/
v

App icon (1024 x 1024)

Add Product '
i ‘ I

Docs

Live

Tools  Suppot  Apps  Required actions fi

App type: Business

App secret

Namespace

Contact email @

becky@yeastar.com

Terms of Service URL

Select all

@ Administrator

EEIN.

Show

Terms of Service for Login dialog and App Deta

Category @

Messaging

« Privacy Policy URL: Enter your organization's privacy policy URL.
« App icon: Upload your organization's icon.

Q

@ Help
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« Category: Select Messaging.

3. Scroll down to the bottom of the page, add a website platform to share the PBX URL
with Meta.

Select Platform

Website Android
12 app stores available

Windows App

Page Tab

OQOMeta = App Dashboard Docs  Tools  Suppot  Apps  Required actions 4 a (o)

7% Yeastar Messaging - App ID: 477381038391389 App Mode: Development @  Live App type: Business @ Help
City/District
G‘] Dashboard
Required actions
State/Province/Region ZIP/Postal Code Country
L} App settings ~ United States -
Basic
Advanced
Website Quick Start X
App roles v
Site URL
Q Alerts L v °| https://docs.example.yeastarcloud.com/
@ App Review v . o )
Provide testing instructions
Products Add Product Meta performs regular reviews of apps on the platform in order to verify that an app's access to permissions follows our terms and policies.
Avoid unexpected restrictions by keeping this required testing information up to date.
Webhooks o :
& Add or update instructions
Messenger v
+ Add platform
Activity log

a. Click Add platform.
b. Select the checkbox of Website, then click Next.
c. In the Site URL field, enter the domain nameof your PBX system.

4. Click Save changes.

Step 2. Select permissions and features

1. On the left navigation bar, go to App Review > Permissions and Features.
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2. Search for the required permissions (pages_messaging, Human Agent, and Busi-
ness Asset User Profile Access) and click the corresponding Request advanced
access button to add them to your submission.

Filter access levels v O pages_messaging

Permissions and features 11 Access level @ 4 APlcalls @ Ti Status T! Action @ T

pages_messaging

e No App Review
essenge Standard access e Active (12) © App Review Request advanced access w
requested
(® Full description @ Requirements
Filter access levels w Q Human Agent
Permissions and features 1. Access level @ | APlcalls @ 1! Status . Action @ 1.
Human Agent
© e A - 7 ~ent No App Review =
uman_ag Standard access © Ready to use (0) Request advanced access il
a e requested
@ Full description  Requirements
Filter access levels w (Q Business Asset User Profile Access
Permissions and features T! Access level @ APlcalls @ 1! Status T/ Action @ Tl

Business Asset User Profile Access

No App Review .
Standard access © Ready to use (0) " Request advanced access il
requeste

@ Full description @ Requirements
3. Click Continue request.

Step 3. Remove unnecessary permissions

1. On the left navigation bar, go to Messenger > Messenger API Settings.
2. In the 3. Complete App Review section, click Request Permission.
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QO Meta = App Dashboard Docs Tools Support Apps Required actions 4 A

7% Yeastar Messaging v App ID: 477381038391389 App Mode: Development @ Live App type: Business @ Help
|
@ Dashboard
. . 1. Configure webhooks -
Required actions Configure a custom webhook URL or use services that help you set up an endpoint. Learn more.
{g} App settings v
2. Generate access tokens o
App roles “ Connect Facebook pages to generate access tokens and set up webhook subscriptions.
Q Alerts v v © 3 Complete App Review
This ission or feature requires ion of the App Review process before your app can access live data.
@ App Review v
Products Add Product You should create a prototype and submit for app review. This helps us review your overall app experience. Learn more

Webhooks To send and receive request pages._! i ission. To access more i [o—
features, please review our documentation. Learn more
Messenger ~ “

Messenger API Settings ¢/> Advanced - Optional

Instagram settings. Optional Advanced Settings
Activity log

i= Activity log

3. Unselect the checkboxes of the following permissions, then click Request Permis-
sion.

Request Permission
Required permissions

V| pages_messaging

Optional

pages_show_list pages_manage_metadata

pages_read_engagement business_management

Learn more Cancel Request P jon

You will be redirected to App Review > Requests.
Step 4. Answer data handling questions

1. On the left navigation bar, go to App Review > Requests.
2. Scroll down to the Data handling questions section, then click Answer questions
about data handling.



Omnichannel Messaging Guide | 2 - Administrator Guide | 112

N Meta App Dashboard Docs Tools Support Apps Required actions 1

74 Yeastar Messaging v App ID: 2478854338991095 App Mode: Development @ Live App type: Business @ Help

@ Dashboard
Business verification

Required actions

{C:)} App settings v ° Submit business verification >
App roles v
£ Alerts v Data handling questions
a App Review ~
| Answer questions about data handling >
Requests To obtain advanced to permissions, an app administrator must answer some questions about your data handling practices.
[ I

permissions and Features Learn about our d: ing guidelines
Products Add Product
Webhooks

(® Add additional permissions and features

Messenger v
Activity log

You must complete all steps before you can submit for review.

i= Activity log

3. Fill in the following information based on your situation, then click Submit.

Data handling questions 5 Auto-saved on 7:15PM, Aug 13,2024 (@ Predfill fromanotherapp X

A A A A 2 1P A At 0 S SIS AR SRR AR 13 SR, T L B 1A A A ) PR S 1 AR 8 I AR S TSt e

organization for guidance on how to answer these questions. Learn about our data handling guidelines.

“Personal data” is any data you receive from Meta that is related to an identifiable person. For examples, refer to the definitions in the General Data Protection Regulation (GDPR) and
the UK Information Commissioner’s Office.

Do you have a data controller located in the European Economic Area (EEA) or the United Kingdom (UK) that will be responsible for all data Meta shares with you?
A data controller is the entity that exercises overall control over the purposes and means of the processing of personal data. Refer to definitions in the General Data Protection Regulation (GDPR) and the UK GDPR for
detalls and examples

Yes

@ No/lamnot sure

List all data processors, including your own companies, that will have access to the personal data of users that you obtain from Meta.
A data processor is a person or business that provides you with services to help you process personal data you obtain from Meta. This may include Service Providers as defined in Meta's Platform Terms.

Yeastar

Have you provided the personal data of users to public authorities in response to national security requests in the past 12 months?
This does not include requests related to search warrants or court orders associated with criminal investigations

Yes, we have shared the personal data of approximately 10 or fewer users.

Which of the following policies or processes do you have in place regarding requests from public authorities for the personal data of users? Check all that apply.

Required review of the legality of these requests.

Need help? Contact Direct Support Cancel

4. Complete the following tasks to demonstrate why the pages_messaging permission
with advanced access is needed and how the app uses it.
a. Click How will your app use the advanced access pages_messaging per-
mission?.

How will your app use the advanced access pages_messaging permission? >
Review the policies for pages_messaging and tell us how you intend to use it

Describe how your app uses this permission or feature
Upload screencast showing the end-to-end user experience
Agree that you will comply with allowed usage

Please provide instructions for how to reproduce this feature

b. Copy and paste the following text in the detailed description box.
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This app is used to integrate Yeastar Phone System wi th Facebook
Messenger. After obtaining the "pages_nessagi ng" perm ssion,
agents can nmanage Page nessages within Yeastar Phone System

Tell us why you're requesting pages_messaging

Please provide a detailed description of how your app uses the permission or feature requested, how it adds value for a person
using your app, and why it's necessary for app functionality.

This app is used to integrate Yeastar Phone System with Facebook Messenger. After obtaining the "pages_messaging"
permission, agents can manage Page messages within Yeastar Phone System.

c. In the Test and reproduce the functionality of your integration section, se-
lect your Facebook Page, copy and edit the following text based on your situa-
tion, then paste in the text field.

Step 1: Log in to Yeastar Phone Systemwi th the follow ng
credenti al s:

Logi n address: { pbx_donai n_nane}

User nanme: {enmil address}

Passwor d: {password}

Step 2: Log in to Facebook with the foll owing credentials and
send a message to the Facebook Page: {url _for_facebook_ page}
Emai | or phone: {enmil_address_or_phone_nunber}

Passwor d: {password}

Step 3: Receive and reply to the nessage on Yeastar Phone System
In this example, we paste the following text:

Step 1: Log in to Yeastar Phone Systemw th the follow ng
credenti al s:
Logi n address: https://docs. exanpl e. yeast arcl oud. com

User nanme: smth@eastar.com
Password: rz9nDg3Cr O

Step 2: Log in to Facebook with the follow ng
credentials and send a message to the Facebook Page:
https://ww. f acebook. coni profil e. php?i d=61563743597525
Enmai | or phone: yangym@eastar.com
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Passwor d: YpeS345j oi

Step 3: Receive and reply to the nessage on Yeastar Phone System

Test and reproduce the functionality of your integration

As part of the review process, we will check that the functionality of the app experience is working as intended. If you provide a
Page management surface to users, provide us with a temporary test account so we can test it.

Yeastar ¥

Step 1: Log in to Yeastar Phone System with the following credentials:
Login address:https://docs.example.yeastarcloud.com/

Username: smith@yeastar.com

Password: rzdnDg3CrO

Step 2: Log in to Facebook with the following credentials and send a message to the Facebook Page:

bbb S s fmmbe e ale oo el e e VDA COATANCATEAT

d. Click Upload file to upload the screencast that demonstrates how you send a
message to your Facebook Page and how the message is received and replied
on Yeastar Phone System.

Upload a screen recording that demonstrates how your app will use this permission or feature so we can confirm it is used
correctly and does not violate our policies. For more information, visit the Screen Recordings guide and Developing for
Success video.

Drag and drop your file

!‘ Upload file

e. Select the checkbox to agree that you will comply with the allowed usage, then
click Save.

If approved, | agree that any data | receive through pages_messaging will be used in accordance with the allowed
usage.

5. Complete the following tasks to demonstrate why the Business Asset User Profile
Access permission with advanced access is needed and how the app uses it.
a. Click How will your app use the advanced access Business asset user
profile access feature?.
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How will your app use the advanced access Business asset user profile access feature?
Review the policies for Business asset user profile access and tell us how you intend to use it

Describe how your app uses this permission or feature
Upload screencast showing the end-to-end user experience

Agree that you will comply with allowed usage

b. Copy and paste the following text in the detailed description box.

This app is used to integrate Yeastar Phone System w th Facebook
Messenger. After obtaining the "Business Asset User Profile
Access" pernission, agents can view the nane of Facebook users
who send messages to the Page directly within Yeastar Phone
System which enables themto identify different Facebook users
and provide better services.

Tell us why you're requesting Business asset user profile access

Access feature a

Please provide a detailed description of how your app uses the permission or feature requested, how it adds value for a person
using your app, and why it's necessary for app functionality. [
This app is used to integrate Yeastar Phone System with Facebook Messenger. After obtaining the "Business Asset User Profile

Access" permission, agents can view the name of Facebook users who send messages to the Page directly within Yeastar -
Phone System, which enables them to identify different Facebook users and provide better services.

c. Click Upload file to upload the screencast that you have uploaded for pages_-
messaging.
Upload a screen recording that demonstrates how your app will use this permission or feature so we can confirm it is used

correctly and does not violate our policies. For more information, visit the Screen Recordings guide and Developing for
Success video.

Drag and drop your file

_‘!_ Upload file

d. Select the checkbox to agree that you will comply with the allowed usage, then
click Save.
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If approved, | agree that any data | receive through Business Asset User Profile Access will be used in accordance
with the allowed usage.

Cancel m
6. Complete the following tasks to demonstrate why the Human Agent permission with
advanced access is needed and how the app uses it.

a. Click How will your app use the advanced access Human Agent feature?.

How will your app use the advanced access Human Agent feature?
Review the policies for Human Agent and tell us how you intend to use it

Describe how your app uses this permission or feature

Upload screencast showing the end-to-end user experience

Agree that you will comply with allowed usage

O Your submission must include instagram_business_manage_messages or instagram_manage_messages to use Human
Agent

b. Copy and paste the following text in the detailed description box.
This app is used to integrate Yeastar Phone System w th Facebook
Messenger. According to Facebook's rul es,

user can only use
the Message Tag feature to send nessages to users outside the
24- hour Standard nessagi ng w ndow.

After obtaining the "Human Agent" perm ssion, when a custoner's
i nquiry cannot be resolved within the standard nmessagi ng wi ndow,

the agent can use the hunman_agent tag to continue providing
services to the custoner

Tell us why you're requesting Human Agent

Please provide a detailed description of how your app uses the permission or feature requested, how it adds value for a person
using your app, and why it's necessary for app functionality.

This app is used to integrate Yeastar Phone System with Facebook Messenger. According to Facebook's rules, user can only
use the Message Tag feature to send messages to users outside the 24-hour Standard messaging window. After obtaining the
"Human Agent"” permission, when a customer's inquiry cannot be resolved within the standard messaging window, the agent
ram irs tha bumsan sannt #am fa cantinos mesoidA -

T TNE Y AP T

c. Click Upload file to upload the screencast that demonstrates how your app us-
es a human agent tag to respond to customer messages.
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Upload a screen recording that demonstrates how your app will use this permission or feature so we can confirm it is used
correctly and does not violate our policies. For more information, visit the Screen Recordings guide and Developing for
Success video.

Drag and drop your file

!‘ Upload file

d. Select the checkbox to agree that you will comply with the allowed usage, then
click Save.

If approved, | agree that any data | receive through Human Agent will be used in accordance with the allowed
usage.

Cancel

7. At the bottom of the page, click Submit for Review and enter password to confirm
your operation.

Result

Your submission is queued and you will receive the review result in a few days.

What to do next

After you pass App Review, you need to switch your app to Live mode on 'Meta for Develop-
ers' portal, as shown below.

N Meta = App Dashboard Docs

;'. Yeastar Messaging v App ID: 2478854338991095 App Mode: Development . Live

ﬁ Dashboard
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Live Chat

Live Chat Integration Guide

By adding Yeastar Live Chat to a website, your website visitors can call or chat with your
agents in just one click, while agents in your business can centrally handle all customer con-
versations on Linkus UC Clients.

Highlights
Easy website integration

Embed a live chat widget on any website effortlessly, no coding skills required.

Free online consultation (chat & call)

Website visitors can initiate a chat or a call with agents in your business at no
cost.

Secure resource control

Specify website domain and limit the number of concurrent calls to ensure
that the live widget only works on the trusted website and prevent resource
abuse.

Requirements

Make sure Yeastar P-Series Cloud Edition meets the following requirements:

Item Requirement

Firmware Version 84.20.0.128 or later
Plan Enterprise Plan (EP) or Ultimate Plan (UP)

Domain Name Due to the limitation of the third-party platform, the domain name must NOT
contain underscore character(s), otherwise the messaging channel will encounter
authentication failure, or will fail to receive messages.

Domain A valid domain certificate is installed.

Certificate

) Note:
If the root domain of your Cloud PBX is NOT the standard Yeastar-provide
d domains (ycmcloud.com, yeastarcloud.com, or yeastarycm.co.za),
you NEED to install a valid domain certificate for the PBX first, otherwise
the messaging channel will encounter authentication failure, or will fail to
receive messages.
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Learn about the limitations of Live Chat widget.

Item Description

Message type

Messaging
mechanism

File retention
period

Chat session

Supports text messages, emojis, and images.

Note:
For Image: The file format should be . png, . j pg, or . j peg and the
maximum file size is 10 MB.

Supports to receive and reply to Inbound messages, but agents can NOT
initiate a chat or a call with website visitors through the live chat widget.

Files can be retained for 72 hours.

Supports 20 active sessions.

Set up a Live Chat Channel

To add Yeastar Live Chat to your website, you need to create and configure a live chat chan-
nel on Yeastar P-Series Cloud Edition first.

Before you begin

If you want to allow website visitors to call your agents directly, we recommend that you
create a WebRTC trunk and set up a corresponding inbound route in advance, as they are re-
quired in the follow-up process.

For more information, see Set up WebRTC Click-to-Call.

Procedure

1. Log in to PBX web portal, go to Messaging > Message Channel.
2. Click Add, and select Live Chat.
3. In the General tab, configure general settings for the channel.

a. In the Basic section, enter the following basic information.


https://help.yeastar.com/en/p-series-cloud-edition/administrator-guide/set-up-webrtc-click-to-call.html
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Basic

LiveChat www.yeastar.com

- Name: Enter a name to help you identify the channel.
» Website Domain: Enter the domain name of the website to which you
want to add the live chat widget.

Note:

For security reasons, the live chat widget will only load on the
website domain.

b. In the Interaction Mode section, set how website visitors can interact with
your agent(s) and where to route the visitors.

Interaction Mode Interaction Mode

Chat Only Phone and Chat

Phone calls through live chat is available only when visitors access the website through the HTTPS transport

Extension 1000-Leo Ball protocol. Please ensure that your website supports HTTPS.

Extension 1000-Leo Ball
Enable WebRTC Inbound Call

To achieve this feature please create a WebRTC trunk and an inbound route First.

WebRTC_Trunk WebRTC_Inbound_Calls

« Interaction Mode: Specify the interaction mode supported on the live

chat widget.
Option Description
Chat Only If selected, website visitors can communicate with your
agent(s) via chat message.
Phone and Chat If selected, website visitors can communicate with your

agent(s) via chat message or phone call.

) Note:
Phone calls through live chat is available only
when visitors access the website through HTTPS
transport protocol. Therefore, make sure that your
website supports HTTPS.
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« Destination: Specify the destination of inbound messages from live chat.

Option Description

Extension

Message Queue

Third-Party
Message
Analytics Platform
(Transmitted via
API)

If selected, choose an extension from the Extension
drop-down list.

Only the extension user can receive inbound messages
from live chat.

If selected, choose a queue from the Message Queue
drop-down list.

All the agents in the selected message queue can receive
inbound message(s) of new sessions in the queue.
However, only the user who picks up a session will be
able to receive and respond to the follow-up inbound
messages in the session.

If selected, inbound messages will be automatically
forwarded to a third-party message analytics platform via
API for advanced processing.

}* Note:
To enable automatic forwarding of inbound
messages to a third-party message analytics
platform, ensure that your PBX server has been
integrated with the third-party message analytics
platform via API. Once this option is selected, the
PBX system will automatically transmit inbound
messages to the designated platform. You can
get notified by monitoring the API event (30031)
New Message Notification. Additionally, the PBX
provides a comprehensive Message API suite for
advanced message interaction with the integrated
third-party message analytics platforms.

- Enable WebRTC Inbound Call: If you allow phone calls through live

chat, enable this option and select a WebRTC trunk and its corresponding

inbound route.

c. In the Advanced section, complete the following settings.



https://help.yeastar.com/en/p-series-cloud-edition/developer-guide/enable-yeastar-p-series-pbx-api.html
https://help.yeastar.com/en/p-series-cloud-edition/developer-guide/event-new-message-notification.html
https://help.yeastar.com/en/p-series-cloud-edition/developer-guide/event-new-message-notification.html
https://help.yeastar.com/en/p-series-cloud-edition/developer-guide/api-interfaces-and-events-summary.html#api-interface-and-event-overview__section_messaging
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Advanced

5 Text Only

Close Session Automatically
*

1 Day(s)

« Maximum Concurrent Calls: Set the maximum number of concurrent
calls supported on live chat.

When the limit is reached, no more calls can be made through live chat.

Note:
> Phone calls made through live chat, whether by agents or
website visitors, occupy the concurrent calls.
> The default number is 5, you can set up to 10 concurrent

calls.

- Supported Message Types for Visitors: Specify the message type that
website visitors can send.

Option Description

Text Only Website visitors can send text and emojis.

Text and Image Website visitors can send text, emojis, and images.

Note:
The maximum size for a single image uploaded
in the chat widget is 10 MB.

» Close Session Automatically: If you want the system to automatically
close the sessions that have been inactive for a specific period of time,
select the checkbox of Close Session Automatically, then set the time-
out in the Session Timeout field.

4. In the Display & Appearance tab, customize how the live chat widget on your web-
site will look and what information it will offer.

| Note:
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When customizing your chat widget, you can preview the changes you made
4 onthe right panel.

a. In the Appearance section, customize the appearance of your chat widget.

A

b
-@- Lightmode € Darkmode £ Helo How can we help you?

:
EEEE HEHF
:

R

| S IS

Appearance

@ Bubble =i Bar

* I

EUBQQD

o I

b. In the Display section, customize the information that will be displayed when
website visitors initiate a chat or a call.

A

.
A

@ Hello! How can we help you?
*

Support Name

Display

Hide "Powered by Yeastar"

o )

@
Note:

For Agent Information Display: If you choose Name or Name and

Profile Photo, the real name and profile photo of the agent who deals
with the chat message or phone call will be displayed when visitors ini-
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tiate a chat or a call. Otherwise, the default agent name and agent pro-
A file photo will be displayed.

5. In the Message section, configure language preference and message settings for the
chat widget.
a. In the Language section, select an option from the drop-down list.

This determines the display language of the chat widget.
b. If you want to use a pre-chat form to gather visitor information before a chat

starts, complete the following settings in the Pre-Chat section.

Pre-Chat

Enable Pre-Chat Form

* Hello §

Hello Please fill in the form below before starting
the chat.

P

%

Please fill in the form below before starting the chat.

1
First Name and Last Name Required \/ i
1
1
. P S
Email Address Optional \/
Phone Number Optional v/

Data Privacy and Consent

=

B I U o o]

We need to store and process your personal data to provide you with the requested content. For detailed informati
on about our privacy practices and our commitment to protecting your privacy, please check our Privacy Policy.

Require explicit consent

c. Optional: In the Message section, edit the following auto-reply text messages
as needed, which will be sent to website visitors based on specific scenarios.
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Message

Hello! How can we help you?

We are away, leave us a message!

Hello, thank you for contacting us. We have received your message.

This chat session has ended. Please feel free to contact us if you have any further questions.

Note:

The Online and Offline Greeting Messages are triggered based on office
hours. Make sure that office hours in the PBX are properly configured.
For more information, see Overview of Business Hours and Holidays.

» Online Greeting Message: Automatically send the text message to web-
site visitors when they open the chat interface in the following situations:
o PBX is within Business Hours, and the live chat destination is a mes-
sage queue.
> PBX is within Business Hours, and the live chat destination is an ex-
tension that is logged in to Linkus UC Clients with presence status
set to Available.
- Offline Greeting Message: Automatically send the text message to web-
site visitors when they open the chat interface in the following situations:
> PBX is within Outside Business Hours or Holidays.
> PBX is within Business Hours, and the live chat destination is an ex-
tension that logs out of Linkus UC Clients or that is logged in but
has presence status set to Away / Business Trip / Do Not Disturb /
Lunch Break / Off Work.
» Auto-response to the First Message: Automatically reply the text mes-
sage to website visitors when they send their first message in the chat.
« Chat Session Closed Message: Automatically send the text message to
website visitors when the chat session ends, either manually closed by
agent / website visitor or automatically closed when session timeout is

reached.


https://help.yeastar.com/en/p-series-cloud-edition/administrator-guide/overview-of-business-hours-and-holidays.html
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6. Click Save.

Result

A code snippet for live chat is generated and displayed in the pop-up window.

Embed Code (LiveChat) X

To enable live chat on your website, you'll need to add the embed code. Learn
configuration details in the User Guide.

<script Copy

src="https://docs.example.yeastarcloud.com/live chat.v1.0
.@.js?channelNumber=LC@00E0"></script>

Send installation instruction to website admin via email

What to do next

1. Click Copy to copy the code snippet.

Note:

You can also email the code snippet as well as the website domain to a spe-
cific user (e.g. website admin) to help with the process. The system will send
an email with installation instructions using the default template (Path: Sys-
tem > Email > Email Templates > Request to Add Live Chat to Website)
to the specified email address.

Send installation instruction to website admin via email

becky@yeastar.com
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2. Enable live chat on your website using the code snippet.

Enable Yeastar Live Chat on Your Website

After you obtain the code snippet for Yeastar Live Chat, you can paste the code snippet be-
fore the closing </ body> tag in the HTML code for your desired website. When done, a live
chat widget appears at the bottom-right corner of the website, enabling website visitors to
have a real-time conversation with your agents.

Procedure

To enable Yeastar Live Chat on your website, paste the code snippet before the closing </

body> tag in the HTML code for your desired website. After you successfully add the code
snippet to your website, a live chat widget is added to the bottom-right corner of your web-
site.

Note:

« Currently, the live chat widget is fixed to the bottom-right corner of a website
and its position can not be changed.

« The live chat widget has been proven to work when visitors access your
website using Google Chrome, Microsoft Edge, or Firefox. For other web
browsers, it may not work as expected.

Example

We take the following Content Management System (CMS) platforms as examples to show
you how to enable Yeastar Live Chat on a website.

 Enable Yeastar Live Chat on WordPress Website
 Enable Yeastar Live Chat on Joomla Website
 Enable Yeastar Live Chat on Drupal Website
 Enable Yeastar Live Chat on Wix Website

 Enable Yeastar Live Chat on Squarespace Website

Enable Yeastar Live Chat on WordPress Website

After you obtain the code snippet for Yeastar Live Chat, you can paste the code into the
footer of your WordPress website. When done, a live chat widget appears at the bot-
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tom-right corner of the website, enabling website visitors to have a real-time conversation
with your agents.

Prerequisites

You have obtained the code snippet for Yeastar Live Chat.

Enable Yeastar Live Chat on WordPress website using theme editor

1. Log in to your WordPress admin panel.

2. On the left navigation bar, go to Appearance > Themes, then click Customize on the
desired theme.

@ @A wordpress demo site

@ Dashboard

A Posts

97 Media

Search installed themes

I Pages
® Comments

Q SeedProd

® Elementor

& Templates

# Appearance

3. On the left navigation bar, click Pages, then edit your desired page.

Active: Yeastar
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@ wordpress demo site

¢ Design YeastarTest

& wordpress demo site

wordpress demo site Privacy Policy YeastarTest

< Pages

YeastarTest

Privacy Policy
admin Published

4. At the top-right corner, click ¢ , then click Code editor.
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. [+ g = B veastartest

Ctri+K

ccvBoo

VIEW

YeastarTest

single place

Distraction free

Write with calmness Ctbe shift\
Spotlight mode

Focus on one block at a time

EDITOR

Visual editor v
Code editor Ctrl+Shift+Alt+M
PLUGINS

Styles o0
TooLs

Keyboard shortcuts Shift-Alt+H
Copy all blocks

Help (4

Export

5. Scroll down to the bottom, paste the code snippet, then click Save.

Editing code

B vYeastarTest Ctrl+K

<!-- wp:paragraph -->
<p>...or something like this:</p>

<1-- /wp:paragraph -->

<!-- wp:quote -->

<blockquote class="wp-block-quote"><p>The XYZ Doohickey Company was founded in 1971, and has been providing quality
doohickeys to the public ever since. Located in Gotham City, XYZ employs over 2,000 people and does all kinds of
awesome things for the Gotham community.</p></blockquote>

<!-- /wp:quote -->

<!-- wp:paragraph -->

<p>As a new WordPress user, you should go to <a href="http://wordpress-demo.com/wp-admin/">your dashboard</a> to delete
this page and create new pages for your content. Have fun!</p>

<1-- /wp:paragraph -->

<script src="https://docs.example.yeastarcloud.com/live_chat.v1.0.0.js?channelNumber=LC0OOOD" ></script>

ccEdooe

Exit code editor

Access the page, then you will find the Live Chat widget is added to your website.




Omnichannel Messaging Guide | 2 - Administrator Guide | 131

@ @ wordpressdemosite W Editsite <8 ® 0 4+ New 2 EditPage WPCode Howdy, admin [ll Q |

YeastarTest

o

Enable Yeastar Live Chat on WordPress website using WPCode plugin

1. Log in to your WordPress admin panel.
2. On the left navigation bar, go to Plugins > Add New Plugin.
3. Add and activate WPCode plugin.

a. At the top-right corner, search for WPCode plugin, then click Install Now to in-
stall the plugin.

@ @ wordpress demo site

@ Dashboard Add Plugins Upload Plugin

A Posts

= Search Results ~ Featured ~ Popular ~ Recommended  Favorites  For Elementor (2 SearctrPlagims= wpcode Keyword v
3] Media
B Pages 16 items
% Comments
Q) Seedrod WPCode - Insert Headers and Footers Install Now Search & Replace Everything by

SeedProd N . .

> + Custom Code Snippets — WordPress ) WPCode - Find and Replace Media,
More Details .
© Eementor Code Manager ) p) Text, Links, and More
e
Easily add code snippets in WordPress. Insert header & Search and Replace everything in WordPress. Easily find

[ =

eress WPCode s, a ith condi ore with a

» Appearance

£ Plugins

Installed Plugins (1.392) Last Updated: 5 days ago &) Last Updated: 3 weeks ago

Add New Plugin 2+ Million Active Installations ¥ Compatible with your version of WordPress 1,000+ Active Installations ¥ Compatible with your version of WordPress

b. Click Activate to activate the plugin.
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WPCode - Insert Headers and Footers
/> + Custom Code Snippets — WordPress

Mo ils
Code Manager )
WPC d Easily add code snippets in WordPress. Insert header &
oce footer scripts, add PHP code snippets with conditional
logic, insert ads pixel code, and more.
By WPCode
(1,392) Last Updated: 5 days ago
2+ Million Active Installations v Compatible with your version of WordPress

4. Add the code snippet to the footer.

) @A wordpressdemosite <8 B 4+ New WPCode

Howdy, admin [l

© Elementor Global Header and Footer

& Templates
Footer

» Appearance

K¢ Plugins v 1|<seript sre="https://docs. example. yeastarcloud. com/live_chat. v1. 0. 0. js?channelNumber=LC00000”></script>
& Users

& Tools

Settings

Code Snippets

Header & Footer
Conversion Pixels

a. On the left navigation bar, go to Code Snippets > Header & Footer.
b. In the Footer section, paste the code snippet.
c. At the top-right corner, click Save Changes.

Access the page, then you will find the Live Chat widget is added to your website.
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@ @ wordpressdemosite A Editsite <& 8 B

YeastarTest

° o

Enable Yeastar Live Chat on Joomla Website

After you obtain the code snippet for Yeastar Live Chat, you can paste the code to your
Jommla website's source code before the / body tag. When done, a live chat widget appears
at the bottom-right corner of the website, enabling website visitors to have a real-time con-
versation with your agents.

Prerequisites

You have obtained the code snippet for Yeastar Live Chat.

Procedure

1. Log in to your Joomla's administrator panel.
2. On the left navigation bar, click System, then click Site Templates.
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m Joomlal # System Dashboard ®443

@ Toggle Menu

4 Home Dashboard 2 Setup / Maintenance
B Content Global Configuration Clear Cache
Menus
Database
c X, Install
omponents
Global Check-in
Users Extensions
Languages Extensions

Languages
& Templates

N Content Languages
Site Templates

. Language Overrides
Site Template Styles

|E

ugins
Administrator Templates

© Information
Warnings
v Installation Messages

v System Information

& Update
Joomla
Extensions

Update Sites

A User Permissions

Groups

3. Click the template to which you want to add the code.

m Joomlal’ <[> Templates: Templates (Site) ®443

@ Toggle Menu
99 & Styles

4 Home Dashboard

Content site > Search
= Menus
Components
Image Template ~

Users

Cassiopeia Details and Files
No preview ble. You can enable

System

Help

Vi

5 TakeaTour v M 2 Postinstallation Messages [ joomladdemo | €@ UserMenu v

-]

5 TakeaTour v M 2 Postinstallation Messages  [4 joomladdemo €@ UserMenu v

Options ? Help

n Template ascending v 20 v

ersion Date Author

1.0 2017-02 Joomla! Project

admin@joomla.org

4. Click index.php, then paste the code snippet before / body tag.

B save B Save&Close & Rename File X Delete File X Close File

Editor Create Overrides Updated Files Template Description

Editing file "/templates/cassiopeia/index.php" in template "cassiopeia”

Bm /templates/cassiopeia

<jdoc:include type="modules” name="bottom-b” style="card” />

B himl <fdiv>

B component.php <php endif; 7
22t <fdiv>

B errorphp

= <php it (§this->countlodules(’ footer’, true)) : 7>
B index.php v Cfooter class="container-footer footer full-width”>
<div class="grid-child">

B joomla.asset.json <jdoctinclude type="modules” name="footer” style="rone” />

E offiine. php 32 </footer>
B templateDetails.xml <Iphp endif; 7

<Iphp if (§this->params->get ( backTop') SIS

<a href="#tcp” ack-top” clas:

B /media/templates/site/cassiopeia

“back-to-top-link” aria-label="<7php echo Text::_(' TPL_CASSIOPEIA BACKTOTOF');
con-arrow-up Lcon-fw” aria-hidden="true”></span>

M css <fa>
<Tphp endif; 7
m images
<jdoc:include type="modules” name="debuz” style="none” />
mjs {script_src="https://docs. exanple. yeastarcloud. con/live_chat. v1.0.0. js7channel Nunber=LC00006”></script>
<oody>
| scss 2 <,m..\;’>

5. At the top-left corner, click Save.

5/5 Columns ~

Override Files

Upto

? Help

Press F10 to toggle Full Screen editing.
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Result
Access your Joomla website, you will find the live chat widget is added to the bottom-right
corner of your website.

CASSIOPEIA
You are here: Home Main Menu

Home

Login Form

Hi admin,

Home

Log out

Enable Yeastar Live Chat on Drupal Website

After you obtain the code snippet for Yeastar Live Chat, you can add the code to your Drupal
website. When done, a live chat widget appears at the bottom-right corner of the website,
enabling website visitors to have a real-time conversation with your agents.

Procedure

1. Log in to your Drupal admin panel.
2. On the top navigation bar, go to Structure > Block layout.

@ Backtosite = Manage Y Shortcuts _§ admin

B content | gk Structure | X Appearance | Pe Extend 9\ Configuration g People  4lI Reports @ Help

Home > Administration

Structure

> Block layout

Configure what block content appears in your site's sidebars and other regions

3. Scroll down to the bottom, click Place block beside Footer Top.
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@ Backtosite = Manage Y Shortcuts _§ admin

I Content gk Structure 4 Appearance | Pe Extend S\ Configuration g People ]I Reports @ Help

Content Below  Place block
No blocks in this region
Footer Top Place block

No blocks in this region
Footer Bottom Place block

No blocks in this region

4. Add a custom block.

Place block

| + Add custom block

‘ Filter by block name

B Content gk Structure | X Appearance Mo Extend |, Configuration g People ol Reports | @ Help

Home

Add custom block

Block description

Yeastar Live Chat

fon of your block

B I SXx L @ ZiTv @@ — )5 sourc
<script sro="https://docs. example. yeastarcloud. con/Live_chat.v1. 0. . js7channe lumber=LCO00D0"></ script>

Text format [Full HTML___ v | About text formats
— S

| Revision information Revision log message
No revision

VE

a. Click Add custom block.
b. In the Block description field, enter a short description of the block.
c. In the Body field, click Source, then paste the code snippet.
d. In the Text format drop-down list, select Full HTML.
e. Click Save.
5. Scroll down to the bottom, then select Footer Top from the Region drop-down list.



Omnichannel Messaging Guide | 2 - Administrator Guide | 137

Region*
Footer Top A

Select the region where this block should be displayed.
6. Click Save block.

Result
Access your Drupal website, you will find the live chat widget is added to the bottom-right
corner of your website.

= Manage Y Shortcuts  § admin

B Content gk Structure  4X Appearance Mo Extend W Configuration  Jg People Il Reports = @ Help

YeastarTest

©

©

Enable Yeastar Live Chat on Wix Website

After you obtain the code snippet for Yeastar Live Chat, you can paste the code to your Wix
website's source code before the / body tag. When done, a live chat widget appears at the
bottom-right corner of the website, enabling website visitors to have a real-time conversa-

tion with your agents.

Note:

You can also add the chat widget using Wix Editor. For more information, see Wix
Editor: Embedding a Site or a Widget.



https://support.wix.com/en/article/wix-editor-embedding-a-site-or-a-widget
https://support.wix.com/en/article/wix-editor-embedding-a-site-or-a-widget
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Prerequisites

You have obtained the code snippet for Yeastar Live Chat.

Procedure

1. Log in to your Wix account, then go to Settings.
2. On Settings page, scroll down to the ADVANCED section, then click Custom code.

</> Custom code %% Headless settings 59 Marketing Integrations
Add custom code snippets Use QAuth apps to Connect marketing tools to
to the head or body of your authenticate with Wix and understand how people
site. make API calls from any interact with your site.

external platform.

3. At the top-right corner, click Add Custom Code.
4. In the pop-up window, complete the following settings, then click Apply.
- Paste the code snippet here: Paste the code snippet for the live chat widget.
« Name: Enter a name to help you identify the code.
- Add Code to Pages: Set the page(s) to which you want to add the code snippet.
» Place Code in: Select Body - end.

Result

Access your Wix website, you will find the live chat widget is added to the bottom-right cor-
ner of your website.

Enable Yeastar Live Chat on Squarespace Website

After you obtain the code snippet for Yeastar Live Chat, you can paste the code into the
footer of your Squarespace website. When done, a live chat widget appears at the bot-
tom-right corner of the website, enabling website visitors to have a real-time conversation
with your agents.

Prerequisites

You have obtained the code snippet for Yeastar Live Chat.
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Procedure

1. Log in to your Squarespace account.
2. On the Dashboard, click the website to which you want to add the live chat widget.

12) Dashboard Domains Help AccountSettings &

Test
marlin-cube-tgha.squarespace.com

Website trial expires on Aug 31, 2024

WEBSITE SELLING

3. On the left navigation bar, go to Pages > Website Tools > Code Injection.

% Q { HOME & WEBSITE
Pages Q Website Tools
Setup Guide ¢
) CUSTOM CODE
Website Main Navigation 4+ <
Pages Custom CSS
Styles Member Sites () O+ < Cade Injection
Assets
Selling Not Linked (@ + < MESSAGING
Invoicin
g Announcement Bar
Content &
Memberships Promotional Pop-Up
Utilities
Donations Mobile Information Bar
System Pages
Scheduling
Website Tools
Marketing
Trash
Contacts
Analytics Version 71

4. In the Footer section, paste the code snippet.


https://login.squarespace.com/
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FOOTER

Enter code that will be injected into the template-defined footer on every page of your site.

1 <script src="https://docs.example.yeastarcloud.com/live_chat.v1.0.0.js?

channe lNumber=LC00000"></script>

5. At the top-left corner, click Save.

Result

The live chat widget is added to the bottom-right corner of your website.

Home
EDIT Page - Published I;I B & A
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WhatsApp

Set up a WhatsApp Channel

This topic describes how to set up a WhatsApp channel on Yeastar P-Series Cloud Edition,
so that agents in your business can receive and reply to WhatsApp messages from cus-
tomers on their Linkus UC Clients.

Requirements
Make sure the following resources are ready.

Platform Requirement

Yeastar PBX  Firmware: Version 84.20.0.128 or later

* Plan: Enterprise Plan (EP) or Ultimate Plan (UP)

- Domain Name: Due to the limitation of the third-party platform, the domain
name must NOT contain underscore character(s), otherwise the messaging
channel will encounter authentication failure, or will fail to receive messages.

» Domain Certificate: A valid domain certificate is installed.

,'* Note:
If the root domain of your Cloud PBX is NOT the standard
Yeastar-provided domains (yecmcloud.com, yeastarcloud.com, or
yeastarycm.co.za), you NEED to install a valid domain certificate
for the PBX first, otherwise the messaging channel will encounter
authentication failure, or will fail to receive messages.

WhatsApp  Product: WhatsApp Business Platform

« Account:
o A Meta Developer account

Note:
You only need ONE Meta Developer account to create
MULTIPLE Meta apps for the WhatsApp channel integration.
There is no limit to the number of WhatsApp channels on PBX.

[

A Business Manager account (Business Portfolio)

Note:
After you set up a Business Manager account, verify your
business.

* Phone number: Ensure that your phone number is valid and available for
messaging.



https://developers.facebook.com/docs/development/register
https://www.facebook.com/business/help/1710077379203657?id=180505742745347
https://www.facebook.com/business/help/2058515294227817?id=180505742745347
https://www.facebook.com/business/help/2058515294227817?id=180505742745347
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Platform Requirement

Note:

Ad accounts

Business asset groups

(2] ) Test Business
Settnss Business portfolio

[
® () users ~
o People

Partners
& System users

5 Accounts ~
Pages

PP

© Yeastar Messaging

=
& DataSources v .
& Requests v ®
Q
n © Brandsafetyand... v &)
D‘ 09’
R
Q
@
o
2
Troubleshooting:

Yeastar Messaging
- 2

© o

Owned by: Test Business

& Assign people

Summary  People  Partners

Business information
Address
No address

Curvanc.

WhatsApp Manager > Phone numbers

2% Partner overview

& Partner solutions
View guidelines

&) overview

Q Search by phone number
) Message templat... A
Phone number
Manage templates

Template library +15559871234
© us

3 Account tools ~

Insights
Flows
Catalog

Activity log

ffi) Paymentconfigu... A

Indin

or name

Name

Leo Ball

You can check the status of your phone number on 'Meta Business

Suite' portal (Path: Account > WhatsApp accounts > WhatsApp
Manager > Account tools > Phone numbers).

Status

Connected

What should | do if my WhatsApp phone number status is "Pending"?

x

Assign people

Edit business information

Payment settings [}
WhatsApp Manager [}
Remove i Jsiness portfolio

Filter by country v

Quality rating

® High

Limitations

Learn about the limitations of WhatsApp messaging channel.

Item Description

Important:

Message type Supports text messages and multimedia messages, where the multimedia
message types are determined by WhatsApp. For more information, see
WhatsApp supported media types.

¥ Filter by status -

Messaging Limit

1K Customers/24hr


https://business.facebook.com/
https://business.facebook.com/
https://help.yeastar.com/en/p-series-cloud-edition/faq/omnichannel-messaging-faq.html#omnichannel-messaging-faq__pending-number
https://developers.facebook.com/docs/whatsapp/cloud-api/reference/media#supported-media-types
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Item Description

Messaging
mechanism

Message sending
rate

File size

File retention
period

When sending multimedia messages (such as images), WhatsApp
downloads the file from a link provided by the PBX. Therefore, if you
have set Allowed Country/Region IP Access Protection rule, make
sure that you have allowed the IP access from the country where the
WhatsApp server is located, otherwise the file transmission would fail.

You can receive and reply to customers' inbound messages, or proactively
initiate a messaging session using a WhatsApp message template.

Supports to send up to 80 messages per second.

Supports to send a file with a maximum size of 100 MB.

Files can be retained for 72 hours.

Procedure

» Step 1. Create a Meta app on 'Meta for Developers' portal

« Step 2. Obtain essential credentials on 'Meta Business Suite' portal

« Step 3. Create and configure a WhatsApp channel on PBX

« Step 4. Configure webhook in the Meta app

Step 1. Create a Meta app on 'Meta for Developers' portal

On 'Meta for Developers' portal, create a Meta app on the Meta for Developers portal, add
phone number to the app, and obtain a phone number ID as well as the app secret, which is
required later when configuring the WhatsApp channel on the PBX.

1. Log in to 'Meta for Developers' portal with your Meta Developer account, then go to

My Apps from the top menu.


https://help.yeastar.com/en/p-series-cloud-edition/administrator-guide/restrict-specific-countries-or-regions-from-accessing-yeastar-pbx.html
https://developers.facebook.com
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2. Create an app of the Business type.
a. Click Create App.

b. Complete the app settings.

Note:
In the Business Portfolio field, select your Business Account to con-
nect the app with your business, as apps that need advanced access

for permissions must be connected to a verified business entity.



https://developers.facebook.com/docs/graph-api/overview/access-levels/
https://developers.facebook.com/docs/graph-api/overview/access-levels/

Create an app

(D App details

 and more. You'lbe sk 10 select  app ype then acid
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3. In the Add products to your app page, scroll down to find WhatsApp and click Set

up.

Webhooks

Subscribe to changes and receive updates in real

time without calling the API.

Read Docs

Setup

S =

WhatsApp Facebook Login for Business

Integrate with WhatsApp A secure way for businesses to give your app

Read Docs

permissions to access data.

Set up Read Docs Setup

You are redirected to the Quickstart page of the WhatsApp product.
4. On the left navigation bar, go to WhatsApp > APl Setup > Send and receive mes-
sages, and complete the followings:

a. In the From drop-down list, click Add phone number to add your WhatsApp
phone number for messaging.

Send and receive messages
Step 1: Select phone numbers

From

Test phone numbers allow you to send free messages for 90 days. You can use your own phone number, which is subject to limits and pricing. About

pricing

[ Test number: +1 555019 3510

)

Test Number
L] @ +1 555019 3510

+ Add phone number

Business

Add phone number

@ WA Business Profile

O Add number

Add a phone number for WhatsApp X
This is the number people will see when they chat with you. Learn how to use a

number that's already on WhatsApp.
Phone number
Us +1 v | (555)987-1234 o |
2 code to verify this numbe

Choose how you would like to verify your number:
If you are using a landline number, choose phone call

@ Text message Phone call

-

b. Select the added phone number from the list, then note down the corresponding
Phone number ID as you will need to add them on the PBX later.
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Send and receive messages

Step 1: Select phone numbers

From
Test phone numbers allow you to send free messages for 90 days. You can use your own phone number, which is subject to limits and pricing. About
pricing
+1 5559871234 -
Phone number ID: 39 05 % WhatsApp Business Account ID: 44 02 O
To
US+1 w  Phone number

Important:

If you are using the test number provided by WhatsApp for demo or
testing purposes, you need to specify the recipients' phone number in
the To drop-down list, otherwise message sending may FAIL.

Step 1: Select phone numbers

From
Send free messages with the provided test phone number. You can usgauenwmmshansmumbsmuhinksissnbissttadimitsandmnrininmsamemnrms

Test number: +1 555019 3510 v Add a recipient phone number X
You can have up to 5 phone numbers to receive free test messages.

Phone number

Ph ber ID: 1 7 WhatsApp Business A
one number © 1SAPP BUSINESSAR s +1 - | (800)278-6915 o]

To . : : .
By continuing, you are giving consent to receive messages at this phone number.

Gancel m
:

{ Select a recipient phone number v J

Manage phone number list

s s s S s snsmmsmsness PIINAL AN NrRSS Anter Tn create vour own messane temfhlate click here

5. On the left navigation bar, go to App settings > Basic, note down the App secret of
the app, as you will need it later on PBX.

@ Dashboard

Required actions App ID App secret

ﬁ' App settings ~ g i 744 2 Reset
Basic Display name Namespace
Advanced Yeastar Messaging

Step 2. Obtain essential credentials on 'Meta Business Suite' portal

On 'Meta Business Suite' portal, create a system user and grant permissions to the user,
then generate an access token for the user to grant access the Meta App you created in the
previous step, which is required when configuring WhatsApp channel on the PBX. Addition-
ally, obtain the WhatsApp Business Account ID, which is needed to retrieve message tem-
plates associated with the account.
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Important:

It is recommended to use the access token from Meta Business Suite instead of
the one from Meta for Developer portal, as the latter is a temporary token that may
cause missed messages once it expires.

1. At the top-left corner of the 'Meta for Developers' portal, go to App Dashboard >
Business settings.

00 Metafor Developers | = App Dashboard |
¥ Docs

Shortcuts “
I
.
© ich © i

ﬂ WhatsApp Business settings| Business Support

Manager Home
& \s] (@) ®: t
Apps Brand Safety and Ad account
Suitabilit settings

y g !

You are redirected to the Business settings page of ‘Meta Business Suite' portal.

2. Go to Users > System users, create a system user and grant app permission to the
user.

a. Click Add to create a system user with Admin role.

. Test Business
Settings T Business portfolio
@ Businesspoltoiiolin i System users © Q Search by name or ID + Add
® (&) users ~ Name 7 Role ©
8 People
- Partners
Q Create system user x
.
Enter a name for the system user you want to create below
S Qe - System user name
Admin
Pages
Ad accounts
Business asset groups -
Apps
WhatsApp accounts
Q
a &3 DataSources v
) I

b. Select the created user, click Add assets and grant the full control permission
of the app to the created user.


https://developers.facebook.com
https://business.facebook.com/
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System users @

Q Search by name or ID

Name 7
Admin
g &  1D:100 185 Generate token Revoke tokens X
g 1D: 106 185 Admin access
Edit info

Assigned assets Installed apps

Assign assets

Select assets and assign permissions

. Ny

Select asset type @

Catalogs
Apps
WhatsApp accounts

1 asset selected

3. Go to Accounts > WhatsApp Accounts, add the created user to your WhatsApp Busi-

Select assets

Q Search by name or ID

—  Selectall

v ‘,'. Yeastar Messaging

Assign permissions

Partial access

Full control
Manage app

Can manage roles, change app settings, test the app and
view analytics.

ness account and grant the user full control permission.

Settings

E5) Business portfolio info

)] users A

People

Partners

o0 0 B

System users

7 Accounts -~

Pages

Ad accounts
Business asset groups
Apps

Instagram accounts

&3 DataSources v

Test Business

Business portfolio

WhatsApp accounts @

Name T4

© Yeastar Messaging

Add people and set permissions
WhatsApp account: Yeastar Messaging

Add people

Q_ search by name, ID, or email
— | Selectall

v B Admin (System user)

1 person selected

Q Search by name or ID

Yeastar Messaging
1D: 9751025558261144
Owned by: Test Business

& Assign people

Summary  People Partners

Business information

Assign permissions
Partial access -

Full control

Manage WhatsApp business accounts
@ ou can do all o the above, and also assign users and view

Edit

= Filters + Add
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4. Go back to Users > System users, generate an access token with the what sapp_-
busi ness_nessagi ng and what sapp_busi ness_management permissions enabled.

Note:
By default, the token expires after 60 days. You can set it to Never if you
don't want the token to expire.

Test Business

Settings [T ;s porfolio
E] E=] Business portfolio info System users © Q Search by name or ID + Add
® B users > Name 1 Admin
85
People ¢ Admin & ID:10 185 Generate token Revoke tokens X
) 1D: 100 "85 Admin access
Partners
Assigned assets  Installed apps
& System users
Accounts ~ Py .
= Generate token What permissions will be granted to the app? x
Pages
@ selectapp @ Ifyou are unable to find the necessary permissions, consider
Ad accounts granting an app role to the system user.
@ setexpiration
Business asset groups Select permissions
(O Assign permissions
Apps 2 options selected - ) o Mancge
Instagram accounts Q
2
WhatsApp accounts pages_read_user_content @ Mfanage
pages_show_list
Q a b W Manage
v
u foJDRta SrcEs private_computation_access
publish_video 3 w Manage
o ~
& @ read_insights
0] Manage
read_page_mailboxes
v whatsapp_business_management -
v whatsapp_business_messaging .

The pop-up window shows the generated access token.

Important:
Make sure that you have copied and properly saved the access token before
closing the pop-up window, as it is only displayed ONCE.
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Generate token

Q Selectapp

@ setexpiration

Token created X

Your token has been created and can now be used.

Token

0 Assign permissions

O Done

5. Go to Accounts > WhatsApp accounts, click your WhatsApp Business Account, then

copy the account ID.

Test Business
Business portfolio

Settings T

£ Businessinfo WhatsApp accounts @

B o

Q search by name or ID

= Filters + Add

a

& users £ Name 11
@ Test WhatsApp Business Account
- 1D: 10 135 X
g EopE (© Test WhatsApp Business Account Ownef@/. Test Business
Partners &
B SySemer & Assigi people & Assign partner
& Accounts o~ Summary People Partners
Pages
Business information Edit
Ad accounts
Address
Business asset gro... No address
Currency
Apps
PPp! .
Instagram accounts .
Time Zone

> R n /:)

America/Los_Angeles

Business name
Test Business

Business verification v

Step 3. Create and configure a WhatsApp channel on PBX

On the PBX, create a WhatsApp channel and configure it using the information obtained in
the previous steps. This ensures that the PBX can connect to the WhatsApp for messaging.

1. Log in to PBX web portal, go to Messaging > Message Channel.

2. Click Add, and select WhatsApp.

3. In the Authentication tab, enter the authentication information of WhatsApp.
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Authentication Messaging Settings

Please refer to the User Guide for information on how to configure the following settings

WhatApp channel https://docs.example.yeastarcloud.com/api/v1.0/webhook/whatsap..

- Name: Enter a name to help you identify the channel.

« Webhook URL: Note down the Webhook URL, as you will need it later on What-
SApp.

» Verify Token: Note down the verify token, as you will need it later on Whats-
App.

« Access Token: Paste the Access Token obtained from 'Meta Business Suite'

portal.
« App Secret: Paste the App Secret obtained from ‘Meta for Developers' portal.

4. In the Messaging Settings tab, configure the channel.
a. Enter WhatsApp phone number information.

+15559871234 12 7

« Phone Number: Enter the WhatsApp phone number in E.164 format ([ +]
[country code] [ phone nunber] ) For example, +15559871234.
+ Phone Number ID: Paste the phone number ID.

b. In the WhatsApp Business Account ID field, paste the account ID obtained
from 'Meta Business Suite' portal.

PBX will automatically synchronize the message templates associated with the
WhatsApp account to the channel.

c. In the Destination for Inbound Messaging drop-down list, specify the desti-
nation of inbound messages from the number.
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5000-Leo Ball

Extension

b
Message Queue
Option Description

Extension If selected, choose an extension from the Extension
drop-down list.
Only the extension user can receive inbound messages from
the number.

Message Queue If selected, choose a queue from the Message Queue

drop-down list.

All the agents in the selected message queue can receive
inbound message(s) of new sessions in the queue. However,
only the user who picks up a session will be able to receive and
respond to the follow-up inbound messages in the session.

Third-Party Message | If selected, inbound messages will be automatically forwarded
Analytics Platform to a third-party message analytics platform via API for
(Transmitted via API)  advanced processing.

Note:
To enable automatic forwarding of inbound messages
to a third-party message analytics platform, ensure
that your PBX server has been integrated with
the third-party message analytics platform via
API. Once this option is selected, the PBX system
will automatically transmit inbound messages to
the designated platform. You can get notified by
monitoring the API event (30031) New Message
Notification. Additionally, the PBX provides a
comprehensive Message API suite for advanced
message interaction with the integrated third-party
message analytics platforms.

d. In the Extensions Allowed to Create Messaging Sessions section, select the
extensions that are allowed to initiate a messaging session with customers.


https://help.yeastar.com/en/p-series-cloud-edition/developer-guide/enable-yeastar-p-series-pbx-api.html
https://help.yeastar.com/en/p-series-cloud-edition/developer-guide/enable-yeastar-p-series-pbx-api.html
https://help.yeastar.com/en/p-series-cloud-edition/developer-guide/event-new-message-notification.html
https://help.yeastar.com/en/p-series-cloud-edition/developer-guide/event-new-message-notification.html
https://help.yeastar.com/en/p-series-cloud-edition/developer-guide/api-interfaces-and-events-summary.html#api-interface-and-event-overview__section_messaging
https://help.yeastar.com/en/p-series-cloud-edition/developer-guide/api-interfaces-and-events-summary.html#api-interface-and-event-overview__section_messaging
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| 2/9items Available 2items Selected

®  Extension Number Caller ID Name Extension Number Caller ID Name

Extension Group Training Group 5000 Leo Ball

5002 Sarah Bennet % 5001 Kristin Hale
3@ 5003 Dave Miller
5004

Micheal Harris

a

5005 Lucy Anderson

5006 Rachel Morgan

e. Optional: If you want the system to automatically close the sessions that have
been inactive for a specific period of time, select the checkbox of Close Ses-
sion Automatically, then set the timeout in the Session Timeout (Days) field.

Close Session Automatically

5. Click Save.

Step 4. Configure webhook in the Meta app

On the 'Meta for Developers' portal, set up a webhook for your Meta app to receive real-time
message events. This allows the PBX to process incoming messages from WhatsApp.

1. Log in to 'Meta for Developers' portal with your Meta Developer account, then go to
My Apps from the top menu.


https://developers.facebook.com

Omnichannel Messaging Guide | 2 - Administrator Guide | 154

2. Click the created app to enter the details page.

OQ Meta for Developers Docs Tools Support [WIYCBl Q. Search developer documentation _

Apps Q search by App Name or App ID Create App
Filter by Recently Used v
(®) AllApps (2)

Archived
‘App ID: 12 6
. . Mode: In development
Required actions Type: Business

Business: Test Business

® Administrator

3. Go to WhatsApp > Configuration to configure the messaging webhook and sub-
scribe to webhook field, so that PBX can get notified upon receiving WhatsApp mes-
sages.

a. Paste the Webhook URL and verify token obtained from the PBX.

Webhook
To get alerted when you receive a message or when a message's status has changed, you need to set up a Webhooks endpoint for your app. Learn
how to configure Webhooks.

Callback URL @
https://docs.example.yeastarcloud.com/api/v1.0/webhook/whatsapp/4f3664096f524cc79d7b8fed69ec9b17,
Verify token @

38owndego8ugcinx

@  Attach a client certificate to Webhook requests. Learn more.

Remove subscription

b. In the Webhook fields section, subscribe to messages webhook field.
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messages v21.0 - Test . Subscribed

Result

« The Status of the WhatsApp channel shows @, which indicates that you have suc-
cessfully created a WhatsApp channel.

Status Name Type Number Total Sent Operations

@ WhatsApp channel WhatsApp +15559871234 0 0 Z ™

« PBX automatically tracks and records the number of messages sent and received on

the channel, where the Total column displays the total amount of the sent messages,
including both successfully sent messages and failed ones.

6 Tip:

You can filter the statistics by a time period using the time filter.

Number Total Sent Failed Received Operations

+15550193510 30 20 10 8 Z

What to do next

Send text messages to the phone number and see if the specified agent can receive mes-
sages on his or her Linkus UC Client.

Related information
Check and Manage External Chat Logs
User Guide - Manage customer queries from SMS channel on Linkus Web Client /
Desktop Client
User Guide - Manage customer queries from SMS channel on Linkus Mobile Client

View WhatsApp Message Templates

Yeastar P-Series Cloud Edition supports WhatsApp message templates, allowing extension
users to send pre-approved, structured messages to their customers.
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Introduction

PBX automatically synchronizes approved message templates based on the WhatsApp
Business Account ID associated with the WhatsApp channel. By default, extension users
can reply to inbound messages within the WhatsApp channel during the WhatsApp 24-hour
customer service window. To proactively send messages, such as initiating a new Whats-
App session or launching a WhatsApp campaign for bulk messaging, outside this 24-hour
time window, users must use these synchronized template messages.

« For more information about how to view message templates for a WhatsApp channel
in PBX, refer to the instructions below.

« For more information about how to use template messages in a WhatsApp campaign,
see Create a WhatsApp Campaign.

 For more information about how users can use the message templates, see Agent
Guide - Start a Message Session via a WhatsApp Channel.

Prerequisites

» Ensure that the firmware of PBX server is 84.20.0.21 or later.
» Message templates have been created and approved in your WhatsApp Business Ac-

count.

Note:

> Only templates with Active status will be synchronized to the PBX; mar-
keting templates of the Catalog type will be excluded.

> The PBX supports synchronizing up to 250 message templates for each
WhatsApp channel.

o Variable names in the template support only lowercase letters and
numbers. Do not use underscores or special characters, as this may af-
fect usage.



https://www.facebook.com/business/help/2055875911147364?id=2129163877102343
https://www.facebook.com/business/help/2055875911147364?id=2129163877102343

Settings
& Businessinfo

@ users ~

people

Partners

a8
®
g
&

System users

B Accounts ~
Pages
Ad accounts

Business asset gro...

Test Business
Business portfolio

WhatsApp accounts @

Name 11

(O Yeastar Messaging
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Q search by name or ID

Yeastar Messaging

1D:
Ovned by: Test Business

& Assign people & Assign partner

Summary  People Partners

Business information

Address
No address

9 |
Assign people
Edit business information
Payment settings &)
WhatsApp Manager ]

Remove fron] business portfolio

. Currency
Instagram accounts

WhatsApp accou...
Manage templates

Template libra
pl ry

O, Messaget... ~

Templates  Template groups

Q search Categ... ¥ Langu. last7.. ¥ £ Namespace

Sy B

Compare Create template

Last
edited

& Accountt.. A

Status 1! Mess: g 4~ Mess g
delive rea...

Template
name

Insights Language 1.

Flows

English (US)
Welcome and congrat.

Phone numbers hello_world Utility Active - Qualit 0 Oct 16, 2023

Catalog
1 message template shown (total active templates: 1 of 6000)

Activity log

« A WhatsApp channel has been set up with your WhatsApp Business Account.

Procedure

1. Log in to PBX web portal, go to Messaging > Message Channel.
2. Click [ beside a WhatsApp channel.

Sent Operations

2| B |

Status Name Type Number Total

©

WhatsApp Message Template X 189

O Refresh Q

Template Name Template Type O Template Language O Preview
PromoOffer Marketing English (US) ©
AccountVerification Authentication English (US) [G]
Eventinvitation Marketing English [©]
FeedbackRequest Marketing English ©
AppointmentReminder Utility English (US) [G]
PaymentSuccess Utility English [©]
ShippingUpdate Utility English ©
OTPCode Utility English [G]
Q Total: 85 2 3 4 5 > 20/ page Goto

A window pops up, displaying all synchronized message templates associated with
your WhatsApp Business Account.

3. To preview a message template, click O}
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4. To update the list and content of message templates to the latest version, click Re-
fresh.

Note:
The system automatically refreshes the templates once a day by default. If
needed, you can also refresh the list manually.

Message Queue Setup

Create a Message Queue

Yeastar P-Series Cloud Edition allows to route messages from different message channels
to message queues, so as to share workload between agents and reduce customer service
response time. This topic describes how to create a message queue.

Limitation

Maximum Number
N<2 N>2

Message Queue

Agents per Message Queue 25 60 120
Requirements

« Plan: Enterprise Plan (EP) or Ultimate Plan (UP)
« Firmware: 84.20.0.21 or later

Procedure

1. Log in to PBX web portal, go to Messaging > Message Queue.

2. Click Add.

3. In the Name field, specify a name to help you identify it.

4. In the Chat Assignment Mode section, configure the assignment mode according to
your needs.



(@ Manual Pickup: Agents can take over the session by clicking the 'Pick Up' button.
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Auto-Pickup: The first agent to respond will automatically pick up the session.

Disable Pickup: Agents cannot pick up sessions.

Mode Description

Auto-Pickup

Disable Pickup

Manual Pickup All agents can view and reply to messages until an agent manually click the

Pick Up button to pick up the session.

All agents can view the messages, and the first agent to reply automatically
picks up the session.

Tip:

If you select this mode, make sure to inform all agents in the queue

in advance to avoid incorrect operations.

All agents can view and reply to messages, and sessions cannot be picked

up.

5. In the Agents section, select the desired extension users from the Available box to
the Selected box.

Available

W 1/6items

- Extension Number Caller ID Name

2006 Naomi Nichols
2007 Ashley Gardner
2008 Jaime Hart
2009 Carmen Gordon test
2010 Joe Lewis
3000 Leo Ball

6. Click Save.

6 items

Extension Number

2000

% 2001

2002

2003

2004

2005

Selected

Caller ID Name
Leo Ball

Phillip Huff
Terrell Smith
Dave Haris
Troy Daniel

Kristin Hale



Omnichannel Messaging Guide | 2 - Administrator Guide | 160

Result

All the selected extension users are assigned as agents of the message queue.

What to do next

Set the message queue as the inbound message destination of a channel number (Path:

Messaging > Message Channel > Z Messaging Settings).

+18723428005

Message Queue Tech Support

Related information
Manage Message Queues
User Guide - Manage customer queries from SMS channel on Linkus Web Client /
Desktop Client
User Guide - Manage customer queries from SMS channel on Linkus Mobile Client

Manage Message Queues

This topic describes how to edit a message queue, and delete message queue(s).

Edit a message queue

1. Log in to PBX web portal, go to Messaging > Message Queue.

2. Click Z beside the queue that you want to edit.
3. Change the settings according to your needs.
4. Click Save.

Delete message queues

Important:
Before you delete a message queue, make sure that the queue is not set as the in-
bound messaging destination of a message channel.
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1. Log in to PBX web portal, go to Messaging > Message Queue.
2. To delete a queue, do as follows:

a. Click [T beside the queue that you want to delete.

b. In the pop-up window, click OK.
3. To delete queues in bulk, do as follows:
a. Select the checkboxes of the queues that you want to delete.

b. At the top of the list, click Delete.
c. In the pop-up window, click OK.

Message Campaign

Message Campaign Overview

Yeastar P-Series Cloud Edition supports a message campaign feature that allows you to
send bulk messages to a group of contacts through specified messaging channel. This fea-
ture is commonly used for marketing promotions, notifications, reminders, and customer
engagement.

Requirements

« Firmware: Version 84.20.0.21 or later
« Plan: Enterprise Plan (EP) or Ultimate Plan (UP)

Limitations

* You can create up to 1,000 message campaigns.
» Each campaign can include up to 1,000 contacts.

Supported channels

You can create message campaigns for SMS and WhatsApp channels, allowing you to
reach your contacts through their preferred communication method.

For more information about the campaign configuration, see the following topics:

» Create an SMS Campaign
» Create a WhatsApp Campaign
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Campaign Status

The following table describes different statuses of the message campaign.

Status Description

Draft The campaign is saved as a draft. Messages will not be sent.

Scheduled The campaign is scheduled to be sent at the specified time.

Pending The campaign is waiting to send messages because another campaign is in
progress.

Executing The campaign is currently sending messages.

Completed The campaign has completed sending all messages.

Stop The campaign was unexpectedly stopped due to a system issue, such as system
restart, subscription issue, etc.

Retrying The campaign is retrying to send messages.

Create an SMS Campaign

SMS campaigns allow you to send targeted messages directly to your contacts' mobile
phones, making it easy to reach customers quickly and efficiently. This topic describes how
to create a message campaign for an SMS channel.

Requirements

« Firmware: Version 84.20.0.21 or later
« Plan: Enterprise Plan (EP) or Ultimate Plan (UP)

Prerequisites

Before you begin, make sure that the following resources are ready for a message cam-
paign:

Item Description

Message Channel  Set up and configure an SMS channel.

Note:
Ensure your account with the selected service provider has sufficient
credits or quota to support your planned bulk messaging volume.

Contact List Prepare a list of contacts with phone numbers for the campaign.
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Item Description

Note:
Each campaign supports up to 1,000 contacts.

You can associate a contact list with a campaign using one of the following
methods:

« Manually add contact numbers.
+ Import a CSV file containing contacts' phone numbers.

73 Note:
To use this method, ensure your file meets the following
requirements:
o Format: UTF-8 . csv
- Size: Less than 50 MB
> File name: Less than 127 characters
o Import parameters: Use a Nunber field to provide
phone numbers in E.164 format (e.g. +1xxxxxxxxxx), as
shown in the figure below.

4 A B C D
1 |Number |
2 +12025550101
8 +12025550102
4 +12025550103
5 +12025550104
(6] +12025550105
7 +12025550106
8 +12025550107
9 +12025530108
10 +120255320109
11 +12025550110
12

Directly use the existing contacts stored in a PBX phonebook.

) Note:
To use this method, ensure that the contact's phone number are
stored in E.164 format, as shown in the figure below.

* Number Type * Number Operations
Business +12025550101 o

+ Add
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Description

Message Routing  Optional. If you want the message campaign to automatically create sessions,
Target configure the desired routing target (either an extension or a message queue) in
advance.

Procedure

1. Log in to PBX web portal, go to Messaging > Message Campaign, then click Add.
2. In the Basic section, complete the basic settings.
« Name: Enter a name for the campaign to help you identify it.
- Message Channel: Select the desired SMS channel.
« Sender: Select the number associated with the selected SMS channel for mes-
sage sending.
« Recipient: Specify recipients using one of the following methods.

Instruction
Manual entry Manually add contact numbers in E.164 format (e.g.,
FIXXXXXXXXXX ).
Recipient
@ Input & Import Phonebooks

* Number Operations

+12025550101 o)

Total: 1 [ 1 20/ page

a. Select Input & Import.
b. Click Add to manually add phone numbers.

Import from CSV file Import a CSV file containing the contacts’ phone numbers.

Recipient

(® Input & Import Phonebooks

.
o0&
Import Message Campaign X
* Number
Please choose a UTF-8.csv file to import.
Click Here to view the format requirement for the imported file.

a. Select Input & Import.
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Method Instruction

b. Click Import.

c. In the pop-up window, click Browse to select the
desired file.

d. Click Import.

Use existing PBX Directly use existing contacts stored in your PBX phonebook.
phonebook

Recipient

Input & Impor: (® Phonebooks

The recipient number must start with "+Country Code" and only numbers and character + are allowed.

VIP_Contacts_Phonebook Business

a. Select Phonebooks.

b. In the Phonebooks drop-down list, select the existing
phonebook.

c. In the Number Type drop-down list, select the number
type.

The system will retrieve phone numbers from the
specified number types.

3. In the Message Content section, customize your message content.

You can send either a text message (SMS) or a multimedia message (MMS) that in-
cludes a file.

Type Instruction

File To send an MMS message that include a file, do as follows:

Note:

« Supported file types are determined by the ITSP of the SMS
channel.
» The file size can NOT exceed 100 MB.

Message Content
(® File Text

Choose a File

a. Select File.
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Type Instruction

b. Click Choose a File, then select a file to upload.

Text To send an SMS message, do as follows:

Note:

» The message length is up to 1600 characters.
» Emojis are supported.

Message Content

Fild (® Text

©

Dear VIP Member,
Thank you for your continued loyalty! This month, we have prepared exclusive rewards and surprises just for you. Feel free to contact
our team for more details. We look forward to serving you! &

“

a. Select Text.
b. In the text field, enter the message content and add emojis as needed.

4. In the Sending Rules section, configure the message send time and the mode.
a. In the Send Time section, specify when to send the message.

Option Description

Send Now The campaign will be sent immediately after saving.
Schedule Sending The campaign will be sent at a specified date and time.

(®) Schedule Sending

* Time

2025/07/24 08:50:00 AM

Do NOT Send, The campaign will be saved as a draft. You can edit or send it
Save as Draft later.

b. In the Send Mode section, set whether to create sessions accordingly.

Option Description

Create session The system automatically create a session for each contact

and send message number when sending the campaign messages, and the sessions
will be assigned to a selected target (either an extension or a
message queue).

) Note:
If an active session already exists for a contact number,
the campaign message will be sent to the existing
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Description

S session instead of creating and assigning a new session
A tothe specified target.

(®) Create session and send message.
A session will be automatically created when sending a message. And this session will be assigned to your selected target.

*

*

VIP_Service

Extension

Message Queue

No session will be created when sending a message. And the

Send messages
message will not be displayed in External Chat Logs.

directly without
creating session

5. Click Save.

Result

A campaign is created successfully and displayed in the campaign list.
o |f you choose to send messages immediately, the campaign status will display

as Executing, and messages will be sent to the specified phone numbers right

away.
Status Name Message Channel Sender Recipient Operations Y
Executing Promotion Ca.. @ SMS channel +14102161183 VIP_Contacts_Phon.. Z

o If you scheduled the campaign, the campaign status will display as Scheduled,
and messages will be sent automatically at the specified time.

Status Name Message Channel Sender Recipient Operations Y
VIP_Contacts_Phon.. 2 [P o)

Scheduled Promotion Ca.. @ SMS channel +14102161183

« When a campaign is marked as Completed, you can check its results from the cam-
paign list.

Note:

o |f there are any failed messages, you can click 1o retry sending.

o To create a similar campaign, click =F to duplicate the campaign.

o For a quick overview, check the Result and Response Rate columns.
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Send Time Send Mode Result (Failed/Total)  Response Rate Details Operations Y

's_Phon.. 2025/07/2314:04:10 Send messages dir.. |0/5 40% E Z @ 9O 1w

> To see detailed sending information, click El.

Send Time Send Mode Result (Failed/Total) ~ Response Rate Details Operations Y
Va o W
Details(Promotion Campaign) X @

Send Time: 2025/07/23 14:04:10  Failed:0  Succeeded:0  Total: 5

Contact Name Number Result Failed Reason
VIP_Customer_E +12025550105 Succeeded
VIP_Customer_D +12025550104 Succeeded
VIP_Customer_C +12025550103 Succeeded
VIP_Customer_B +12025550102 Succeeded
VIP_Customer_A +12025550101 Succeeded

Total: 5 10/ page

v OK

Create a WhatsApp Campaign

WhatsApp campaigns allows you to send marketing, utility, and authentication messages di-
rectly to your contacts' mobile devices via WhatsApp using message templates, making it
easy to reach customers quickly and effectively. This topic describes how to create a mes-
sage campaign for a WhatsApp channel.

Requirements

« Firmware: Version 84.20.0.21 or later
» Plan: Enterprise Plan (EP) or Ultimate Plan (UP)

Prerequisites

Before you begin, make sure that the following resources are ready for a message cam-
paign:

Description

Message Channel Set up a WhatsApp Channel with your WhatsApp Business Account.

I Note:
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Description

Message Template

Contact List

S Ensure your account’s messaging limit can support your planned
4 bulk messaging volume.

WhatsApp Manager > Phone numbers ® Test WhatsApp Business Account ¥

REjPartheroveiview] Q search by phone number or name Filter by country w ||V Filter by status -

& Partner solutions
Phone number Name Status Quality rating Messaging Limit

@ Overview Test Number
L 15550193510 e stomers Connected ® High 1K Customers/24hr o

» Create message templates for your WhatsApp Business Account in
advance, as message templates must be approved by WhatsApp
before use.

73 Note:
Variable names in the template support only lowercase letters
and numbers. Do not use underscores or special characters,
as this may affect usage.

» Refresh the template list in PBX to ensure all approved templates from
your WhatsApp account are synchronized to PBX and available for
your campaign. For more information, see View WhatsApp Message

Templates.

Prepare a list of contacts with phone numbers for the campaign.

Note:
Each campaign supports up to 1,000 contacts.

You can associate a contact list with a campaign using one of the following
methods:

» Manually add contact numbers.
« Import a CSV file containing contacts' phone numbers.

Note:
To use this method, ensure your file meets the following
requirements:
o Format: UTF-8 . csv
o Size: Less than 50 MB
> File name: Less than 127 characters
o Import parameters: Use a Nunber field to provide
phone numbers in E.164 format (e.g. +1xxxxxxxxxx),
as shown in the figure below.
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Item Description

. A B C D
1 |Number |
2 +12025550101
3 +12025550102
4 +12025550103
5 +12025550104
6 +12025550103
7 +12025550106
8 +12025550107
9 +12025550108
10 +12025550109
11 +12025550110
12

.

Directly use the existing contacts stored in a PBX phonebook.

,'* Note:
To use this method, ensure that the contact's phone number
are stored in E.164 format, as shown in the figure below.

* Number Type * Number Operations
Business +12025550101 Tar
+ Add
Message Routing Optional. If you want the message campaign to automatically create
Target sessions, configure the desired routing target (either an extension or a
message queue) in advance.

Procedure

1. Log in to PBX web portal, go to Messaging > Message Campaign, then click Add.
2. In the Basic section, complete the following settings.
- Name: Enter a name for the campaign to help you identify it.
- Message Channel: Select the desired WhatsApp channel.
« Sender: Select the associated WhatsApp phone number for message sending.
« Recipient: Specify recipients using one of the following methods.

Instruction

Manual entry Manually add contact numbers in E.164 format (e.g.,
FIXXXXXXXXXX ).
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Method Instruction

Recipient
‘ @® Input & Import Phonebooks
o
| *Number Operations
i
Lyl
| +12025550101 | i

Total: 1 1

a. Select Input & Import.
b. Click Add to manually add phone numbers.

Import from CSV file  Import a CSV file containing the contacts’ phone numbers.

Recipient

(® Input & Import

:
(X0 [

* Number

Phonebooks

Import Message Campaign

Please choose a UTF-8.csv file to import.
Click Here to view the format requirement for the imported file.

VIP_Customers_Push.csv ‘

a. Select Input & Import.
b. Click Import.

c. In the pop-up window, click Browse to select the
desired file.

d. Click Import.

Use existing PBX Directly use existing contacts stored in your PBX phonebook.
phonebook

Recipient

Input & Impor: (® Phonebooks

The recipient number must start with "+Country Code" and only numbers and character + are allowed.

* Phonebooks * Number Type

VIP_Contacts_Phonebook Business

a. Select Phonebooks.

b. In the Phonebooks drop-down list, select the existing
phonebook.

c. In the Number Type drop-down list, select the number
type.

20/ page
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Instruction

The system will retrieve phone numbers from the
specified number types.

3. In the Message Content section, configure the message template to be sent.

a. Click WhatsApp Message Template, then search and select the desired mes-
sage template.

Message Content

WhatsApp Message Template v Marketing X English x

O tier_discount_announcement
4

Hello! £ As a valued {{customer tier}} member, were excited to share a
special {{offer type}} with you! T Enjoy {{offer details}}—available until...

b. If the template includes media or variable placeholders, upload the required me-
dia files and fill in specific values for all variables.

Edit tier_discount_announcement Message Preview

Hello!

As a valued VIP member, we're excited to share a
special discount with you! T

Enjoy 20% off for all products —available until July
31,2025

Hello!

Asavalued VIP member, we're excited to share a special ~ discount  with you! If you have any questions or want to redeem your

ffe l ly to th tact
Enjoy  20% off forall products  —available until ~ July 31,2025 offer, simply reply to this message or contact our

team,

Thank you for chocsing SmartMalt @
If you have any questions or want to redeem your offer, simply reply to this message or contact our team

Redeem Offe
Thank you for choosing SmartMal | @

Visit website

Contact us

Note:
* You can preview the final message contents on the right panel.
« For location information, you can simply paste the Google Maps
URL, the system will auto-fill the name and coordinates based on
the URL. However, you need to manually enter the detailed ad-
dress for the { { Addr ess} } variable.
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Messaging / Message Campaign / Edit (Sales Campaign)

Message Content

Message Preview

Madison Square Garden

ion ==
Hall at Penn Station ' o e Macy's
i
&
A

2y D34 St-Herald Sq
v S Madison Square Garden

7505045,73 9934387,172/data=1am 2141 550x89c25¢

elimit to enjoy

ny questions, fel free to contact us,

* ({Address))

* 407505045

*73.9934387

4. In the Sending Rules section, configure the message send time and the mode.
a. In the Send Time section, specify when to send the message.

Option Description

Send Now The campaign will be sent immediately after saving.

Schedule Sending The campaign will be sent at a specified date and time.

(®) Schedule Sending
* Time

2025/07/24 08:50:00 AM

Do NOT Send, The campaign will be saved as a draft. You can edit or send it
Save as Draft later.

b. In the Send Mode section, set whether to create sessions accordingly.

Option Description

Create session The system automatically create a session for each contact

and send message number when sending the campaignh messages, and the sessions
will be assigned to a selected target (either an extension or a
message queue).

," Note:
If an active session already exists for a contact number,
the campaign message will be sent to the existing
session instead of creating and assigning a new session
to the specified target.
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Option Description
(®) Create session and send message.

A session will be automatically created when sending a message. And this session will be assigned to your selected target.

*

‘ VIP_Service

Extension

Message Queue

No session will be created when sending a message. And the

Send messages
message will not be displayed in External Chat Logs.

directly without
creating session

5. Click Save.

Result

A campaign is created successfully and displayed in the campaign list.
o If you choose to send messages immediately, the campaign status will display

as Executing, and messages will be sent to the specified phone numbers right

away.
Status Name Message Channel Sender Recipient Operations Y
Executing Promotion Ca... » WhatsApp Chan... +15550193510 VIP_Contacts_Phon... 2

o If you scheduled the campaign, the campaign status will display as Scheduled,
and messages will be sent automatically at the specified time.

Status Name Message Channel Sender Recipient Operations Y
VIP_Contacts_Phon... Z B m)

Scheduled Promotion Ca... ® WhatsApp Chan... +15550193510

« When a campaign is marked as Completed, you can check its results from the cam-
paign list.

Note:

o |If there are any failed messages, you can click 1o retry sending.

o To create a similar campaign, click =F to duplicate the campaign.

> For a quick overview, check the Result and Response Rate columns.
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Send Time Send Mode Result (Failed/Total)  Response Rate Details Operations Y

's_Phon.. 2025/07/2314:04:10 ~ Send messages dir.. |0/5 40% E Z @ 9O 1w

> To see detailed sending information, click El.

Send Time Send Mode Result (Failed/Total)  Response Rate Details Operations Y
2 o W
Details(Promotion Campaign) X @

Send Time: 2025/07/23 14:04:10  Failed: 0 Succeeded:0  Total: 5

Contact Name Number Result Failed Reason
VIP_Customer_E +12025550105 Succeeded
VIP_Customer_D +12025550104 Succeeded
VIP_Customer_C +12025550103 Succeeded
VIP_Customer_B +12025550102 Succeeded
VIP_Customer_A +12025550101 Succeeded
Total: 5 ‘T‘ 10/ page

v 0K

External Chat Log Management

Check and Manage External Chat Logs

External chat logs are comprehensive records of sessions and messages coming from var-
ious messaging channels. This topic describes how to check the external chat logs (includ-
ing session information, session operation records, and detailed chat histories) and how to
delete the session or chat histories on Yeastar P-Series Cloud Edition.

Requirements

The firmware version of Yeastar P-Series Cloud Edition is 84.13.0.25 or later.
Procedure

1. Log in to PBX web portal, go to Reports and Recordings > External Chat Logs.
2. Optional: Set criteria (time, channel type, or other objects) to filter the desired records.

The relevant records of external chat sessions are displayed on the page.
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Reports and Recordings / External Chat Logs

2024/09/010000:00  ~  2024/10/1023:50:59

Session ID Created At

31 2024/09/20 1518:38
30 2024/09/20 15:09:42
29 2024/09/20 150151
1 2024/08/16 09:27:15

Last Active At

2024/09/20 15:24:03

2024/09/2015:10:10

2024/09/20 15:09:24

2024/09/08 11:29:54

Sender Recipient Channel Type Channel Number Session Status Details Operations
Website Visitor QueueA Live Chat LC00000 Closed ) o
Website Visitor Leo Ball<1000> Live Chat Lco0000 Closed B o
Website Visitor Leo Ball<1000~ Live Chat Lc00000 Closed ) &
Jim Terrell Smith<1002>  Facebook Messenger  334079033132760 Not Closed B o]

Lee<86153282118153...

Q Total4 E 20/ page

3. Check and manage the records according to your need.

Operation

of an external chat
session

External Chat Session

Check operation records

Instruction

a. Click F@ beside the desired session.

Channel
Session ID Time Sender Recipient Channel Number
Type
2 12/12/2023 customer<+12 TechS N sMs +12 407
2331112 283> ech suppor

A window pops up, displaying the operation records of the
session in a timeline view.

73 Note:
Only the following operations will be recorded:
« Create a session
« Transfer a session
« Pick up a session from a message queue
* Close a session

Session Timeline X

@ Received an inbound message and created session
12/12/2023 23:31:12

Received a message from +12, 283, and the session has been routed to
Tech Support.

&, Session has been picked up from message queue
12/12/2023 23:33:51

Leo Ball<3000> picked up the session from message queue Tech Support

® Session closed by extension
12/18/2023 04:47:29

Leo Ball<3000> closed the session.

Details

Operations
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Operation Instruction
Delete external chat » To delete a session, do as follows:
session(s)
Session ID Time Sender Recipient Channel Type Channel Number Details Operations
2 125/;12:/122023 +121 283 Tech Support SMS +12) 407 ) %

If deleted, extensions will not be able to view the
session, and the message record of the session
will also be deleted. Are you sure you want to
proceed?

X Cancel

a. Click EI beside the session that you want to delete.

b. In the pop-up window, click OK.
» To delete multiple sessions, do as follows:

&> Download v [l O Refresh

®  SessionlD  Time Sender Recipient Channel Type = Channel Number Details Operations
12/19/2023
+ G
7 - 120 28005 B [ o]
If deleted, extensions will not be able to view the
o
6 12419/2023 +120 session, and the message record of the session 28005 B &
05748 will also be deleted. Are you sure you want to
proceed?
12/19/2023
5 +120 28005 K
00:32:58 © H Ll
X Cancel
12/18/2023
R
3 35742 1001 61283 B M &

a. Select the desired sessions, then click Delete.
b. In the pop-up window, click OK.

External Chat History

Check the detailed chat

L
. . . a. Click beside the desired session.
histories of a session

Channel

Session ID Time Sender Recipient Type Channel Number Details Operations
12/12/2023 customer<+12
5 =
2 23:3112 2835 Tech Support SMS +12 407 ) far

)

The detailed messages in the session are displayed.

Time Sender Recipient Message Type Message Content Operations
12/18/2023 04:47:29  PBX System The session has been closed.

12/18/2023 00:03:06  Leo Ball<3000> +12 283 Outbound Test Session Completed jof
12/12/202323:3413  Leo Ball<3000> +12 283 Outbound Hi! How can | help you? o}

Leo Ball picked up the session from message
12/12/202323:33:51  PBX System
queue Tech Support.

12/12/202323:31:12 +12) 283 Tech Support Inbound Hi | need help o

Q Total:s 20/ page

Delete chat histories of a I Note:
session 4 ;
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Operation

Instruction

| 15] Delete
L] Time
12/18/2023 04:47:29
12/18/2023 00:03:06
12/12/2023 23:34:13

12/12/2023 23:33:51

12/12/2023 23:31:12

a. Click beside the desired session.

I Messages sent by the PBX system can NOT be deleted.
,5

Channel
Session ID Time Sender Recipient Type Channel Number Details Operations
12/12/2023 customer<+12
2 233112 283 Tech Support SMs +12 407 @ -{'J o)
The detailed messages in the session are displayed.
b. To delete a single message, do as follows:
Time Sender Recipient Message Type Message Content Operations
12/18/2023 04:47:29  PBX System The session has been closed.
12/18/2023 00:03:06  Leo Ball<3000> +12 283 Outbound Test Session Completed Ty
12/12/2023 23:34:13  Leo Ball<3 w can | help you? B
If deleted, extensions will not be able to see these | picked up the session from message
12/12/2023 23:33:51  PBX Syste|
message(s) when viewing the session on the Yech Support.
client side. Are you sure you want to proceed?
12/12/2023 23:31:12  +12 d help a7

O ~Totr'5 1 20/ page

Sender

PBX System

Leo Ball<3000>

Leo Ball<3000>

PBX System

+12 283

i. Click EI beside the desired message.
i. In the pop-up window, click OK.
c. To delete multiple messages, do as follows:

Recipient Message Type

If deleted, extensions will not be able to see these
message(s) when viewing the session on the

client side. Are you sure you want to proceed?

Message Content Operations
closed.
tted o)
u? o}

e session from message

X Cancel
B

Q Total:s 20/ page

i. Select the desired messages, then click Delete.
ii. In the pop-up window, click OK.

Download External Chat Logs

This topic describes how to download external chat logs for legal compliance, dispute reso-

lution, training, or other purposes.
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Requirements

The firmware version of Yeastar P-Series Cloud Edition is 84.13.0.25 or later.
Procedure

1. Log in to PBX web portal, go to Reports and Recordings > External Chat Logs.
2. To download all chat logs, click Download at the top of the list, then click Download
All Chat Logs.

¢ Download v [ & Refresh

Download Filtered Chat Logs Sender Recipient Channel Type Channel Number Details Operations

Download All Chat Logs 23

7
UUI3258 12 283 Tech Support SMs +18 005 e [ o}

12/18/9092

3. To download specific chat logs, do as follows:

12/01/2023 00:00:00 12/31/2023 23:59:59 = SMS Y Filter

G\J Download v D Refresh

Download Filtered Chat Logs Sender Recipient Channel Type Channel Number Details Operations

Download All Chat Logs 23
. +12 283 Tech Support SMS +12 407 @ &
N 2
12/12/2023
1 Leo Ball<3000> +12( 407 SMS +12! 283 @ o]
23:31:.07
Q  Total :2 ‘ 1 ‘ 20/ page

a. Set criteria to filter the desired records.

The relevant records of external chat sessions are displayed on the page.
b. At the top of the list, click Download, then click Download Filtered Chat
Logs.

Result
The external chat logs are downloaded to your computer, and each downloaded chat log
has two CSV files:

» Session_Record: This file includes basic information about all the chat sessions in the

download list.
» Chat_Data_Record: This file contains detailed chat histories of the entire chat session.



Agent Guide

Omnichannel Messaging Agent Guide

This guide provides guidance on how to manage incoming customer inquiries on a unified
agent portal available on web, desktop, and mobile devices.

Audience

This guide is intended for customer service representatives (agents) who handles chat in-
teraction with customers through multiple digital messaging channels.

Agent portal

To enhance communication mobility and improve agent productivity, Yeastar provides a uni-
fied agent portal integrated into the Linkus UC Clients that is available on mobile, desktop,
and web-based platforms. Agents can efficiently handle message-based interactions come
from multiple digital channels through the supported clients.

Supported -
Client Description
Linkus Web The Linkus Web Client and Desktop Cleint allows agents to manage customers'

Client / Desktop | chat interactions directly from a web browser or a Desktop application.
Client
« For instructions on handling message-based interactions with customers
on Linkus Web Client and Desktop Client, see Agent operations on Web
Client / Desktop Client.
» For more information about utilizing Linkus Web Client and Desktop Client,
see Linkus Web Client User Guide and Linkus Desktop Client User Guide.

Linkus Mobile The Linkus Mobile Client is suitable for agents who need the flexibility to handle
Client customers' chat interactions on the go.

« For instructions on handling message-based interactions with customers
on Linkus Mobile Client, see Agent operations on Mobile Client.

» For more information about utilizing Linkus Mobile Client, see Linkus
Mobile Client User Guide.



https://help.yeastar.com/en/p-series-linkus-cloud-edition/web-client-user-guide/about-this-guide.html
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https://help.yeastar.com/en/p-series-linkus-cloud-edition/mobile-client-user-guide/about-this-guide.html
https://help.yeastar.com/en/p-series-linkus-cloud-edition/mobile-client-user-guide/about-this-guide.html
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Agent Operations on Web Client / Desktop Client

Start a Messaging Session with a Customer on Web Client /
Desktop Client

If you need to send customers messages for notifications, marketing campaigns or other
purposes, you can proactively start a messaging session.

Note:
You can proactively start a messaging session via SMS or WhatsApp messaging
channel.

Requirements

PBX Server

Contact system administrator to make sure that PBX server meets the follow-
ing requirements:

« PBX Version: 84.20.0.21 or later.
« Plan: Enterprise Plan or Ultimate Plan
» Messaging:
o At least one SMS or WhatsApp messaging channel is set up on
PBX.
> You have been granted with the permission to create message
sessions in the channel.
o To initiate a session via the WhatsApp channel, only WhatsApp-ap-
proved message templates can be used. Ensure that the desired
templates have been synchronized to the PBX.

Linkus Desktop Client

Make sure that the version of your Linkus Desktop Client meets the following
requirement:

« Windows Desktop: 1.7.3 or later
» macOS Desktop: 1.7.3 or later
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Supported methods

« Start a session via an SMS channel

« Start a session via a WhatsApp channel

Start a session via an SMS channel

1. On Linkus Web Client or Desktop Client, go to Chat > External Chat.

2. Click + to add a session.

()
3¢ Yeastar

Q-
2

B

=

Extensions

Contacts

Chat

Video Conferencing

Operator Panel

Call Center Console

Call Logs

Voicemails

Recordings

Preferences

Chrome Extension

B @ Elv  AgentStatusv @ Availablev
Internal Chat External Chat

T
&

Recent

3. In the pop-up window, complete the following settings.

Follow System « ° %
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Create Session X

@ SMS

+141516170000/SMS Channel

+1 United State... 2025550101

« Session Type: Select SMS.

« Sender: Select the desired channel number for sending messages.

» Recipient: Select a country/region code, then enter the recipient number.
4. Click Create.

The SMS messaging session is created, you can send massages and chat with your
customer.

A
Internal Chat External Chat +12025550101
+

Recent v
Campaign Group

+12025550101 Ty

D

© B3 B

Dear Mr. Smith, this is a reminder for your car maintenance appointment at
AutoCare Center on July 26th at 9:00 AM. Please reply “1” to confirm or “2” to 17
reschedule. For assistance, call (123) 456-7890) @
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Start a session via a WhatsApp channel

1. On Linkus Web Client or Desktop Client, go to Chat > External Chat.

2. Click + to add a session.

_l

7¢ Yeastar

Q: Extensions

[E; Contacts

[=1 Chat

B Video Conferencing
E Operator Panel

69 Call Center Console
[& Call Logs

ao Voicemails

O Recordings

S Preferences

1
a

%> Chrome Extension

B ® B~ AgentStatusv @ Availablev
Internal Chat External Chat

T
&

Recent

3. In the pop-up window, do as follows:

Create Session

® WhatsApp

+15550193510/WhatsApp Channel

+1 United State...

2225550101

+ Session Type: Select WhatsApp.
« Sender: Select the associated phone number for sending messages.

:: Follow System v o %
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« Recipient: Select a country/region code, then enter the recipient number.
4. Click Create.

The WhatsApp messaging session is created.
5. In the session, send the desired message template to your customer.
a. Click WhatsApp Message Template, then search and select the desired tem-

.
Internal Chat External Chat +12025550101
+
All v
Campaign Group
+12025550101 .
]
WhatsApp Message Template X
Marketing » English X

WhatsApp Message Template

tier_discount_announcement

Hello! As a valued {{customer_tier}} member, we're excited to share a special {{offer_type}}
with you! T Enjoy {{offer_details}}—available until {{expiry_date}}. If you have any questions or...

X Cancel

b. If the template includes media or variable placeholders, upload the required me-
dia files and fill in specific values for all variables.
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WhatsApp Message Template X

Message Preview

Hello! .2
Hello! .
As avalued VIP member, we're excited
to share a special discount with you!
Asavalued VIP  member, we're excited to T

Enjoy 20% off for all products —

share a special  discount  with you! T available until July 30, 2025

Enjoy 20% off for all product —available until
If you have any questions or want to

July 30,2025 . redeem your offer, simply reply to this
message or contact our team.

If you have any questions or want to redeem your Thank you for choosing SmartMal! @

offer, simply reply to this message or contact our Redeem Offer

Note:
* You can preview the final message contents on the right panel.
« For location information, you can simply paste the Google Maps
URL, the system will auto-fill the name and coordinates based on
the URL. However, you need to manually enter the detailed ad-
dress for the {{ Addr ess}} variable.

7505045,-73.0934387,

WhatsApp Message Template

ttps://www google.com/maps/place/Madisor Madison Square Garcen

Google Maps

Special offer: {(OfferDetails})

* Madison Square Garden:

* {{Address)}

* 40.7505045

*73.9934387

c. Click Send.


https://www.google.com/maps
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Related information
Manage Customer Queries from External Messaging Channels on Web Client / Desk-

top Client

Manage Customer Queries from External Messaging Channels
on Web Client / Desktop Client

This topic describes how to manage the messaging sessions of customer queries on
Linkus Web Client and Desktop Client.

Requirements

PBX Server

Contact system administrator to make sure that PBX server meets the follow-
ing requirements:

« PBX Version: 84.20.0.128 or later.
« Plan: Enterprise Plan or Ultimate Plan
» Messaging: At least one messaging channel is set up on PBX.

Linkus Desktop Client

Make sure that the version of your Linkus Desktop Client meets the following
requirement:

» Windows Desktop: 1.2.14 or later
» macOS Desktop: 1.2.14 or later

Pick up a messaging session
If you are an agent of a message queue, when the queue receives inbound message(s) in a
new session, you can see the message(s) and pick up the session from the queue.

Note:
The pickup operation is only available when the chat assignment mode of your
message queue is set to Manual Pickup or Auto-Pickup.

« If the mode set to Manual Pickup, you need to manually pick up the session.
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« If the mode is set to Auto-Pickup, the session will be automatically assigned
to you if you are the first agent to reply. You can also manually pick up the
session in this mode if needed.

Internal Chat External Chat ) ? 283

+
Click the button to pick up the session from the message queue.
Recent

283 *
@ 283

1. On Linkus Web Client or Desktop Client, click Chat, then click the External Chat tab.
2. To manually pick up a session, click Pick Up at the top of the messaging session.

There is a prompt indicating that you have picked up the session from the message
queue; Only you can see the session and respond to messages in the session.

Transfer a messaging session

During a session, you can transfer a customer's conversation to another colleague or a mes-
sage queue for further handling. Alternatively, if advanced message processing or automa-
tion is required, you can transfer the session to a third-party message analytics platform.

Note:

The option to transfer sessions to a third-party message analytics platform will only
appear if the system administrator has integrated the PBX server with a third-party
platform via API.
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121) +1 121
Internal Chat External Chat &y

Recent Transfer C
=

Al 121 Do you want to transfer this messaging session? Once transferred,
- you will no longer be able to ork on the session. The person who

receives the session will see all your previous chat history. mple.pdf

Extension

1003-Kristin Hale
X Gance

1. On Linkus Web Client or Desktop Client, click Chat, then click the External Chat tab.

2. At the top-right corner of the messaging session, click e
3. In the pop-up window, select the desired destination and click OK.

The messaging session is removed from your external chat list, and transferred to the
colleague / message queue / Third-party message analytics platform with whole chat
history.

Initiate a voice call from a messaging session

You can initiate a voice call right from the messaging session to resolve a customer's issue
if necessary.

Note:

This operation requires the permission to make outbound calls. Contact the system
administrator to check if you have the permission.
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sample.pdf

121

1. On Linkus Web Client or Desktop Client, click Chat, then click the External Chat tab.

2. At the top-right corner of the messaging session, click .

Linkus Web Client quickly dials out the customer's number, and the call is sent
through the PBX.

Add a customer to Contacts

You can add a customer to Contacts right from the messaging session.

121 +1 121 . "Q) 5 a

@ Add New Contact

2. Add to Existing Contact

+ o
o
° sample.pdf

121

1. On Linkus Web Client or Desktop Client, click Chat, then click the External Chat tab.

2. At the top-right corner of the messaging session, click 2 .
3. Add the customer to Contacts according to your needs.
« To add the customer as a new contact, click Add New Contact and enter the
customer's information.
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» To add the customer to an existing contact, click Add to Existing Contact and
edit the contact's information as needed.

View messaging session details

You can check the detailed information of a messaging session, including the message
source channel, channel number, etc.

(R - | 8 | Details X

2

There: 2
D
° sample.pdf v Session Details

1. On Linkus Web Client or Desktop Client, click Chat, then click the External Chat tab.

2. At the bottom of the messaging session, click El

The details of the messaging session is display at the right panel.

Archive a messaging session

You can archive a messaging session if there is no response from the customer or you wish
to refer back to the session later.

. a
Internal Chat External Chat &y + 121 e
121
+
= &
121 +1 121
o
° B sample.pdf
121
)
)
© 3 B8

1. On Linkus Web Client or Desktop Client, click Chat, then click the External Chat tab.
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2. At the top-right corner of the messaging session, click ]
The messaging session is moved from Recent list to the Archived list.

Note:

To start the conversation again, you can directly send a message in the

archived messaging session, or click B at the top-right corner to unarchive
the messaging session. The unarchived session will be moved back to the
Recent list.

End a messaging session

When you're done helping a customer, you can end the messaging session.

Do you want to close this messaging
+1 121 session? Once closed, you will not be able
[:~:] to send new messages on this session.

1. On Linkus Web Client or Desktop Client, click Chat, then click the External Chat tab.

2. At the top-right corner of a messaging session, click =
3. In the pop-up window, click OK.

The messaging session is closed and moved to the Archived list; You can NOT send
messages on this session any more. Next time the customer sends messages, a new
messaging session will be created.

Remove a messaging session

To remove a messaging session, do as follows:



© BB
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This will remove the conversation from this ° sample.pdf
chat list. Are you sure to remove it?

X Cancel [EVAVS

1. On Linkus Web Client or Desktop Client, click Chat, then click the External Chat tab.
2. In the external chat list, right click the messaging session that you want to remove.

3. Click Remove.

4. In the pop-up window, click OK.

The messaging session is removed from all your Linkus clients.

Handle campaign sessions

If system administrator sets message campaigns to send messages in bulk, and assigns
the campaign sessions to your extension or the message queue you belong to, you can view
and manage these campaign sessions.

909

101

102

104

105

909) +12025550909

+12025550909 < Campaign Group

+12025550101

412025550102

+1 zazssrm@
-

+12025550104
-]

+12025550105
@

102 +12025550102

: B

=

test.3gp

1. On Linkus Web Client or Desktop Client, click Chat, then click the External Chat tab.
2. In the external chat list, click Campaign Group.

All sessions created by message campaigns will be listed.
3. Click a session to view and respond to customer replies as needed.
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Agent Operations on Mobile Client

Start a Messaging Session with a Customer on Mobile Client

If you need to send customers messages for notifications, marketing campaigns or other
purposes, you can proactively start a messaging session.

Note:

You can only proactively start a messaging session via SMS messaging channel.

Requirements

PBX Server

Contact system administrator to make sure that PBX server meets the follow-
ing requirements:

« Version: 84.12.0.57 or later.
« Plan: Enterprise Plan or Ultimate Plan
« Messaging: At least one messaging channel is set up on PBX.

Linkus Mobile Client

Make sure that the version of your Linkus Mobile Client meets the following re-
quirements:

* Linkus iOS Client: Version 5.7.3 or later
+ Linkus Android Client: Version 5.7.4 or later
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1. On Linkus Mobile Client, go to Chat > External Chat.

2. At the top-right corner, tap +.

3. In the drop-down menu, select Create SMS Session.
4. Select sender and recipient.

a. In the Sender drop-down list, select the channel number for sending messages.

b. In the Recipient drop-down list, select a country/region code, then enter the re-
cipient number.

5. At the top-right corner, tap Create.

Result
The messaging session will appear in the external chat list after you send a message.

Related information
Manage Customer Queries from External Messaging Channels on Mobile Client

Manage Customer Queries from External Messaging Channels
on Mobile Client

This topic describes how to manage the messaging sessions of customer queries on
Linkus Mobile Client.
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Requirements

PBX Server

Contact system administrator to make sure that PBX server meets the follow-
ing requirements:

* Version: 84.20.0.128 or later.
« Plan: Enterprise Plan or Ultimate Plan
« Messaging: At least one messaging channel is set up on PBX.

Linkus Mobile Client

Make sure that the version of your Linkus Mobile Client is 5.19.7 or later.

Pick up a messaging session
If you are an agent of a message queue, when the queue receives inbound message(s) in a
new session, you can see the message(s) and pick up the session from the queue.

Note:

The pickup operation is only available when the chat assignment mode of your
message queue is set to Manual Pickup or Auto-Pickup.

« If the mode set to Manual Pickup, you need to manually pick up the session.

- If the mode is set to Auto-Pickup, the session will be automatically assigned
to you if you are the first agent to reply. You can also manually pick up the
session in this mode if needed.
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Gl he buton pick up the sess
from the message queue.

1. On Linkus Mobile Client, go to Chat > External Chat.
2. To manually pick up a message session, tap Pick Up at the top of the session.

There is a prompt indicating that you have picked up the session from the message
queue; Only you can see the session and respond to messages in the session.

Transfer a messaging session

During a session, you can transfer a customer's conversation to another colleague or a mes-
sage queue for further handling. Alternatively, if advanced message processing or automa-
tion is required, you can transfer the session to a third-party message analytics platform
(API).

Note:
The option to transfer sessions to a third-party message analytics platform will only
appear if the system administrator has integrated the PBX server with a third-party

platform via API.




Omnichannel Messaging Guide | 3 - Agent Guide | 198

2:17 ol T @
Cancel Select The Contact
&l Search
Extensions Message Queue API

Default_All_Extensions(5) v
K

Kristin Hale
[Offline]

- Do you want to transfer this
messaging session? Once
transferred, you will no longer
be able to work on the
session. The person who

receives the session will see
‘ all your previous chat history.

¢
g B --0-- B
‘ b

1002
[Offline]

#

1. On Linkus Mobile Client, go to Chat > External Chat.

2. In an active messaging session, tap ~ at the top-right corner.
3. On the Chat Information page, tap Transfer.
4. Search and select the colleague, then tap Confirm in the pop-up window.

The messaging session is removed from your external chat list, and transferred to the
colleague / message queue / Third-party message analytics platform with whole chat
history.

Initiate a voice call from a messaging session

You can initiate a voice call right from the messaging session to resolve a customer's issue
if necessary.

Note:
This operation requires the permission to make outbound calls. Contact the system
administrator to check if you have the permission.
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407

1. On Linkus Mobile Client, go to Chat > External Chat.
2. In a messaging session, tap % atthe top-right corner.

Linkus Mobile Client quickly dials out the customer's number, and the call is sent
through the PBX.

Add a customer to Contacts

You can add a customer to Contacts right from the messaging session.

Add to Contacts
New Contact

Add to Existing Contact

Cancel
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1. On Linkus Mobile Client, go to Chat > External Chat.

2. In a messaging session, tap ~ at the top-right corner.
3. At the bottom of the Chat Information page, tap Add to Contacts.
4. Add the customer to Contacts according to your needs.

« To add the customer as a new contact, click New Contact in the pop-up win-
dow, and enter the customer's information.

« To add the customer to an existing contact, click Add to Existing Contact in
the pop-up window, select the contact and edit the information as needed.

View messaging session details

You can check the detailed information of a messaging session, including the message
source channel, channel number, etc.

Session Details

Channel Type

Channel Number

Recipient Number

1. On Linkus Mobile Client, go to Chat > External Chat.

2. In a messaging session, tap ~ at the top-right corner.

The details of the messaging session is displayed in the Session Details section.

Note:

If the customer is an existing contact, you can also tap the customer to quick-
ly access the contact's information.
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2:20 = @l

< Chat Information
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Archive a messaging session

You can archive a messaging session if there is no response from the customer or you wish
to refer back to the session later.

1. On Linkus Mobile Client, go to Chat > External Chat.
2. In the external chat list, touch and hold an active messaging session, then tap

Archive.

The messaging session is moved from Recent list to the Archived list.

Note:
To start the conversation again, you can directly send a message in the
archived messaging session, the messaging session will be automatically

unarchived and moved back to the Recent list.
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End a messaging session
When you're done helping a customer, you can end the messaging session.

2:17 e T @

< Chat Information

External Chat

0 +12027886407

Session Details

Channel Type [i:]
Channel Number +12026461283
Recipient Number +12027886407
Mute Notifications ()
Close >
Transfer >
Archive ()
Do you want to close this messaging session? Once
closed, you will not be able to send new messages on

this session.

o Confirm

Cancel

1. On Linkus Mobile Client, go to Chat > External Chat.

2. In an active messaging session, tap ~ at the top-right corner.
3. On the Chat Information page, tap Close.
4. In the pop-up window, click Confirm.

The messaging session is closed and moved to the Archived list; You can NOT send
messages on this session any more. Next time the customer sends messages, a new
messaging session will be created.

Remove a messaging session

To remove a messaging session from the chat list, do as follows:
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External Chat

Archive  Delete

w_

1. On Linkus Mobile Client, go to Chat > External Chat.
2. In the external chat list, touch and hold a messaging session, then tap Delete.

The messaging session is removed from the chat list on all your Linkus clients.

Handle campaign sessions

If system administrator sets message campaigns to send messages in bulk, and assigns
the campaign sessions to your extension or the message queue you belong to, you can view
and manage these campaign sessions.
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1. On Linkus Mobile Client, go to Chat > External Chat.
2. In the external chat list, tap Campaign Group.

All sessions created by message campaigns will be listed.
3. Tap a session to view and respond to customer replies as needed.
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